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VISITREN D/PLOTTM 

PREFACE 

USER'S 
GUIDE 

PURPOSE OF THIS MANUAL 

PREFACE 

This manual teaches you how to use VisiTrend/PloPM, and provides a 
complete reference to the details of the program. 

Chapter 1: INTRODUCTION presents an overview of the three 
VisiTrend/Plot subprograms, and guides you in setting up your com­
puter, and in getting started with the program. 

Chapter 2: THE VISITREND/PLOT TUTORIAL contains five lessons that 
teach the main features of the program with examples and illustrations. 
You are introduced keystroke-by-keystroke to drawing graphs, managing 
files, editing, and analyzing data. In addition, Lesson 5 contains a set of 
plotting examples. Each lesson ends with a functional summary that can 
serve as a bare-bones course, or as a review of the lessons. 

Chapter 3: REFERENCE alphabetically references each VisiTrend/Plot 
menu, and the program commands and features. You can use the 
Reference to provide more detail during the lessons, or to clarify and 
enhance your knowledge of particular points, after you have learned 
the program. 

The Glossary and Index are effective tools for learning terminology, 
and locating the discussion of various topics. 

The Appendixes cover topics of special interest: Appendix A is a list of 
error messages, Appendix B contains printer information, Appendix C 
discusses data formats for file storage, and Appendix D shows how 
VisiTrend/Plot data can be shared with other programs such 
as VisiCalc®. 

The Pocket Reference Card provides a handy summary of the 
VisiTrend/Plot menu functions and special features. 
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HOW TO USE THIS MANUAL 

The VisiTrend/Plot manual is primarily a set of lessons and a 
reference. It can be used in different ways to maximize its value. Here 
are a few suggestions: 

• If you are using VisiTrend/Plot for the first time, and have not spent 
much time using other programs, read the Introduction and do the 
lessons. Each lesson is independent of the other lessons, but you 
should do them in the order given. As you progress, use the 
Reference to look up answers to your questions. 

• If you have a good deal of computer experience and have used other 
programs, you can quickly learn the VisiTrend/Plot program by 
reading the Introduction and studying the functional summaries at 
the end of each lesson. The summaries are a brief keystroke guide, 
and can provide a quick course for learning the program. Refer to the 
text of the lessons or to Chapter 3: REFERENCE for further explana­
tions and details. 
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ABOUT THIS PROGRAM 

CHAPTER 1 
INTRODUCTION 

The VisiTrendlPlot™ program turns your computer into a statistical­
analysis and chart-plotting system. With this program you can enter and 
save business data, do complex forecasting and analysis, display charts 
of your current status and goals, print charts on your printer, and save 
charts on diskette for later use with VisiTrend/Plot or other programs. 
The VisiTrend/Plot program communicates with the VisiCalc® program 
and other programs that support DIFTM (data interchange format) files. 

The VisiTrend/Plot program contains three subprograms: 

• The Main Subprogram for storage management and data editing. 

• The Trend Subprogram for statistical analysis and data editing. 

• The Plot Subprogram for plotting charts of the data generated by the 
other subprograms. 

Figure 1-1 shows the relationship between these subprograms. 

Main Subprogram 

VIEW, INITIALIZE, STORE 

Store 

[ijj]EBEI 
Load 

Plot Subprogram 

GRAPHICS 

!~ 
X·Axii 

[E] 
.

"". "., ... onA .. tr.~ ..•.. Vo. eotll 1.111 ' 

Const m, 

"""{'" .... 

Display 

001·002 

Figure 1-1. Visi Trend/Plot Program Overview 
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MAIN 

When you load VisiTrend/Plot, the program begins in the Main sub­
program. Main provides a path to the other two subprograms: Trend, and 
Plot. Existing data must be loaded from a data diskette using Main, or 
data must be created using either Main or Trend, before charts can be 
drawn using Plot. In the Main subprogram you can: 

• Load data from a data diskette. 

• Save data on a diskette. 

• List the data currently in memory. 

• Control the assignment of disk drives. 

• Clear unwanted data from memory. 

• Create new data and modify existing data. 

• Load the Trend subprogram. 

• Load the Plot subprogram. 

TREND 

In the Trend subprogram you can: 

• Develop data series to do analysis and forecasting. The available 
methods include derivation of data-point-to-data-point moving 
averages, smoothing data, percent of change, leading, lagging, and 
cumulative total functions. Additionally, new series can be created 
by taking sums, ratios, logs, or other mathematical or logical trans­
formations of the time series data. 

• Perform linear multiple regressions, using the ordinary least squares 
method. The Trend subprogram calculates and displays the major 
statistical measures of a multiple regression including: standard 
errors of the coefficients and the regression, T-statistic, R-bar 
squared, F-statistic, and Durbin-Watson statistic. 

• Perform trendline forecasting. 

• Calculate and generate statistics such as minimum, maximum, mean, 
variance, standard deviation, and correlation coefficient. 

PLOT 

In the Plot subprogram, you can create text-only pages and annota­
tions, and you can visually communicate statistical data by generating 
the types of charts shown in Figures 1-2 through 1-7. 
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018·001/P 

Figure 1-2. Typical Line Chart 

Line charts consist of points plotted against a value axis and a time 
axis. The points can be plotted with or without the connecting line. 

018·002/P 

Figure 1-3. Typical Bar Chart 

Bar charts consist of vertical bars that indicate values by the height of 
each bar. 
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018-003/P 

Figure 1-4. Typical Area Chart 

Area charts consist of a line chart with the area between the plotting 
line and the base line filled in. 

018-004/P 

Figure 1-5. Typical Pie Chart 

Pie charts consist of a circle segmented to show percentage of a whole 
or total. 
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018-005/P 

Figure 1-6. Typical High-Low-Close Chart 

High-Low-Close charts consist of data points and vertical lines that show 
the high value, low value, and intermediate value for each data point. 

018-006/P 

Figure 1-7. Typical XY Chart 

XY charts consist of two sets of values plotted against each other. The 
single set of points on this type of chart graphically indicates the 
presence or absence of a correlation between the two sets of values. 
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Also, with the use of the VisiTrend/Plot overlay and window 
capabilities, combinations of all the chart formats (except the Pie chart) 
are possible. A Pie chart is a unique form that is always handled 
separately. Figures 1-8 through 1-10 show some examples of chart 
combinations. 

018-007/P 

Figure 1-8. Combined Line and Bar Chart 

018-008/P 

Figure 1-9. Comparative Bar Chart 
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018-009/P 

Figure 1-10. Combined High-Low-Close and Line Chart 

COMPUTER SET-UP 

To use the VisiTrend/Plot program with your computer, you must have: 

• 48K or more of RAM memory. 

• A video monitor or a TV set, either color or black-and-white. A video 
monitor with color is preferable so that you can make full use of the 
VisiTrend/Plot color capabilities. 

• Two or more Apple Disk II disk drives. The disk controller must have 
the I6-sector PROMs installed. The I6-sector PROMs come with the 
Apple Language System and with Apple DOS 3.3. 

Make sure your disk drives are connected to the computer as shown 
under DEVICE in Chapter 3: REFERENCE. 

• The two VisiTrend/Plot product diskettes that are stored in the plastic 
sleeve at the back of this binder. 

• At least one blank diskette. 

• The Apple Language System card or the Applesoft ROM if your 
system is an Apple II. The Apple II Plus already has Applesoft BASIC 
in ROM. 

Be sure that your computer is set up and fully operational before you 
try to load the VisiTrend/Plot program. If you experience difficulty at any 
point in the set up, see your dealer. . 
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TAKING CARE OF FLOPPY DISKETTES 

You can't be too careful with your diskettes! Each diskette is 
magnetically coated and sealed in a protective square plastic cover. You 
can see the magnetic surface of the diskette through the oval cutout in 
the square cover. 

Never touch the exposed magnetic surface with your fingers or any 
implement. Protect diskettes from dust by storing them in the paper 
sleeves. Do not store them within six inches from magnetic fields 
generated by a TV, speakers, or other magnetic devices. 

Temperature extremes (such as in a car trunk on a warm day) destroy 
diskettes. Never fold, bend, or staple a diskette. And don't write on the 
square plastic cover with a hard pen or pencil (use only soft felt tip pens). 
Store diskettes in a special diskette binder or case. 

GETTING STARTED 

THE KEYBOARD 

Figure 1-11 shows the computer keyboard. With the exception of a few 
keys, the keyboard is self-explanatory. Any special keys will be 
explained as you need to use them. 

001-002 

Figure I-II. The Keyboard 

WARNING: Never press the RESET key. When VisiTrend/Plot 
diskettes are in the drives, pressing RESET can damage the program and 
data. If you do accidentally press RESET, see the directions under 
KEYBOARD USAGE in Chapter 3: REFERENCE. 
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INSERTING AND REMOVING DISKETTES 

The door of a floppy disk drive is opened by pulling outward and 
upward on the bottom edge of the door. The diskette is inserted into and 
removed from the drive with the diskette label facing upward. The edge 
of the diskette with the oval cutout enters the drive first; the edge with the 
label enters face up and last. 

Never remove a diskette while the red IN USE light on the drive is lit. 
This can permanently damage the diskette, and is almost certain to 
destroy the information on it. You may be able to reuse such a diskette, 
but you will not be able to recover the lost data. 

READING THE PROGRAM DISKETTE SERIAL NUMBER 

The VisiTrend/Plot program diskette serial number is recorded on the 
program diskette. You need the serial number to complete your warranty 
card. Write down the number so that you can refer to it later. To read the 
number, follow the steps below: 

1. With the computer power OFF, insert your Apple DOS 3.3 System 
Master diskette into drive 1. Turn the power ON. 

2. Insert your VisiTrend/Plot program diskette into drive 2, and type the 
DOS 3.3 command: 

CATALOG,D2 

3. Press the RETURN key to see the second page of the catalog listing. 
The program diskette serial number is contained in the name of the 
last file in the list. The name is SERIAL-NUMBER: xxxxxxxxxx, where 
xxxxxxxxxx is the IO-digit serial number. 

LOADING THE VISITREND/PLOT PROGRAM 

The procedure you use to load the VisiTrend/Plot program depends on 
the configuration of your computer. For all configurations, the I6-sector 
PROMs must be installed in the disk controller card. 

Procedure 1 is used for Apple II Plus computers with or without the 
Language System, and for Apple II computers with the Applesoft ROM 
card installed. These systems come equipped with Applesoft BASIC. 

Procedure 2 is used for Apple II computers with the Language System 
installed but without Applesoft in ROM. You must load Applesoft BASIC 
into these systems before you can load the VisiTrend/Plot program. 

Procedure 3 is used if you have a Corvus Hard Disk™ connected to 
your computer. 
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Procedure 1 - Floppy Diskettes Only 
Assuming that your video monitor and computer are OFF (the Apple's 

POWER light at the left corner of the keyboard is not lit), follow these 
instructions: 

1. Turn ON your video monitor or TV set. 

2. Insert the VisiTrend/Plot program diskette in drive I, and the 
example diskette in drive 2. Close the drive doors. If you have mul­
tiple floppy-disk drives, drive 1 should be the drive connected to the 
controller card in the highest-numbered slot. This is usually slot 6. 

3. Turn the computer power switch ON. The red IN USE light for drive 1 
goes on, and the drive begins to whir. In a few seconds you see the 
VisiTrend/Plot startup display on the screen. If this display does not 
appear on the first try, turn the computer switch OFF then ON again. 

Procedure 2 - Floppy Diskettes Only 
Assuming that your video monitor and computer are OFF (the Apple's 

POWER light at the left corner of the keyboard is not lit), follow these 
instructions: 

1. Turn ON your video monitor or TV set. 

2. Insert the DOS 3.3 System Master diskette in drive I, and close the 
door. Drive 2 should be empty. If you have multiple floppy-disk 
drives, drive 1 should be the drive connected to the controller card in 
the highest-numbered slot. This is usually slot 6. 

3. Turn ON the computer power switch. The red IN USE light for drive 1 
goes on, and the drive begins to whir. In a moment, Applesoft BASIC 
is loaded into the computer, and the Applesoft BASIC prompt (1) is 
displayed. If your computer contains a Microsoft RAM card, type FP 
and press the RETURN key. 

4. Open the drive door, and remove the DOS 3.3 System Master 
diskette. 

S. Insert the VisiTrend/Plot program diskette into drive I, and close the 
door. 

6. Insert the VisiTrend/Plot example diskette into drive 2, and close the 
door. 

7. Type RUN HELLO and press the RETURN key. The red IN USE light 
for drive 1 goes on, and the drive begins to whir. In a moment, you 
see the VisiTrend/Plot startup display on the screen. If this display 
does not appear on the first try, turn the computer power switch OFF 
then ON again, and repeat from step 2. 
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Procedure 3 - Floppy Diskettes With Corvus 
Hard Disk 

1. Your video monitor or TV set should be turned ON,and 
your computer should be turned OFF. 

2. Insert the VisiTrend/Plot program diskette in floppy~disk 
drive I, and the example diskette in floppy~disk drive 2 (if 
installed) . 

NOTE:. If you do not have a floppy·disk drive 2, use the 
Corvus· COPY3 program to put·the examplediskeUe files 
on an empty volume. 

3. Turn ON the Corvus Hard Disk drive. 

4. When only the READY' light on the Corvus Hard Disk: drive 
remains lit, turn· ON the computer power, . 

5. Within a couple of seconds, aDOS startup display appears 
on the screen. 

6.Wh.enthelpromptappears, type RUNHELLO,.S4~Ql. 
PresstheR~TURN key .. Ina fewse90nds/ yous~ethe 
VisiTrend/Plot startup display on the screen. . 

THE STARTUP DISPLAY 

Figure 1-13 shows the initial screen after loading the VisiTrend/Plot 
program. 

Figure 1-13. Startup Screen Display 
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The four dark and light bars that currently appear at the top of the 
screen are called the status area. At some points during the 
VisiTrend/Plot program, this status area appears at the bottom of the 
screen. The status area displays information about the computer and the 
program, and contains menus of commands you qive to the 
VisiTrend/Plot program. 

The light bars (inverse video) supply information and give directions. 
The dark bars (normal video) display a menu, messages from the pro­
gram, or spaces for data entry. 

Below the status area are two lines that contain the version number of 
your VisiTrend/Plot program, and the copyright notice. You should write 
down the version number, and refer to it in any future correspondence 
with VisiCorp. The copyright notice indicates that this program and its 
documentation are protected by the United States Copyright laws. Be 
sure to read the VisiCorp Customer License Agreement on the back of 
the User Support Plan. 

Below the copyright notice are three lines of directions for selecting a 
menu item from those displayed in the status area. 

THE CURSOR 

The cursor is an inverse video rectangle that serves as your pointer to 
items on the screen. If you just loaded the program and have not pressed 
any keys, the cursor highlights the menu item LOAD. 

Press the - key on the keyboard. The cursor moves to the menu item 
PLOT. Press the - key, and the cursor moves back to LOAD. 

As you move the cursor, the top line of the status area displays a long 
prompt of the meaning of each menu item. With the cursor on LOAD, the 
top line indicates that you can load a file from the data diskette. With the 
cursor on PLOT, the long prompt indicates that you can go to the Plot 
subprogram. 

You can move the cursor left or right with the - and - keys. When the 
cursor reaches the end of one line of items, it wraps around to the other 
line. You can also move the cursor up or down one line in the menu with 
the space bar. Experiment with the arrow keys and the space bar until 
you feel comfortable with moving the cursor to items ina menu. 
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SELECTING A MENU ITEM 

Moving the cursor to a menu item does not execute a command to the 
program. To make the program respond, you must select that menu item. 

You select a menu item in either of two ways: 

• Move the cursor to the item, then press RETURN; or 

• Type the first two letters of an item name, regardless of where the cur­
sor rests. The cursor moves to the item whose abbreviation you typed, 
the long prompt flashes on the screen in the status area, and the 
display associated with that item appears. 

Move the cursor to DISPLAY and press RETURN. The program beeps, 
and the message CAN'TI NO ACTIVE SERIES replaces the menu in the 
status area. The program cannot display a series of plotting data because 
none exists in memory yet. 

Because the commands in the VisiTrend/Plot program are executed by 
selections from a menu, you must have a menu on the-screen to continue. 
Whenever a menu is not present on the screen, you can redisplay a menu 
by pressing the ESC key. Press ESC, and the Main menu is again 
displayed. 

SUMMARY 

This completes your introduction to the VisiTrend/Plot lessons. You 
should now know how to: 

• set up your computer. 

• load the VisiTrend/Plot program. 

• move the cursor within a menu. 

• select an item from the menu. 

• use the ESC key to redisplay the menu on the screen. 

Now you are ready to go on to the VisiTrend/Plot lessons. Lesson One 
discusses drawing charts on the screen. Lesson Two covers the Main sub­
program with the exception of the Edit operation. Editing operations are 
covered in Lesson Three. Lesson Four describes how to use the statistical 
analysis functions in the Trend subprogram. Lesson Five guides you in 
plotting a number of charts for experience with more complete data 
series. 
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CHAPTER 2 
TUTORIAL 

LESSON ONE: THE PLOT SUBPROGRAM 
DRAWING CHARTS 

Lesson One covers loading plotting data into memory, and using the 
Plot subprogram. At the end of this lesson, you should know how to: 

• Draw a chart. 

• Add titles and other enhancements to a chart. 

• Change the scale and range on a chart. 

• Print a chart. 

• Save the screen image of a chart for later display or printing. 

Before you begin this lesson, be sure you have read the Introduction and 
know how to: load the VisiTrend/Plot program from the diskette, move the 
cursor in a menu, and select a menu item. Review the Introduction now, if 
you are unsure of any of these steps. 

LOADING DATA INTO MEMORY 

If you are not continuing directly from the Introduction, load the 
VisiTrend/Plot program diskette according to the directions under 
LOADING THE VISITREND/PLOT PROGRAM in Chapter 1. Your screen 
should look like the Startup Screen Display in Figure 1-13, earlier. 

The status area displays the Main subprogram menu. The bottom line 
specifies the drive that contains the data diskette. From the Main menu you 
can access the other two VisiTrend/Plot subprograms: Plot and Trend. 

First, you will load data from the data diskette, then go to the Plot sub­
program and use that data to draw charts on the screen. Follow these 
instructions: 

1. With the cursor on the word LOAD, press RETURN. 

2. With the cursor on SAMPLE 1, press RETURN. The program displays a 
list of the data series in SAMPLE 1. 

3. Press RETURN again. The list disappears and the Main menu returns. 
The SAMPLE 1 data has been loaded into memory, and you can now 
use it to draw (plot) a chart. 

4. Move the cursor to PLOT, and press RETURN. You are now in the Plot 
subprogram. 
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The Select menu appears in the status area at the bottom of the screen, 
preceded by the message PLEASE SELECT CHART TYPE. Your screen 
should look like Figure 2-1. 

018-011/P 

Figure 2-1. Select Menu 

SELECTING A CHART TYPE 

You use the Select menu to select the type of chart you want to draw. 
The menu indicates the six types of VisiTrend/Plot charts: LINE, BAR, 
AREA, PIE, HIGH-LOW-CLOSE, and XY. The last item on the menu, 
NONE, exits from the Select menu without choosing a chart type, and 
takes you to the Plot menu. 

With the cursor on LINE, press RETURN to select a Line chart. 

The menu disappears and is replaced by a line of information: 
CURSOR MOVEMENT, < SPACE>, OR < RETURN>. The same list of 
data series names you saw after loading SAMPLE 1 appears at the top of 
the screen. You'll now indicate the data series to be plotted by moving 
the cursor, if necessary, and pressing RETURN. Using <SPACE> (the 
space bar) is discussed in Lesson Five when you select multiple series to 
be plotted on the same chart. 

The header line of the data series list includes some information about 
each series: 

NAME The name of the data series: series names should describe the 
data they contain. 
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PER The period of the series: the series in this list have a period of 1. 
This indicates one data point for each time period that the 
series covers. The period can be any value from 1 to 99. 
Typical values are 1 (annual), 4 (quarterly), 12 (monthly), and 
30 (daily). 

START The starting date for the series: the series in this list start in 
1973. For periods other than I, the starting date displays the 
year followed by the period of the first data point. For example, 
with a period of 12, a starting date 1980 9 indicates the 9th 
period of 1980 (September, 1980). 

END The ending date for the series: this date is displayed in the 
same manner as START. For example, with a period of 12, an 
ending date 1989 3 indicates the 3rd period of 1989 (March, 
1989). 

# The number of data points in the series: a series can contain up 
to 150 data points. 

You cannot go further in the Plot subprogram until you select a data 
series to plot. To move the cursor up and down in this list, use the keys 
marked ~ or -. The cursor wraps around the list in much the same way 
as it wraps around a menu. Pressing - on the last item causes the cursor 
to jump to the top item. Likewise, pressing ~ at the top of the list causes 
the cursor to jump to the bottom. 

Move the cursor to the series named FLOPPY SALES, and press 
RETURN. 

PLOTTING A CHART 

The list of data series disappears, and the Plot menu is displayed at the 
bottom of the screen. Most of your work in the Plot subprogram is 
selected from this menu. Figure 2-2 shows the Plot menu. 
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018·0121P 

Figure 2-2. Plot Menu 

The bottom line of the status area records the information FLOPPY 
SALES/LINE on the left, and W1 ,61 on the right. You have selected a Line 
chart to be drawn for the FLOPPY SALES data series. W1 indicates that 
the chart's foreground, the data, will be drawn in white, and B1 that the 
background will be black. 

The cursor is on PLOT, and the long prompt indicates that this menu 
item lets you PLOT THE CURRENT SERIES. Current means your most recent 
choice(s) from the data series list. 

Plotting a Line Chart 
Press RETURN to select PLOT from the menu. The program beeps, the 

menu in the status area disappears, and the plotting of the chart begins. 
Automatically, the Y and X axes, the axes tick marks and values, and the 
bottom legend are drawn. Your screen should resemble Figure 2-3. 
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018-013/P 

Figure 2-3. Line Chart With Floppy Sales Data 

Examine the chart for a moment. The numbers along the Y-axis are the 
scale of the chart, and the numbers along the X-axis are the range in 
years. When there are many plotting points for a range of years, the Plot 
subprogram abbreviates the range numbers to fit on the axis. 

The legend at the bottom has three parts: a chart-type code (in this 
case, L for Line), the plotting symbol used for the series, and the name of 
the series. A hollow square is always used when a single series is plotted. 
When you draw charts with multiple series in Lesson Five, you will see 
the other symbols: plus sign (+), hollow circle (0), x, hollow diamond 
( 0 ), and x over a dot ( )( ). 

The chart has one plotting symbol for each of the 12 data points in the 
series, and the points are connected by a line. 

To redisplay the Plot menu, press ESC. The status area covers the 
legend at the bottom, but the full chart is still visible above the status 
area. 

Press ESC again to see the chart and legend without the status area. 
You can switch back and forth as often as you wish. ESC works this way 
whenever a chart is displayed on the screen. 

2-5 



VISITREN DIP LOT™ ~~T~~s APPLE II 
LESSON ONE TUTORIAL 

Plotting a Bar Chart 
Display the status area on the screen so that you can use the other items 

in the Plot menu. The menu lets you put titles on a chart, change the 
range and scale, add and remove grid lines, and many other options. 
Before examining these features, you'll practice what you just learned by 
drawing a different type of chart, a Bar chart. 

Move the cursor to the word SELECT. The long prompt indicates that 
you can SELECT A CHART TYPE. Press RETURN. 

The status area now displays the Select menu. Your Line chart is still 
on the screen, and you can still remove and redisplay the status area with 
the ESC key. 

Move the cursor to BAR and press RETURN. 

Instead of listing the available data series, the program first displays 
the Bar menu in the status area. You can choose the style of bars you want 
to draw. Figures 2-4 through 2-6 illustrate the choices. 

018-014/P 

Figure 2-4. NORMAL Bars 

Normal bars are full-width, centered on the X-axis tick marks. 
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018-015/P 

Figure 2-5. BOTH Bars 

A half-width bar is drawn on each side of the tick mark. The plot is not 
complete until both half-width bars are drawn. 

018-016/P 

Figure 2-6. LEFT Bars (or RIGHT Bars) 

Half-width bars appear to the left of the tick marks. Specifying RIGHT 
places half-width bars to the right of the tick marks. The plot is complete 
when either set of half-width bars is drawn, as appropriate. 
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With the cursor on NORMAL, press RETURN. Now the program 
displays the list of data series. Move the cursor to FLOPPY SALES, and 
press RETURN. 

As before, the list disappears, and the status area presents the Plot 
menu. Your previous line chart of FLOPPY SALES is still on the screen. A 
previous chart remains as the current chart on the screen until you select 
PLOT for a new chart. The bottom line of the status area reflects your 
latest selections: FLOPPY SALES/BAR. Now plot the Bar chart. 

With the cursor on PLOT, press RETURN. The program beeps, the old 
Line chart disappears, and the Bar chart is drawn. Another beep indi­
cates that the chart is complete. Your screen should now resemble 
Figure 2-7. 

018-017/P 

Figure 2-7. Bar Chart With Floppy Sales Data 

ADDING DETAIL TO A CHART 

The chart on the screen is a typical Bar chart with basic information. 
You can include more detail in the chart such as a descriptive legend, 
highlighted titles, or explanations of unusual data. 

Press ESC to redisplay the status area with the Plot menu. 

The menu item that lets you add detail to a chart is OPTIONS. Move the 
cursor to OPTIONS, and press RETURN; or abbreviate the item choice by 
typing OP. The Options menu appears in the status area. Your screen 
should resemble Figure 2-8. 
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018-018/P 

Figure 2-8. Options Menu 

Putting Top and Bottom Titles on a Chart 
With the cursor on TITLE, press RETURN. The status area now displays 

the Title menu, shown in Figure 2-9. 

018-019/P 

Figure 2-9. Title Menu 
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The first item in this menu is EXIT. As the long prompt indicates, 
choosing EXIT lets you RETURN TO MAIN PLOT MENU. All other items in 
the Title menu perform their function, then let you remain in the Title 
menu. Try EXIT. Now return to the Title menu from the Plot menu by 
selecting OPTIONS, and then TITLE. 

Now create a top title for your chart. Move the cursor to TOP, and press 
RETURN; or abbreviate the item choice by typing TO. 

In the status area, the title menu is replaced by spaces where you enter 
a title, as shown in Figure 2-10. The cursor is blinking on the title-entry 
line. This line displays any characters you now type at the keyboard. 

018-020/P 

Figure 2-10. Title-Entry Status Area 

Type MY FIRST CHART. The cursor moves forward as you type. If you 
make an error, use the ESC key to erase characters to the left of the cur­
sor; then retype them. If you press ESC beyond the beginning of this 
line, a beep sounds, and you return to the Title menu. In such a case, 
simply select TOP again. 

When you complete the title, press RETURN. Next, the Typeface menu 
appears, shown in Figure 2-11. You can choose to display your title in 
normal typeface, bold typeface, or inverse video. Move the cursor to 
BOLD, and press RETURN. 
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Figure 2-11. Title Typeface Menu 

The title appears in boldface type, centered at the top of the chart. The 
Title menu returns to the status area. Your screen should resemble the 
one in Figure 2-12. 

018-022IP 

Figure 2-12. Top Title in Boldface 

A top title can contain up to 37 characters. To change a top title, you 
would enter a new one by repeating the sequence above. Select TOP, 
enter the title, then choose a typeface. The new title would replace the 
old one. For more information, see the section "Changing and Erasing 
Titles" later in this lesson. 
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The menu also lets you enter one, two, or three bottom titles. Bottom 
titles occupy the first, second, and third lines in the legend area. A bot­
tom title erases a legend that occupies the same line. 

Move the cursor to FIRST, and press RETURN; or type FI. The title-entry 
area replaces the menu. Each of the three bottom titles can contain up to 
37 characters. Type DISK DRIVE SALES for the First bottom title, and 
press RETURN. The Typeface menu appears. This time select NORMAL 
typeface; press RETURN. Rapidly, the legend is overwritten by the title, 
then the Title menu reappears. Press ESC to erase the status area, and 
take a better look at the bottom title. Press ESC when you are ready 
to continue. 

SECOND and THIRD work the same way as FIRST. They create, respec­
tively, a second and third title under the first title at the bottom of 
the chart. 

LEFT-JUSTIFYING TOP AND BOTTOM TITLES 

When a top title or a bottom title is placed on a chart it is automatically 
centered. If you want to left-justify a top title or any bottom title, type an 
"at" symbol (@) as the last character of the title. For example, if DISK 
DRIVE SALES were entered as DISK DRIVE SALES@, it would appear in 
the lower left-hand corner of the chart under the Y-axis. 

If you want to try it now, select FIRST again from the Title menu, type 
DISK DRIVE SALES@ as a new title, and select NORMAL from the 
Typeface menu. When you press ESC to remove the status area, you can 
see the title at the bottom-left of the chart. Press ESC to continue with the 
Title menu. 

Putting Side Titles on a Chart 
Move the cursor to SIDE, and press RETURN; or type SI. A side title 

can contain up to 14 characters. Type UNITS/OUTLET in the title-entry 
area, and press RETURN. This time, select INVERSE from the Typeface 
menu. The side title is displayed vertically along the left side of the chart, 
outside the Y-axis values. 

Restoring the Legend 
The LEGEND menu item is used to restore the original legend line(s) by 

erasing all bottom title lines. You covered the one-line legend with the 
FIRST title; now move the cursor to LEGEND, and press RETURN; or 
type LE. 
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The status area vanishes, the bottom title line is replaced by the 
original legend, and the status area returns - covering the legend. This 
happens fast, and you might miss it. Press ESC to erase the status area for 
a better look. Your bottom title is gone, and the original legend is back 
on the screen. 

This menu item works slightly differently with Pie charts. Refer to the 
discussion of LEGEND in Chapter 3: REFERENCE for more details. 

Putting Moveable Titles on a Chart 
The last item in the Title menu is MOVEABLE. This option lets you enter 

a title, and move it to any location on the chart. You can put any number 
of titles anywhere on the chart you choose. A moveable title can contain 
up to 37 characters. 

Press ESC to bring back the status area. Move the cursor to 
MOVEABLE, and press RETURN; or type MO. Type PLANT FIRE in the 
title-entry area, and press RETURN. 

The title appears at the middle-left of the chart. This title can now be 
moved to any location on the screen. 

The movement of a title is controlled with the I, +--, -, and M keys. 
Look at these keys on the key board. Notice that their relative locations 
suggest the four directions of movement: 

up 
I 

left +-- - right 

M 
down 

Press - a couple of times. The title jumps in a given direction each 
time a direction key is pressed. Now press the M key to move the title 
down over the chart bars. Notice that the title is white when over a black 
background and black when over a white background. Keep pressing 
the M key to move the title all the way to the bottom of the screen. 

When the title reaches the limits of the screen, a beep sounds for each 
attempted move beyond the screen limits. 

You can increase or decrease the distance of each title move by typing 
a number from 1 to 9. The higher the number the farther the title will 
move when a direction key is pressed. If you do not change the distance 
per move, the title moves at approximately the 5 rate. 
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Press 9, the greatest distance per move, then experiment with pressing 
I, +-, -, and M. The title can now be moved in fewer jumps from one 
screen border to another. Experiment with smaller numbers, too. 

With a little practice, you can become adept at moving the title quickly 
to an area of the screen in big jumps, and fine-tuning its position in 
smaller jumps. 

Move the PLANT FIRE title to the short bar for the year 1982. Center 
the title about a quarter of an inch below the top of the bar. When you 
have positioned the title where you want it, press RETURN. 

A Typeface menu appears in the status area. This menu is identical to 
the Typeface menu for regular titles, with the addition of two items: FIX 
and CANCEL. The FIX menu item fixes the title in place; it can no longer 
be moved around the screen. Selecting FIX without specifying a 
typeface, automatically defaults to the NORMAL typeface. The CANCEL 
menu item erases the title, then returns you to the Title menu. 

Before selecting FIX, or choosing to CANCEL, you can experiment with 
switching from one typeface to the other. The Typeface menu remains in 
the status area until either FIX or CANCEL is selected. When you select 
FIX, the title is fixed on the chart in the chosen typeface, and the Title 
menu reappears. 

For now, move the cursor to FIX, and press RETURN. The title is fixed 
in place, in NORMAL typeface. The Plot subprogram automatically 
displays the title in a black rectangle, since it is fixed over the white bars. 
The title is now a permanent part of the chart. Your screen should 
resemble Figure 2-13. 
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Figure 2-13. A Moveable Title in Place 

You learned several important things in this exercise. Review some of 
them now: 

• The keys I, ~, +-, and M cause a moveable title to move in the direc­
tion indicated by their relative location on the keyboard. 

• The numbers 1 to 9 can be used to select the distance a title moves 
each time the keys I, +-, ~, or M are pressed. 

• Pressing RETURN after locating a moveable title on a chart displays a 
Typeface menu. 

• The Typeface menu item FIX is the only way to fix a moveable title in 
place. 

Changing and Erasing Titles 
Two types of titles can be added to charts in the Plot program: 

moveable titles and fixed titles. There are different methods for changing 
and removing these two types of titles. 

CHANGING AND ERASING MOVEABLE TITLES 

A MOVEABLE title can be easily changed or erased with the CANCEL 
menu item, before it's fixed in place. The method is the same in either 
case: to change a moveable title, you first erase it with CANCEL, then 
select MOVEABLE from the Title menu, and enter a new title. 
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WARNING: If a moveable title is covering any bars, lines or 
characters when you press CANCEL, a permanent black rectangle 
remains on the screen. To avoid this, move the title into an open black 
area of the screen before you display the Typeface menu. 

Try cancelling a title. Select MOVEABLE from the menu, enter TEST1 
as the title, and press RETURN. Move the title above the bars. 

Now press RETURN to get the Typeface menu. Move the cursor to 
CANCEL, and press RETURN. The title is erased, and the Title menu 
reappears. 

After you have selected the FIX menu item, a moveable title becomes a 
fixed title. It can still be changed or erased, but by the methods 
described below for FIXED TITLES. 

CHANGING AND ERASING FIXED TITLES 

Any FIXED title, except one that was previously moveable, can be 
changed or erased by simply selecting the same Title menu item again. 
Then enter a new title to change (write over) the previous title, or type at 
least one blank as the new title to erase the previous title. 

There are two other methods of chanqing or erasing any fixed title 
(including a previously moveable title). Both of these methods work as 
well on other parts of a chart. 

• One method is to select the TEXT item that appears in the Plot menu. 
This item will be covered in detail in Lesson Five. 

• A second method is called masking. You create a mask to cover an 
area, thereby erasing it from the chart. 

A mask is created with the MOVEABLE menu item, because a mask is 
simply a moveable title consisting of blanks bounded by periods. A mask 
can contain up to 37 characters (including the two periods). The mask 
functions as a horizontal bar, and therefore, cannot be used to effectively 
cover a side title. 

Experiment with a mask now by entering a title on the second bottom 
title line. Move the cursor to SECOND, press RETURN, enter 1981, and 
press RETURN again. The Typeface menu appears. Select BOLD, and 
press ESC to view the new title line. 
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Now follow these steps to erase the line using a mask: 

1. Press ESC to display the Title menu. Select MOVEABLE. 

2. Create the mask on the title-entry line in the status area. The mask 
must contain the same number of blanks as the area to be erased, and 
it must begin and end with a period. Type a period, four blanks (use 
the space bar), and another period. 

3. Press RETURN. The mask and two periods appear at the center-left of 
the chart. 

4. Use the direction keys I, -, +-, and M to move the mask so that the 
two periods are on either side of 1981, and resting on the baseline. 
When the mask is in position, press RETURN. 

5. When the Typeface menu appears, select FIX. Press ESC to view the 
line - the year 1981 and the two periods are gone. Press ESC again 
to display the Title menu. 

As mentioned earlier, you can use masks to erase more than titles. A 
mask erases any portion of a chart between the two periods. 

MANIPULATING THE RANGE AND THE SCALE 

The range of any chart is the time between the starting date or 
reference point, and the ending date or reference point. The range is 
stored as part of the data series, and is plotted on the X-axis (except on an 
XY chart). 

The scale of any chart is the spread of values plotted along the Y-axis. 
The scale is determined each time a series is plotted. The program draws 
a scale that takes into account the range of values in the series, and adds 
an appropriate number of scale divisions (tick marks). 

In determining a scale, the program attempts to avoid divisions that 
result in fractional or non-round numbers. Whenever possible, the pro­
gram chooses round numbers. For example, with a series of 0 through 
700, the program tick-marks the Y-axis seven times. The tick marks are 
labeled 0, 100, 200, ... ,700. 

When Y-axis values are too large to be displayed, the program indi­
cates a scaling factor (THOU or MILL) at the top of the Y-axis, and trun­
cates the tick mark labels. For example, with a scale of 0 through 30,000, 
the program prints 0, 10, 20, 30 and displays THOU as the factor. This 
indicates that the numbers represent 0, 10,000, 20,000, and 30,000, 
respectively. Figure 2-14 is a chart with a scale factor of thousands. 
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Figure 2-14. Example of Chart With Scale Factor 

The VisiTrend/Plot program does its best to generate a good scale for 
your chart. There are times, however, when the values it chooses are not 
well-scaled. When this happens, you should consider rescaling the 
chart. 

You can change both the range and the scale when you draw a chart. 
For example, you might choose to display only a subset of the range, or 
to emphasize or minimize small variations. The scale and range can 
strongly influence how the data in a chart is perceived. 

Changing the Scale 
You'll select a different chart for this portion of the lesson - a FLOPPY 

DENSITY line chart. Follow this sequence of steps: 

1. Move the cursor to SELECT, and press RETURN. 

2. With the cursor on LINE, press RETURN. 

3. With the cursor on FLOPPY DENSITY, press RETURN. 

4. With the cursor on PLOT, press RETURN. Your screen should resem­
ble Figure 2-15. 
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Figure 2-15. Line Chart Before Changing the Scale 

Press ESC to display the Plot menu in the status area. Select OPTIONS. 
The Options menu is now displayed. 

One of the items on the Options menu is RESCALE, which changes the 
scale of the Y-axis. Move the cursor to RESCALE and press RETURN. 

The status area displays three prompts for the limits of the axis. The 
first prompt is Y AXIS MINIMUM. The current minimum on the chart is 20. 
Change it by typing -200; press RETURN. The next prompt is Y AXIS 
MAXIMUM. The current maximum is 180. Change it by typing 100; press 
RETURN. The final prompt is # I NTERV ALS (2" 12J OR < RETURN>. You 
can specify any number of intervals (tick marks) from 2 to 12, or press 
RETURN to accept intervals as determined by the program. The scale, 
-200 to 100, divides well into 6 intervals. Type 6 and press RETURN. 

Note that when you rescale a chart that has a scaling factor (such as 
THOU), you must enter the complete numbers; for example, you would 
type 30000, not 30. 

The Plot menu returns but the chart has not changed. You must replot 
the chart with the new scale. With the cursor on PLOT, press RETURN. A 
beep sounds, and a message appears in the status area DATA OFF SCALE, 
CHOOSE ACTION. This is a warning that some data points in the series 
are outside of the scale you specified, and that the chart will not contain 
those data points. You now have two choices of action: PROCEED or 
CANCEL. PROCEED continues with the chart, drawing it off-scale. 
CANCEL aborts the plot request (including the rescale numbers), leaves 
the current chart on the screen, and displays the Plot menu. 
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Select PROCtED. The program beeps twice to indicate that two data 
points cannot be drawn on the chart. The last two points in the series did 
not fit within the scale. 

When you proceed with drawing an off-scale Line, Area, XY, Bar, or 
High-Low-Close chart, the program continues to display the message 
DATA OFF SCALE, CHOOSE ACTION, and prompts you to PRESS ANY 
KEY to continue. When you press a key (ESC, for example), the Plot menu 
returns to the status area. 

The incomplete information on an off-scale chart can be misleading. A 
person reading the chart cannot know that certain data points continue 
beyond the top of the scale. It is usually preferable to rescale, and replot 
the chart, than to show incomplete information. 

SPECIFYING WELL-SCALED CHARTS 

When you select a scale, the program takes your request literally, and 
does not try to change it. You might occasionally produce some odd­
looking scales. This is especially true if you select Y-axis intervals that 
are not even divisions of the difference between the minimum and max­
imum scale values. For example, if you set a scale from - 200 to 800 with 
10 intervals, the labels read - 200, -100, 0, 100 and so on. But if you set 
a scale from - 212.39 to 643.22 with 9 intervals, the chart, while correct, 
is hard to read (see Figure 2-16). 

018·026/P 

Figure 2-16. Example of Hard-to-Read Scaling 
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To determine a reasonable number of scale intervals, subtract the 
minimum value of the scale from the maximum value. Choose any 
number, in the range 2 through 12, that evenly divides into the dif­
ference. In the chart on your screen, 100 minus - 200 equals 300. Speci­
fying 2, 3, 6, or 12 results in divisions of 150, 100, 50, and 25 respective­
ly. Others numbers, such as 4 and 5, divide evenly but result in divisions 
of 75 and 60. These laUer numbers are not as common as chart units of 
25, 50, and 100. 

Press ESC to display the Plot menu. Move the cursor to OPTIONS, and 
press RETURN; or type OP. When the OPTIONS menu appears, select 
RESCALE. For Y AXIS MINIMUM, type 0, and press RETURN. For Y AXIS 
MAXIMUM, type 750, and press RETURN. For the number of intervals, 
type 10, and press RETURN. 

When the Plot menu returns, select PLOT. This time your scale values 
are accepted, and the chart is redrawn with a new Y-axis. 

UNDERSTANDING SCALE ASSUMPTIONS BY THE PLOT 
SUBPROGRAM 

If you mistakenly enter a minimum scale value that is greater than the 
maximum value, the program makes an assumption and continues. The 
program assumes that you reversed the values, and switches them back. 
If you enter the same value for the minimum and the maximum, the pro­
gram uses this value as the minimum and sets the maximum approxi­
mately 20 percent higher. 

If you enter a value less than 2 or greater than 12 for the number of 
intervals, the value appears to be accepted. However, the chart that 
results will be off-scale. 

Changing the Range 
Now you'll practice changing the range on a chart. Start with a new 

copy of the FLOPPY DENSITY Line chart. Go back to the Select menu, 
and plot a fresh chart of the series, or change the scale back to 20 to 180 
with 8 intervals. PLOT the chart. If you need help with your choice, refer 
to the earlier sections of this lesson under SELECTING A CHART TYPE, 
and PLOTTING A CHART; or reread "Changing the Scale" above. 

Now you should have a FLOPPY DENSITY Line chart on the screen that 
looks like Figure 2-15, earlier. 

Press ESC to redisplay the Plot menu, then select OPTIONS. From the 
Options menu, select RANGE. 
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The top line of the status area displays the current range RANGE: 1973 
to 1981. The Range menu offers three choices: SET, CLEAR, and EXIT. 

EXIT returns you to the Plot menu, SET lets you change the range, and 
CLEAR removes a new range and displays the range stored in the series. 
CLEAR does nothing if you have not changed the range. 

With the cursor on SET, press RETURN. The prompt YEAR? requests a 
starting year. Type 1974, and press RETURN. The next prompt END 
YEAR? requests an ending year. Type 1990, and press RETURN. 

The Plot menu returns, but the chart is unchanged. RANGE works like 
RESCALE: you must now select PLOT to see the chart with your changes. 
With the cursor on PLOT, press RETURN. Your chart is redrawn with the 
new range. 

You removed one year from the front of the series, and added nine 
years to the end. You can lengthen or shorten a range. If you change the 
range, and thus remove data points, you might wish to rescale. Specify­
ing a range that does not include at least two of the data points in the 
series, causes the program to print the message CAN'T! BAD RANGE. 
In such a case, you would press ESC to return to the Plot menu, and 
try again. 

Because the period of this series is 1 (annual), the program did not 
prompt for a period with the starting and ending years. When your data 
series has a period other than 1, the program additionally prompts for the 
period of the first data point - for both the starting and the ending years. 

Press ESC to redisplay the Plot menu, then select OPTIONS. Select 
RANGE again from the Options menu. This time, move the cursor to 
CLEAR, and press RETURN. When the Plot menu returns, PLOT the chart 
again. The chart is redrawn with the original range. Press ESC to display 
the Plot menu. 
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FORMATTING A CHART 

You can modify Line, Bar, and XY charts with the FORMAT item in the 
Options menu. Before practicing with FORMAT, select NEW from the Plot 
menu. NEW erases the existing chart, and clears all options you have set. 
H you do not select NEW, some options such as BACKGR, are held over 
from chart to chart. 

Now you'll plot a new chart to practice formatting. With a clear screen, 
move the cursor to SELECT, and press RETURN. Now choose LINE and the 
FLOPPY SALES series to plot. When the Plot menu reappears, PLOT the 
chart. 

Redisplay the Plot menu, then select OPTIONS. Move the cursor to 
FORMAT, and press RETURN. The Format menu is displayed. The 
choices are SYMBOLS, LINES, POINTS, and BOTH. The line charts you 
have drawn in this lesson used both symbols and lines. 

Select POINTS from this menu. The Plot menu returns. Now PLOT the 
chart again. It is redrawn without the plotting symbols - it contains only 
points to indicate plotted values. 

Experiment with the other FORMAT choices by redisplaying the Plot 
menu, and repeating the preceding steps. Begin with OPTIONS, then 
FORMAT. 

The FORMAT menu item is valid for Line, XY, and Bar charts. For Line 
and XY charts, the format choices are: symbols only, lines only, points 
only, or both symbols and lines. When FORMAT is selected for a Bar 
chart, the Format menu is different. You can select outlined bars, shaded 
bars, or solid bars. Figures 2-17 through 2·21 show the Bar and XY chart 
formats. 
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Figure 2-17. Solid-Bar Chart 

018-028/P 

Figure 2-18. Outlined-Bar Chart 
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Figure 2-19. Shaded-Bar Chart 

018-030/P 

Figure 2-20. XY Chart With Symbols Only 
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Figure 2-21. XY Chart With Both Symbols and Lines 

If you select the FORMAT menu item with any kind of chart other than 
Line, Bar, or XY, a beep sounds and the program prints the message 
CAN'TI NO OPTION HERE. In such a case, you would press ESC to return 
to the Plot menu. 

DBA WING GRID LINES 

Press ESC to redisplay the Plot menu, then select NEW to clear the 
screen, and cancel all previously set options. Go to the Select menu. 
Now select LINE, the FLOPPY DENSITY series, and PLOT the chart. When 
the chart is drawn, press ESC to display the Plot menu. 

Select OPTIONS, move the cursor to GRID, and press RETURN. The 
Grid menu appears. You can draw horizontal, vertical, or both horizon­
tal and vertical grid lines. The NONE item takes you back to the Plot 
menu without drawing grid lines. With the cursor on BOTH, press 
RETURN. The program draws the grid lines for every tick mark that has a 
label, and completes the chart with top and right-side borders. The Plot 
menu is displayed. Your screen should resemble Figure 2-22. 
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Figure 2-22. Example of Chart With Grid Lines 

PLOT the series again. The program redraws the chart without the grid 
lines. Return to the Grid menu using OPTIONS and GRID, and select only 
HORIZ to draw the horizontal grid lines. 

Go back to the Grid menu once more, and select HORIZ again. The 
program erases the existing grid lines. Note in Figure 2-23 that only the 
grid lines are erased; the added border on the top and right side remain. 
The Plot menu is displayed. 

018-033/P 

Figure 2-23. Chart With Grid Lines Erased 
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This grid line erasing feature works for horizontal and vertical grid 
lines. In general, if a set of grid lines does not exist on a chart, choosing 
HORIZ, VERT, or BOTH draws the set(s). Once a set of grid lines exists on a 
chart, choosing the same set a second time erases that set. 

Charts that can have grid lines must be displayed before you choose 
the GRID menu item. If you select the item before you have plotted a 
chart, a beep sounds, and the program prints the message CAN'TI NO 
OPTION HERE. If this happens, press ESC to return to the Plot menu. 

EXAMINING OTHER ITEMS IN THE OPTIONS MENU 

You now have enough experience to examine the remainder of the 
Options menu. Move the cursor to OPTIONS, and press RETURN. There 
are three items here that you haven't used: UNLABEL, BACKGR, and 
COLOR. 

UNLABEL erases the X and Y axes labels from a chart. The chart must 
first be displayed before UNLABEL is selected. Once you erase axis labels 
with this menu item, you must replot the chart to get them back. 

BACKGR and COLOR offer you a variety of visual enhancements. For 
a complete description of how you can enhance your charts with black, 
white, and the various colors offered by the COLOR option, see the 
BACKGR and COLOR sections in Chapter 3: REFERENCE. For now, 
select EXIT to return to the Plot menu. 

PRINTING A CHART 

• If an Apple Silentype printer is connected to your computer, con­
tinue with the following exercise. 

• If a non-graphics printer is connected to your computer, skip this 
exercise, because you can print listings and tables only. 

• If another type of printer is connected to your computer, check 
Appendix B before going any further. Change printer drivers 
as explained in the Appendix, then continue with the following 
exercise. 

To print a copy of the chart on your screen, select PRINT from the Plot 
menu. The Print menu appears in the status area. With the cursor on 
PRINT, press RETURN. The program immediately begins printing the 
chart to the printer. 
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While the chart is being printed, take a look at the Print menu. The 
Print menu allows you to change the printer driver to any other type that 
is supported by your computer, and to respecify a slot number for your 
printer interface card. 

DRIVER changes printer/slot only for the current session. 

DEFAULT changes printer/slot for the current session and all future ses­
sions. Any change stays in effect until either DRIVER is chosen, or 
DEFAULT is chosen again. 

SLOT allows you to respecify the slot number to which the printer is 
connected. Usually, the printer is connected to slot 1. 

EXIT returns you to the Plot menu, without printing. 

Chapter 3: REFERENCE and Appendix B contain more information on 
printers and the Print operation. When printing is completed, the pro­
gram returns to the Plot menu. 

SAVING A CHART ON DISKETTE 

Once you have plotted a chart on the screen, you can save (store) the 
screen image in a diskette file. This allows you to retrieve the chart later 
for viewing on the screen, or printing to the printer. The SCREEN option 
lets you save and retrieve your charts. 

Select SCREEN from the menu. The Screen menu appears with the 
choice of loading, saving, device changing, or exiting. 

Now you'll practice saving the chart on the example data diskette. If 
you want to save the chart on a data diskette in another drive connected 
to your computer, see DEVICE in Chapter 3: REFERENCE. 

Move the cursor to SAVE, and press RETURN. The SCREEN menu is 
replaced with the prompt CURSOR MOVEMENT OR < RETURN> . Screen 
images that have been saved on the diskette are displayed in a list, with 
[NEW FILE] at the end of the list. Moving the cursor with - or ~ steps 
through the list, and RETURN selects the highlighted file. You are going 
to save the chart in a new file, so move the cursor to [NEW FILE], and 
press RETURN. 
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The status area prompts for the file name. Type SCREENl, and press 
RETURN. The VisiTrend/Plot program saves the displayed chart on the 
data diskette, in a file named SCREENl.PIX. The suffix .PIX denotes that 
the file is a screen image. You do not need to type this suffix; it's 
automatically added by the program whenever you name a file to save a 
screen image. 

When the file has been saved on the diskette, the Screen menu 
appears again in the status area underneath the chart. 

RETRIEVING A CHART FROM DISKETTE 

From the Screen menu, you can also retrieve (LOAD) a chart image 
from a data diskette. 

With the cursor on LOAD, press RETURN. A list of chart image files 
stored on the diskette appears on the screen. The program added .PIX to 
each file name when you saved the file. 

The last entry in this list is [NONE]. When there are more file names 
than can fit on one screen, the last entry in the list is [MORE]. Selecting 
[MORE] displays the next screen of file names. 

When the last entry in the list is [NONE], all file names in the list have 
been displayed. You select [NONE] if you change your mind about 
loading a file in this list. This choice cancels the Load operation, erases 
the list of file names, and redisplays the Screen menu. 

For now, select SCREEN1. PIX from the list. The list is erased, and the 
chart you just saved in SCREEN 1 . PIX is displayed. 

Press ESC to display the Screen menu again, and select EXIT to return 
to the Plot menu. 

Note that the display on your screen is the saved image, or picture, of a 
plotted chart. As such, the .PIX file is available for display or printing to 
a printer; but you cannot add or remove options on this image. However, 
text can be added to and removed from a .PIX file using the TEXT menu 
item. You will learn about the Text operation in Lesson Five. 

EXAMINING OTHER ITEMS IN THE PLOT MENU 

You can now examine the remainder of the Plot menu. You haven't 
used four items in this lesson: WINDOW, OVERLA V, TEXT, and EXIT. 

WINDOW allows you to draw two charts on the same screen. 
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OVERLAY allows you to add series to a chart without redrawing the 
chart. 

TEXT allows you to create text-only screens, and to annotate and edit 
charts. 

The Window, Overlay, and Text options are described in Lesson Five. 

The EXIT item displays a menu offering three choices: MAIN, TREND, 
and CANCEL. MAIN reloads the Main subprogram, TREND loads the 
Trend subprogram, and CANCEL returns you to the Plot menu. The data 
series that you have in memory are not lost when you move to other sub­
programs. 

SUMMARY 

In this lesson, you've used most of the features of the Plot subprogram. 
At this point, you should know how to load the Plot subprogram, how to 
plot a chart, and how to enhance a chart with fixed and moveable titles, 
and grid lines. You should also be comfortable with changing the scale 
and range of a chart, storing and retrieving a chart image on diskette for 
future use, and printing a screen image on a printer. 

FUNCTIONAL SUMMARY 

Operation 

LOADING 

Load a data file 

Load the Plot sub­
program 

PLOTTING 

Draw a Line chart 

Draw a Bar chart 

From 

Main menu 

Main menu 

Select menu 

Plot menu 

Select menu 
Bar menu 

Plot menu 
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Select or Type 

1. LOAD 
2. file name 
3. RETURN/PRINT 

1. PLOT 

1. LINE 
2. series name 
3. PLOT 

1. BAR 
2. NORMAL/BOTH/ 

LEFT/RIGHT 
3. series name 
4. PLOT 



LESSON ONE 

(Continued) 

Operation 

MENU DISPLAY 

Redisplay or erase 
the Plot menu after 
plotting 

From 

chart display 

TITLES, LEGENDS, AND LABELS 

Put top, bottom, or 
side ti tIes on a chart 

Put a moveable title 
on a chart 

Erase a fixed title 
(masking) 

Plot menu 
Options menu 
Title menu 

Typeface menu 

Plot menu 
Options menu 
Title menu 

Typeface menu 

Plot menu 
Options menu 
Title menu 
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Select or Type 

1. ESC 

1. OPTIONS 
2. TITLE 
3. TOP/FIRST/SEC­

OND /THIRD/SIDE 
4. title (end with @ to 

left-justify; correct 
with ESC) 

5. NORMAL/BOLD/ 
INVERSE 

1. OPTIONS 
2. TITLE 
3. MOVEABLE 
4. desired title 
5. 1 through 9 (to 

change movement 
increment) 

6. I, ~, ~ ,M (position 
the moveable title) 
then RETURN 

7. NORMAL/BOLD/ 
INVERSE 

8. FIX 

1. OPTIONS 
2. TITLE 
3. MOVEABLE 
4 .. spaces. 
5. I, ~, ~,M (position 

the mask) 
then RETURN 

6. FIX 
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(Continued) 

Operation From Select or Type 

TITLES, LEGENDS, AND LABELS (Continued) 
Erase a legend Plot menu 1. OPTIONS 

Options menu 2. TITLE 
Title menu 3. FIRST/SEC-

OND/THIRD 
4. space(s) 

Typeface menu 5. NORMAL/BOLD/ 
INVERSE 

Restore the original Plot menu 1. OPTIONS 
legend Options menu 2. TITLE 

Title menu 3. LEGEND 

V iew the legend Chart with 1. ESC 
status area 

Erase axis labels Plot menu 1. OPTIONS 
Options menu 2. UNLABEL 
Unlabel menu 3. BOTH/HORIZ/VERT 

SCALE AND RANGE 

Change the scale Plot menu 1. OPTIONS 
and redraw the Options menu 2. RESCALE 
chart 3. Y-axis minimum 

4. Y-axis maximum 
5. number of intervals 

Plot menu 6. PLOT 
7. if off-scale: 

PROCEED 

Change the range Plot menu 1. OPTIONS 
and redraw the Options menu 2. RANGE 
chart Range menu 3. SET 

4. start of range 
5. end of range 

Plot menu 6. PLOT 
7. if off-scale: 

PROCEED 

Return to the original Plot menu 1. OPTIONS 
range and redraw Options menu 2. RANGE 
the chart Range menu 3. CLEAR 

Plot menu 4. PLOT 
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(Continued) 

Operation From Select or Type 

FORMATTING AND COLOR 

Erase existing chart, Plot menu 1. NEW 
and all options 

Draw symbols only, Plot menu 1. OPTIONS 
lines only,or points Options menu 2. FORMAT 
only-on Line and Format menu 3. SYMBOLS/LINES/ 
XY charts POINTS 

Plot menu 4. PLOT 

Draw symbols and Plot menu 1. OPTIONS 
lines on Line and XY Options menu 2. FORMAT 
charts Format menu 3. BOTH 

Plot menu 4. PLOT 

Draw different bar Plot menu 1. OPTIONS 
formats on Bar charts Options menu 2. FORMAT 

Format menu 3. OUTLINE/SHADED/ 
SOLID 

Plot menu 4. PLOT 

Draw horizontal, ver- Plot menu 1. OPTIONS 
tical,or both horizon- Options menu 2. GRID 
tal and vertical grid Grid menu 3. HORIZ/VERT/BOTH 
lines 

Erase horizontal, Plot menu 1. OPTIONS 
vertical, or both Options menu 2. GRID 
horizontal and Grid menu 3. HORIZ/VERT/BOTH 
vertical grid lines 

Change background Plot menu 1. OPTIONS 
color on Line, Bar, Options menu 2. BACKGR 
or Area chart Backgr. menu 3. (color) 

Plot menu 4. PLOT 

Restore original Plot menu 1. OPTIONS 
background color on Options menu 2. BACKGR 
Line, Bar, or Area Backgr. menu 3. DEFAULT 
chart Plot menu 4. PLOT 

Change plotting Plot menu 1. OPTIONS 
color Options menu 2. COLOR 

Color menu 3. (color) 
Plot menu 4. PLOT 
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(Continued) 

Operation From Select or Type 

FORMATTING AND COLOR (Continued) 

Restore original plot­
ting color 

PRINTING 

Change the printer 
driver 

Print displayed chart 

SAVING 

Save displayed chart 
on same diskette 

Save displayed chart 
on another diskette 

Plot menu 
Options menu 
Color menu 
Plot menu 

Plot menu 
Print menu 

Linefd. menu 

Print menu 

Plot menu 
Print menu 

Plot menu 
Screen menu 

Plot menu 
Screen menu 
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1. OPTIONS 
2. COLOR 
3. DEFAULT 
4. PLOT 

1. PRINT 
2. DRIVER/DEFAULT 
3. printer 
4. YES/NO (use/don't 

use auto linefeeds) 
5. slot number 
6. EXIT 

1. PRINT 
2. PRINT 

1. SCREEN 
2. SAVE 
3. existing file name/ 

[NEW FILE] then 
new file name 

1. SCREEN 
2. DEVICE 
3. device identifier 
4. SAVE 
5. existing file name/ 

[NEW FILE] then 
new file name 
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LESSON TWO: THE MAIN SUBPROGRAM­
LOADING, SAVING, AND DELETING DATA 

This lesson describes the operations of the Main subprogram, except 
for Edit. The Edit operations are described in Lesson Three. 

Main is the first subprogram you encounter after loading the 
VisiTrend/Plot program diskette. In the Main subprogram, you create, 
load, and save VisiTrend/Plot data. You can also access DIF (data inter­
change format) data from other VisiCorp products, such as the VisiCalc 
program. See Appendix D for information on DIF files. 

In Lesson One, you were introduced briefly to the Main subprogram 
when you used it to load the sample data diskette, and to access the Plot 
subprogram. In this lesson, you will fully explore the Main subprogram. 

ACCESSING THE MAIN MENU 

• If you are continuing directly from Lesson One, your screen displays 
the FLOPPY DENSITY line chart image that you loaded from the file 
SCREENl.PIX. The status area displays the Plot menu. Select EXIT 
from this menu. Now, with the cursor on MAIN, press RETURN to 
access the Main subprogram. 

• If you are not continuing directly from Lesson One, load the program 
diskette according to the directions in the section LOADING THE 
VISITREND/PLOT PROGRAM in Chapter 1. Then load the data 
series as described in the section LOADING DATA INTO MEMORY 
in Lesson One. 

In either case, the Main menu now appears in the status area at the top 
of the screen. This menu is shown in Figure 2-24. 
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018-034/P 

Figure 2-24. Main Menu 

USING THE PROGRAM DISKETTE AND DATA DISKETTES 

Data diskettes store data files, and the program diskette stores the 
VisiTrend/Plot program. The bottom line of the status area for the Main 
menu identifies the data drive. This is the drive used to load or save data 
on diskette, and that should contain your example data diskette 
throughout these lessons. When you're using your own data, that data 
diskette also belongs in this drive. If you have two floppy disk drives, the 
drive identifier is 2, as shown in Figure 2-25. 

018-035/P 

Figure 2-25. Data Diskette Identifier in Main Menu 

2-37 



APPLE II 
LESSON TWO TUTORIAL 

If you have more than two floppy disk drives (or a hard disk drive) con­
nected to your computer, check the slot and drive identifiers to make 
sure that the drive listed contains the data diskette. If you try to load from 
a nonexistent or empty drive, the program prints an error message. 

Data should never be stored on the program diskette. The 
VisiTrend/Plot example diskette contains all of the sample data series 
used in these lessons. In Lesson One, you used two of these series from 
the SAMPLE 1 file, FLOPPY DENSITY and FLOPPY SALES. 

UNDERS TANDING FILES AND SERIES 

Data is stored on a data diskette in units called files. This data can be a 
screen image of a chart, or it can be a collection of data points (called a 
series). A file is identified by a file name. 

When the VisiTrend/Plot program processes data in the computer 
memory, that data is called a series. Each series is a collection of data 
points for a single chart, and is identified by a name, just like a file. Files 
are used to store one or more series. Figure 2-26 shows the relationship 
between files, series, and data points. 

Data Diskette Files Series 

.. MPLE .-1 Floppy Sales 

Floppy Density 

-0 --;e.....---.- ACME REPOR1 

(luantity 

Revenue 

Units Shipped 

Explmses 

Market 

r+ 

Data Points 

1

1977 
1978 
1979 
1980 · · · 

38211 
42543 
46765 
51234 . 

Figure 2-26. Relationship Between Files and Series 

001-005 

A data series can be used only after the file, on which the data series is 
stored, has been loaded into memory from the data diskette. Loading a 
file does not erase it from the diskette. When a file has been loaded into 
memory, the program only processes the data in individual series. 

Often, several series with related data need to be used for similar 
tasks. The advantage in storing multiple series on one file is that you can 
access lots of data by loading a single file instead of many files. 
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The points to remember are: 

• Both files and series have names. 

• Files are units of storage on diskettes. The program uses files for stor­
ing individual units of data. 

• Series are individual units of data in files. The program uses series for 
processing. 

'. ·,·.:O~l;):,a,·:·9t>·rv:tlj~:·a~ic!<fl1sk~ .. k,~Ji~~~··Li$st&~·:~a:~E!."(~~.·!pn.$:c!atai.· 
'd.i$K&tt~: ,"; '",.' " ";:;'" 

USING DATA WITH THE VISITREND/PLOT PROGRAM 

There are two ways to get chart-plotting data into the computer 
memory. You can create it with the Edit operation (described in Lesson 
Three), or you can load it from diskette. 

In Lesson One, and possibly again at the beginning of this lesson, you 
loaded data from the sample diskette. You chose from a displayed list of 
file names, and then the program displayed a list of series names in the 
loaded file. 

To recap briefly: 

• After you loaded the VisiTrend/Plot program, the Main menu 
appeared, and you selected LOAD. The program then printed the list 
(directory) of files on the diskette. The list resembled Figure 2-27. 

Figure 2-27. List of Files for Loading 
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• You chose the file SAMPLE 1, and the file was loaded into memory. 
Next, a list of the series in that file was displayed, as shown in Fig­
ure 2-28. 

018-037/P 

Figure 2-28. List of Series in Loaded File 

• You selected RETURN, which returned the Main menu. 

If you want to put more files into memory, repeat the above procedure. 
Be advised that you cannot put more than 16 data series or 645 data 
points into memory. One file can contain up to 16 series. Four files with 
four series each, or two files with 8 series each are also possible - as 
long as the total number of data points contained in all series is less than 
645. Anyone series cannot contain more than 150 data points. 

When the memory limit is reached, a message is printed indicating 
that no more room is available. When memory is approaching its limit, 
the program does partial loads, if possible. In other words, some of the 
series in a file can be loaded even when there isn't room for all the series 
in that file. 

DISPLAYING THE SERIES IN MEMORY 

From the Main menu, move the cursor to DISPLA V, and press RETURN. 

To review, the list on the screen shows the names of the series, the 
period of the data (the frequency of data points per year), the starting 
date, the ending date, and the number of points in the series. 
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This list has an additional line at the bottom that was not present in the 
Plot subprogram list. It reads: 

SERIES: 2/16 DATA POINTS: 21/645 

This line shows how much memory is occupied. Of the possible 16 
series you may have in memory, there are now two. Of the possible 645 
data points you may have in memory, there are now 21. 

Select RETURN to return to the Main menu. Alternately, you may select 
PRINT to print a copy of the list before returning to the Main menu. 

INITIALIZING A DATA DISKETTE 

Initializing a data diskette as described here, applies to floppy 
diskettes only, For a Corvus Hard Disk, see the appropriate 
Corvus manual. 

Before a diskette can store data, it must be initialized with the FORMAT 
menu item. This item appears in the Files menu. You get to the Files 
menu by selecting FILES in the Main menu. 

Move the cursor to FILES, and press RETURN. You're given three 
choices: FORMAT to initialize a data diskette, DELETE to delete files from 
a data diskette, and MAIN to return to the Main menu. The status area 
displays the identifier of the drive that you will use. 

With the cursor on FORMAT, press RETURN. The status area displays 
directions for your next action: 

INSERT DISKETIE S6,D2 < ESC> CANCELS. 

You can either insert the data diskette in Slot 6/Drive 2, or you can 
press ESC to cancel the Format operation. Note that if your disk con­
troller card is installed in a different slot, that slot number is displayed 
instead of slot 6. 

Get another diskette to practice initializing. Make sure that the 
diskette is blank (or does not contain important information), and that the 
write-protect tab has been removed. The initialization process com­
pletely erases data on a diskette. Remove the VisiT rend/Plot example 
data diskette from the drive, and replace it with the diskette to be 
initialized. Press RETURN. 

The red IN USE light stays on while the diskette is being initialized. 
When the Format operation is complete, you are returned to the Main 
menu. 
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A data diskette initialized with FORMAT is ready for storing data series 
and screen images. Before doing the next exercises, remove the data 
diskette you just initialized, and put the example diskette back in 
the drive. 

SAVING DATA ON DISKETTE 

The SAVE menu item takes data that is in computer memory and writes 
it onto a data diskette. Move the cursor to SAVE and press RETURN. 

A menu with two items, NORMAL and DIF, is displayed. This menu lets 
you choose the format in which the data will be saved. If the data is to be 
used only with the VisiTrend/Plot program, save it in the NORMAL 
format. 

The DIF (data interchange format) choice stores data in a format that 
can be used by other VisiCorp products, such as VisiCalc. See Appen­
dix D, and the end of this lesson, for more detailed information. 

With the cursor on NORMAL, press RETURN. 

The status area displays the directions CURSOR MOVEMENT, 
< SPACE>, OR < RETURN>. You select the series to be saved in a file by 
moving the cursor to a series, and pressing RETURN. The space bar lets 
you indicate more than one series to be saved. An asterisk (*) marks a 
series when you press the space bar, but the marked series is not saved 
until you press RETURN to complete the Save operation. 

You can change your mind up to the time you press RETURN. Pressing 
the space bar a second time causes the asterisk to disappear. The 
specified series is no longer selected for saving. Pressing the space bar 
selects the series again. You can select as many or as few series as 
you want. 

Below the status area is the list of series currently in memory. At the 
bottom of the list are the items [NONE] and [ALL]. Figure 2-29 shows 
this display. 
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018-038/P 

Figure 2-29. List of Series for Saving 

You can cancel the Save operation by moving the cursor to [NONE], 
and pressing RETURN. Alternately, you can select [ALL], which puts all 
the series currently in memory onto the data diskette. 

When you press RETURN, you save all series marked with an asterisk 
and the series which the cursor is highlighting (whether or not the latter 
has an asterisk). If the cursor is on [ALL] or [NONE], all series or no series 
are selected, respectively - regardless of the number of asterisks in the 
list. 

For the purposes of this lesson, move the cursor to [ALL], and press 
RETURN. The directory of the files currently on the diskette is now listed 
under the status area. It is the same list you saw when you loaded 
SAMPLE 1. But there is a slight difference: there is now an entry called 
[NEW FILE] in this list. 

You must now select the name of the file in which the selected series 
will be saved; but you must be careful. If you select an existing file name, 
you store the selected series in that file, but you destroy all the data 
previously stored in the file. For example, if you have a file in memory 
that contains series I, 2, and 3, then save series 2 in that same file, the 
file will contain only series 2. Series 1 and 3 will be erased from the file 
on the diskette. 

It is good practice to save all data in new files. If you decide later that 
you don't need old data, you can erase files with DELETE, described later 
in this lesson. 
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Also remember that all selected series are saved in the same file, 
regardless of the file(s) from which they were originally loaded. 

For now, select [NEW FILE]. 

When you choose to create a new file, the program prompts for a file 
name. Type SAMPLE I, then press RETURN, and see what happens. An 
error message appears CAN'TI FILE EXISTS, and the Save operation is 
cancelled. When saving series in a new file, you must assign a file name 
that is different from all other file names on the data diskette. 

Press ESC to return to the Main menu. 

Remember to check the data disk drive identifier before starting a 
Save operation. The identifier cannot be changed during the Save 
operation. If you have begun a save but need to change the drive identi­
fier, return to the Screen menu by selecting [NONE] from the series list, 
or by pressing ESC when you are prompted for a file name. Then select 
DEVICE to change the identifier. 

You can cancel a save in one of two ways, depending on where you are 
in the operation: 

1. You can cancel the save operation by selecting [NONE] from the 
displayed list of series in memory; or 

2. You can cancel the save operation by selecting [NEW FILE] from the 
displayed list of files on the diskette, then pressing either ESC or 
RETURN when prompted for a file name. RETURN by itself is invalid 
as a file name, and cancels the operation. 

CLEARING SERIES FROM MEMORY 

When you save data on a diskette, the copy of the data in the computer 
memory is not erased. After you have saved new and modified series on 
diskette, you might want to clear them from memory to make room for 
new data you want to load or create. 

The CLEAR menu item removes some or all of the series from memory. 
Move the cursor to CLEAR, and press RETURN. The status area prompts 
you to SELECT SERIES TO CLEAR. Remember, you must select the series 
you want to remove, not the ones you want to keep. 
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The list of series in memory is displayed under the status area. Two 
additional items: [KEEP ALL] and [KEEP NONE] are in this list. [KEEP ALL] 
removes nothing from memory; in effect, it cancels the Clear operation. 
[KEEP NONE] removes everything from memory. 

You are going to clear the series FLOPPY SALES from memory. 
Remember, this doesn't affect the copy of the series that is on diskette in 
the file SAMPLE 1. Move the cursor to FLOPPY SALES, and press 
RETURN. 

The program next gives you two choices: you can print the list of series 
still in memory (shown on the screen), and then return to the Main menu; 
or you can return directly to the Main menu. Select RETURN. 

MOVING BETWEEN SUBPROGRAMS 

When you have finished loading, editing, or creating data, you nor­
mally want to go to either the Plot or the Trend subprogram. The PLOT 
and TREND menu items load the Plot and Trend subprograms, respec­
tively, from the program diskette. 

In Lesson One, you loaded the Plot subprogram from this menu and 
used it to plot charts. In this lesson, you'll follow a similar procedure, but 
with the Trend subprogram. Unlike the Plot subprogram, the Trend sub­
program contains the same edit capabilities as the Main subprogram; 
therefore, you can load the Trend subprogram without first loading data. 

Move the cursor to TREND, and press RETURN. The Trend subprogram 
loads. 

The Trend menu is displayed. This menu includes two items MAIN and 
PLOT that allow you to leave the Trend subprogram, and go to one of the 
other subprograms. Select MAIN; the Main subprogram is loaded, and 
the menu reappears. 

Various items in the VisiTrend/Plot program offer you a "path" back to 
the Main or other subprograms. None of the data in memory is lost in 
transition. 

To see for yourself that the data is kept, move the cursor to DISPLAY 
and press RETURN. The list displays the FLOPPY DENSITY series. Now 
press RETURN, and load the Plot subprogram. Select any chart type from 
the Select menu. Compare the list of series with the list from the Display 
operation. They are identical. 
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Now go back to the Main subprogram: press RETURN, select EXIT, then 
select MAIN. Do a DISPLAY again, and you will find that the list has not 
changed. Press RETURN to display the Main menu. 

The Trend subprogram also contains a DISPLAY menu choice that you 
can try. The data remains no matter which subprogram you load. 

DELETING FILES FROM THE DATA DISKETTE 

You should periodically delete files from your data diskette to make 
space for new files, and to remove out-dated files. 

The DELETE menu item erases files from your data diskettes. This item 
appears in the Files menu, along with the FORMAT item you used earlier. 
To display the Files menu, select FILES from the Main menu. When the 
Files menu appears, select DELETE. 

The files on the diskette are listed below the status area. You select a 
file for deletion in the same manner that you select a file for loading or 
saving: you move the cursor to a file name, and press RETURN. Because 
this operation permanently erases files, the program warns you with a 
beep, and prompts you to confirm the deletion by typing Y. Do not press 
any keys yet. If you press RETURN and then Y, the file highlighted by the 
cursor will be deleted. 

For the purposes of this lesson, select [NONE] at the bottom of the list. 
A second list of your chart image files appears containing the file you 
saved in Lesson One, SCREENl.PIX. Select [NONE] again. The Delete 
operation is cancelled, and the Main menu returns. 

REVIEWING THE EFFECTS OF COMMANDS ON FILES 
AND SERIES 

The CLEAR, DELETE, LOAD and SAVE commands, as you have seen, 
affect files and series in various ways. Table 2-1 illustrates the results of 
executing these commands on files and series both in memory and on the 
data diskette. 

2-46 



APPLE II VISITRENDIPLOT™ ~~T~~s 
TUTORIAL LESSON TWO 

Table 2-1. Effects of Commands on Files and Series 

Results 

Specified 
Series 
Exists File Exists 

Sub- in on 
Command program File Type Series Memory Diskette 

CLEAR Mainl series no yes* 
Trend name(s) 

DELETE Main Normal! yes no 
.DIF/.PIX 

LOAD Main Normal! yes yes 
.DIF 

LOAD Plot .PIX yes yes 

SAVE Main Normal! yes yes** 
DIF 

SAVE Plot .PIX current yes 
(default) display 

only 

* If series was previously saved in a file on diskette. 

* * If the save is to an existing file, all previous series in that file are lost, and only newly 
speCified series are saved in the file. 

GETTING OUT OF THE VISITREND/PLOT PROGRAM 

One remaining item in the Main menu has not been mentioned: QUIT. 
This item exits the VisiTrend/Plot program and puts you into DOS.· 
All data in memory, and all work in progress, is cleared when you 
select QUIT. 

You can leave the VisiTrend/Plot program now, so move the cursor to 
QUIT, and press RETURN. Type Y to confirm, and the] prompt is 
displayed. If you want to load the VisiTrend/Plot program again, follow 
the directions under LOADING THE VISITREND/PLOT PROGRAM in 
Chapter 1. 
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USING VISICALC DATA IN THE VISITREND/PLOT 
PROGRAM 

This section describes how to move data from the VisiCalc program to 
the VisiTrend/Plot program, and vice versa. If you do not use both of 
these products, or have no need to transfer data, skip this section and go 
to the summary at the end of this lesson. 

You can load and plot VisiCalc data using the VisiTrend/Plot 
capabilities. The VisiCalc data must be saved in a DIF file. However, you 
must also have a copy of the VisiCalc program that has a version number 
of 193 or higher. 

Several important reminders about preparing VisiCalc data for use 
with the VisiTrend/Plot program are needed. 

• When you arrange data in a VisiCalc worksheet, do not mix 
periodicities. A monthly worksheet, for example, can't be used for a 
VisiTrend/Plot chart that has a periodicity of one year. 

• You must use the VisiCalc IS#S command to save the worksheet data 
that is to be plotted. The stored data should be a sequence of data 
values that are meaningful to plot as a series. A good example is a 
single row or column from a VisiCalc worksheet. 

• Single or multiple rows and columns from a VisiCalc worksheet can 
be used. Each row or column is treated as an individual data series. 
The first coordinate in the row or column becomes the data series 
name. If the first coordinate is not a VisiCalc label, the VisiTrend/Plot 
program supplies a sequential name for each series: SERIESO, 
SERIES1, SERIES2, ~c. 

• Data from the VisiCalc program, while in a format acceptable to 
the VisiTrend/Plot program, does not contain all the information the 
Main subprogram expects. It does not contain a period or a start 
date. When you load VisiCalc data, you are prompted for the 
missing items. 

The following exercise uses data from a VisiCalc worksheet that is con­
tained on your VisiTrend/Plot example diskette in the file BUDGET.VC. 
You will load this worksheet file with the VisiCalc program, convert one 
row to a DIF file, then load the DIF file as a data series with the 
VisiTrend/Plot program. The steps in this exercise are summarized in 
Figure 2-30. 
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Figure 2-30. Using VisiCalc Data in the VisiTrend/Plot Program 

1. Load the VisiCalc program diskette in drive 1. To load the VisiCalc 
file containing the worksheet from the example diskette in drive 2, 
type ISL. When the program prompts STORAGE: FILE TO LOAD, type 
BUDGET.VC,D2 and press RETURN. The screen with the worksheet 
on it should look like Figure 2-31. 

018-039/P 

Figure 2-31. VisiCalc Worksheet 

2. Move the cursor to the column or row you want for the data series. For 
this exercise, move the cursor to UTILITIES at location A6. The cur­
sor location marks the upper-left corner of the rectangle of data to be 
saved. The lower-right corner is specified later. 

3. Type IS#S to save the data in the DIF format. Type the file name 
UTIL.DIF to save the data, and press RETURN. 

4. Specify M6 as the lower-right corner, and press RETURN. 

5. Type R to save the data in a row. 
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Now remove the VisiCalc program diskette from drive I, and load 
the VisiTrend/Plot program diskette. When the Main menu appears, 
select LOAD. 

You load DIF files in the normal manner, just as VisiTrend/Plot data 
files are loaded. The file you'll now use appears on the list as UTIL,DIF. 
Move the cursor to this file name, and press RETURN. 

The loading of the file begins. In a few moments, the disk drive stops, 
and the program prompts for a periodicity for the data series. Type 12 
because the data in this file is on a monthly basis, and press RETURN. 
Next, you are prompted for a major start date (year). Type 1980, and 
press RETURN. Finally, you are prompted for a minor start date (period). 
Type 1 for January, and press RETURN. The disk drive begins again, and 
the loading of the data is completed. 

The program displays the list of series in memory. The UTIL.DIF file 
contains a single data series named UTILITIES. The series name is taken 
from the label in the VisjCalc row. 

You can now go to the Plot subprogram, and create a chart of the 
UTILITIES data from the VisiCalc worksheet. If you've followed all the 
steps in this exercise, you can create a line chart using the UTILITIES 
data series that would look like Figure 2-32. 

018·040/P 

Figure 2-32. Chart Plotted from VisiCalc Data 

You could also modify the data using the VisiTrend/Plot Edit operation 
(described in Lesson Three). After modifying the data with the Edit 
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operation, you could res ave the series as a OIF file, then return to the 
VisiCalc program and put the data back into the worksheet using the 
steps described in the next exercise. 

Note that when any series is saved in DIF format using the 
VisiTrend/Plot program, then moved into a VisiCalc worksheet, the 
series name does not appear as a label on the worksheet. This is true even 
if the series was originally saved as a DIF file in the VisiCalc program, 
then modified and resaved in the VisiTrend/Plot program, and finally 
returned to a VisiCalc worksheet. 

A VisiCalc worksheet constructed or modified using data that was 
transmitted via a DIF file will not calculate like an original VisiCalc 
worksheet that contained formulas. This is because no formulas are 
copied into a DIF file - only data values. 

USING VISITREND/PLOT DATA IN THE VISICALC 
PROGRAM 

The data series you used in the preceding exercise does not contain 
the formulas, if any, that were used in the VisiCalc worksheet. The series 
contains only values. The label of the VisiCalc worksheet row became the 
series name. These values can now be loaded back into the VisiCalc 
worksheet. 

NOTE: When any series is saved in DIF format using the 
VisiTrend/Plot program, then moved into a VjsiCalc worksheet, the 
series name does not appear as a label on the worksheet. This is true even 
if the series was originally saved as a OIF file in the VisiCalc program, 
then modified and resaved in the VisiTrend/Plot program, and finally 
returned to a Vh:;iCalc worksheet. 

The following steps show you how to take any data series from the 
VisiTrend/Plot program and use it to build values into a VisiCalc 
worksheet. These steps are summari:z:ed ir,J. Figure 2-33, 

VisiTreod/Plot 
Program 

DlfTM File 
00 Dhlkette 

VisiCalc Program 

Create 
DlPM 
File 

Figure 2~33~ Usin.g DCltCl Series in the VisiCcdc PrQgrglJ1 
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1. For this exercise, continue to use the file UTIL.DIF containing the 
single series, UTILITIES. To demonstrate that a series saved as a DIF 
file in the VisiTrend/Plot program does not transfer its name onto a 
VisiCalc worksheet, select SAVE from the VisiTrend/Plot Main menu. 
Select DIF from the Save menu, then select UTILITIES from the list of 
series in memory. When the list of files on diskette is displayed, select 
UTIL.DIF to write over the same series on the existing file. 

Remember that whenever chosen VisTrend/Plot series are saved on a 
data diskette in a DIF -formatted file, the program automatically adds 
the extension .DIF to your specified file name. 

2. Remove the VisiTrend/Plot program diskette, and load the VisiCalc 
program diskette in drive 1. Make sure the example data diskette con­
taining the UTIL.DIF file is in drive 2. 

3. Move the cursor to location B6. When DIF-formatted data is moved to 
a worksheet, the data appears in the row or column where the cursor 
rests. 

4. Load the DIF file into the VisiCalc pr0<1ram from the example data 
diskette using the IS#L command. When the program prompts DATA 
LOAD: FILE TO LOAD, type UTIL.DIF,D2 and press RETURN. 

5. Type R to put the data in a row. 

6. The data series that comprises the UTIL.DIF file appears on the 
screen as a row of values in the VisiCalc worksheet. Notice that the 
series name, UTILITIES, did not reappear as a label. Your screen 
should resemble Figure 2-34. 

018-041!P 

Figure 2-34. Data Series Loaded in VisiCalc Worksheet 
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You could fill out this entire VisiCalc worksheet using additional DIF 
files that contain data series values created in the VisiTrend/Plot 
program. 

If you wish to create your own DIF files for use with the VisiTrend/Plot 
program, see Appendix D. 

SUMMARY 

This completes Lesson Two. Lesson Three discusses the VisiTrend/Plot 
program's Edit operations. You have been introduced to all the other 
Main subprogram menu items except EDIT. 

If you have any trouble performing an operation, look up the menu 
item in Chapter 3: REFERENCE, or return to the lesson where the opera­
tion was described. 

FUNCTIONAL SUMMARY 

Operation From Select or Type 

LOADING DATA 

Load data files Main menu 1. LOAD 
withou t p rin ting 2. file name 
series information 3. RETURN 

Load data files and Main menu l. LOAD 
print series 2. file name 
information 3. PRINT 

LISTING SERIES 

List series in 
memory without Main menu l. DISPLAY 
printing series infor- 2. RETURN 
mation 

List series in Main menu 1. DISPLAY 
memory and 2. PRINT 
print series 
information 
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Operation From 

CHANGING DATA DRIVE 

Change data 
diskette identifier 

INITIALIZING 

Initialize a floppy 
diskette 

Re-initialize a floppy 
data diskette 

Main menu 

Main menu 
Files menu 

Main menu 

SA VING AND DELETING FILES AND SERIES 

Save one series 
in a file 

Save all series 
in a file 

Main menu 
Save menu 

Main menu 
Save menu 
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Select or Type 

1. DEVICE 
2. identifier 

(3. volume no., if 
Corvus Hard Disk 
iden tifier specified 
in step 2.) 

1. FILES 
2. FORMAT 
3. put diskette in 

prompted drive 
4. RETURN 

1. FILES 
2. FORMAT 
3. put diskette in 

prompted drive 
4. RETURN 
5. Y (to continue) 

1. SAVE 
2. NORMAL/DIF 
3. series name 
4. existing file 

name/[NEW 
FILE] then new file 
name 

1. SAVE 
2. NORMAL/DIF 
3. [ALL] 
4. existing file 

name/[NEW 
FILE] then new file 
name 
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(Continued) 

Operation From Select or Type 

SAVING AND DELETING FILES AND SERIES (Continued) 

Save several series Main menu 1. SAVE 
in a file Save menu 2. NORMAL/DIF 

Delete data file 
perm.a.:Jilelltly from 
diskette 

CLEARING MEMORY 

GlI!ea;r:all series from 
memory 

Clear one series 
from memory 

Clear several series 
from memory 

Main menu 
Files menu 

Main menu 

Main menu 

Main menu 

TRANSFERRING BETWEEN SUBPROGRAMS 

Enter Main sub­
program 

Enter Main sub­
program 

Enter Main sub­
.program 

Enter Trend sub­
pJ."Dgram 

p:ower'Jilp 

-Txend ~mell1U 

Plolmenu 

Main menu 
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3. each series name 
except last: space 
bar and -

4. last series name: 
RETURN 

5. existing file 
name/[NEW 
FILE] then new file 
name 

1. FILES 
2. DELETE 
3. filename 
4. Y (to confirm) 

1. CLEAR 
2. [KEEP NONE] 

1. CLEAR 
2. series' name 

L CLEAR 
2. each series name 

except last: space 
bar and -

3. last series: RETURN 

1. insert program 
diskette incirive 1 

2. turn ON power 
switch 

I .. MAIN 

1. EXIT 
-2. MAIN 

I .. TREND 
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(Continued) 

Operation From Select or Type 

TRANSFERRING BETWEEN SUBPROGRAMS (Continued) 

Enter Trend sub- Plot menu 1. EXIT 
program 2. TREND 

Enter Plot sub- Main menu 1. PLOT 
program 

Enter Plot sub- Trend menu 1. PLOT 
program 

Enter DOS Main menu 1. QUIT 
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LESSON THREE: THE EDIT OPERATION 

With the VisiTrend/Plot Edit operation, you can perform two important 
tasks: 

• Create new data series. 

• Modify existing data series. 

Identical Edit operations are available in the Main subprogram and in 
the Trend subprogram. For this lesson, you will use EDIT from the Main 
subprogram. 

Load the VisiTrend/Plot program according to the instructions under 
LOADING THE VISITREND/PLOT PROGRAM in Chapter 1. When the 
Main menu is displayed, select EDIT. You do not need to load a file into 
memory; this lesson teaches you how to create a new data series. 

USING EDIT 

After selecting the EDIT menu item, the status area prompts CURSOR 
MOVEMENT OR < RETURN>. You are being directed to select from the 
list displayed below the status area. You did not load a file, so the list 
contains only [NONE] and [NEW SERIES]. 

Selecting [NONE] from this list cancels the Edit operation, and returns 
you to the Main menu. 

To enter data for a new series, move the cursor to [NEW SERIES], and 
press RETURN. The status area next prompts for the series name. 

Type FIRST, and press RETURN. Remember, you can correct typing 
errors with the ESC key, whenever you are entering information during 
the Edit operation. This includes a series name, starting year, or any data 
value. Pressing ESC erases characters to the left of the cursor. You can 
then retype the character(s). 

The status area prompts for the period of the new series PERIODICITYI, 
and displays a current period CURRENT 1. Because you just loaded the 
program, and have not done any editing or working with series in this 
lesson, the program defaults to a period of 1. After you have worked with 
a series, the period of the most recently edited series is displayed. 
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For this exercise, type 1 for the period of the new series, and 
press RETURN. 

Next, you are prompted for the starting year. Type 1966, and 
press RETURN. 

The bottom line of the status area displays the name of the series and 
the starting year. Now, you are prompted for the first value in the new 
series FIRST VALUE/. Type 23, and then press -. 

Under the status area, the program creates two columns to contain the 
data values for the new series. The first column begins with 1966, and the 
corresponding value, 23, appears next to it in the second column. 
Because the program does not allow :gaps in a data sequence, the next 
consecutive date for each new entry is automatically displayed. In this 
case, the period is 1, so 1967 appears next in the first column. An inverse 
video bar separates the two columns, and the cursor highlights where 
your next value will be placed in the second column. 

If a series has a period other than 1, the period is incremented within 
the year; then the year is incremented when the period goes full cycle. 
Your screen should resemble the one in Figure 2-35. 

018-042/P 

Figure 2-35. Display for Editing or Creating a Series 
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The status area displays a line of information PRESS < ESC> FOR 
COMMANDS. You can add more values to the series; or you can press 
ESC to display the Edit menu, and modify the current value(s). 

For the moment, you'll add some more values to the series. When the 
complete series has been entered, you will use the Edit commands to 
modify the data. 

Adding Values to the Series 
To add a value for the year 1967, type 28. Again the value appears in 

the status area. Press --+, and the value moves down to the second column 
opposite 1967. 

Add the remaining values to the series by repeating the preceding 
process: type the value, and press --+. Enter the values 33, 37, 41, 44, 4:4:, 
53, 61, 75, 64:, 73, 82, and 79. 

After you enter the last value, the cursor is below the list in the second 
column,opposite the date 1980. Your series won't. have a value for 
1980, so press RETURN. The cursor moves up to the 1979 value,and 1980 
disappears. 

Replacing a Value 
You can replace a value by moving the cursor to the old value and 

entering the new value. The new value is written over the old value when 
you press RETURN or --+. 

Move the cursor to the value for the year 1969. Instead of 37, this value 
should have heen 39.9. Type 39.9, and press --+. The new value replaces 
the old value, and the cursor moves down to the next value in the 
column. 
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U sing the Edit Menu 
You have so far used the Edit operation to enter values for the series, 

and to replace a value by entering a new value that writes over an old 
value. You can further modify the data in a series with the Edit com­
mands. Press ESC to display the menu of Edit commands in the status 
area. Your screen should resemble the one in Figure 2-36. 

018-043/P 

Figure 2-36. Edit Command Menu 

The Edit menu provides the following commands: 

JUMP moves the cursor to a specific entry (value) within the series. 

INSERT inserts new data points between existing data points. 

DELETE deletes any number of existing data points. 

SPECS changes the specifications of a series. 

FORMAT changes the manner in which data is displayed. 

PRINT 

UNDO 

EDIT 

FILL 

EXIT 

prints the contents of a series. 

cancels the current editing changes to a series. 

returns to the Edit entry level. 

fills areas of a series with values generated by predefined 
formulas. 

retains the current series and any editing to that series in 
memory, and returns to the Main menu. 
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These Edit commands will be discussed more fully in the next several 
sections, and several of them will be practiced later in the lesson. For 
now, select EXIT. When you leave the Edit operation by this route, the 
work you created or modified is saved, and the Main menu reappears. 

Select EDIT again from the Main menu. This time you don't have to 
enter a name, period, or starting date. The name of the series FIRST is 
listed along with [NONE] and [NEW SERIES]. With the cursor on FIRST, 
press RETURN. The years and corresponding data-point values reappear 
in two columns. 

At this Edit entry level, you can position the cursor anywhere in the 
series list with the - and - keys. The status area tells you how to display 
the Edit menu: PRESS < ESC> FOR COMMANDS. 

For now, press ESC to display the Edit menu, and move the cursor to 
each menu item as it is discussed. Examine the long prompt for the item 
in the top line of the status area, but do not press RETURN to select 
any item. 

JUMP - MOVING FROM POINT TO POINT 

The JUMP command lets you move from entry to entry within the series 
without repeatedly pressing the arrow keys. With JUMP, you can move 
the cursor quickly to the top entry in the series using the - key, and to 
the bottom entry in the series using the - key. You can also move the 
cursor directly to any entry by typing the year, and pressing RETURN. 
For series having a period other than I, the JUMP command also prompts 
you for the period when you enter the year. 

Long series can contain more entries than will fit on one screen 
display. When a year/period that you specify with JUMP is displayed on 
the current screen, the cursor simply jumps to it. If the specified date is 
on a screen other than one currently displayed, the current screen is 
erased, and the specified date appears at the bottom or top of a new 
screen. The location of the date (top or bottom) depends on the direction 
that the program moved within the screens of that series. 

If a specified date does not exist in the series, a beep sounds, and 
the program returns to the Edit entry level. At this point, you could redis­
play the Edit menu by pressing ESC, select JUMP again, and enter a 
valid date. 

After a jump is completed, you are returned to the Edit entry level. 
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INSERT- ADDING AN ENTRY 

The INSERT command lets you insert anew value fbr the date at the cur­
rent Cursor location. The value on which the cursor rests, and all values 
below the cursor are pashed ahead to the next date to make rOOin for the 
value to he inserted. Up ito 149 values eanbe insetted ina series. 

Insertion with this cnmmand works like initially entering a value in the 
series: you can type ;tlu!e value, and press ~.The cursor automatically 
moves to the following value in the column,and pushes it down to create 
room for your next in'Sertion .. You press RETURN to signal the last inser­
tion. The remaining-values move up again toHn the last gap created,and. 
you areretumed to the Edit entry level. You can then redisplay the Edit 
menu by pressing ESC. 

The INSERT command operates anywhere tnthe series,except a;J:!t1he 
'end (the las1value in the series). 

DELETE - ERASING A :DATA POINT 

The DELETE command erases onecr :morevalues,beginningDth <the 
current cursor location. The range to be deleted is listed in tkestatus 
area. You can cancel the DELETE command by pressing ESC. 

When you select the DELETEcommand,the onedatapoin:l,vthere <the 
cursor rests is displayed in theistatus area as the rangefoxdeletion.Mov­
ing the cursor in 'either direcfion broadens the range of values to be 
Jremoved. If you try to .move fhe cursor beyond the end of the series, the 
DELETE command is cancelled .. The deletion is also cancelled jf you. try to 
remove all the values from the series. 

You can delete values ineitherdiredtionfromtheoriginalcursorposi­
tion . However, the original cursor ,position willal ways· be the beginning 
or end of the range to.be erased. 

Pressing RETURN after youha vedefinedthecQrl'ect .range removes 
the selected values from the series. The 'values below 'the :removedarea 
move up to fill the new empty dates. You are returned 10 ~£heEditentry 
level, where you can press ESC to redisplay ,the Edit . menu. 

SPECS-CHAN.GINGTHESERIESSPECIFICATIONS 

The SPECS command lets you change thename,.petmd, or starting 
dateo£ the series. This command cannot be used to CBaEge data points. 
When you select .SPECS,.a ,secondmenu.appearsfrom.whichyouchoose 
which. specification istobe.changed: NAME PER,orSIART. The EXIT 
item letsYiOurehun to the Edit entry level. 
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You choose the specification from this menu, and respond to a prompt 
by typing the new value. When you press RETURN, the series specifica­
tion changes immediately on the screen. 

You can press the RETURN key without entering a new specification 
value for NAME and START. In such a case, the program assumes a value. 
For NAME, the program generates the name SERIESn, where n is a 
number from 1 through 16. For START, the program assumes the date 0, 
provided that the current period is 1. If the period is other than I, 
RETURN alone doesn't work for START: the program instead prompts you 
to change the period. 

FORMAT - CHANGING THE DATA DISPLAY 

The FORMAT command lets you specify how to display data values in 
the series. Selecting FORMAT displays the current format at the top of the 
status area. Your format options appear on the second line: 0-6: PLACES, 
-1: FLOAT, <RET> NO CHANGE. The meaning of these options is: 

0-6: PLACES 

-1: FLOAT 

<RET> 
NO CHANGE 

You can choose a fixed-decimal format display 
by specifying a number from 0 to 6, and pressing 
RETURN. This number is the precision (number 
of digits to the right of the decimal point). You 
are then prompted to specify a number from 6 to 
15 for the column width (total number of digits 
displayed). Pressing only RETURN retains the 
current column width. 

You can choose a floating-deCimal format 
display by specifying -I, and pressing 
RETURN. When floating-decimal format is 
chosen, the VisiTrend/Plot program controls the 
precision. You are then prompted to specify a 
number from 6 to 15 for the column width. Press­
ing only RETURN retains the current column 
width. 

You can retain the current format andlor preci­
sion by pressing only RETURN. You are then 
prompted to specify a number from 6 to 15 for 
the column width. Pressing only RETURN retains 
the current column width. 
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If you make format changes and your resulting values are displayed as 
a number of greater than symbols (> > > », one of the following situa­
tions is in effect: 

• The value is too large for the column width. If this is the case, 
increase the column width. 

• The value is an exponential number (such as IE + 09), and you are in 
a fixed-decimal format. Exponential numbers can only be displayed 
in floating-decimal format. You cannot enter values in exponential 
format; however, the program automatically converts values to 
exponential format if they are less than or equal to 0.001, or greater 
than 9 digits to the left of the decimal point. 

If you do not choose a display format, the program default is floating­
decimal format. 

The FORMAT command does not affect how values are stored, only 
how they are displayed during editing. Format changes remain in effect 
until you choose a new format, or exit the program. 

PRINT - LISTING A SERIES 

The PRINT command lets you print the displayed series on your printer. 
If you have other than an Apple Silentype Printer, find the information 
on your printer in Appendix B. You must change to the appropriate 
printer driver before using the PRINT command. 

When PRI NT is selected, the displayed series is printed with the name 
of the series at the top. The inverse video bar and any blank lines at the 
bottom of the screen are not printed. You can stop a Print operation by 
pressing CTRL-C. (Press and hold the CTRL key while pressing C). 

After the current series is printed, you are returned to the Edit entry 
level. You can then press ESC to redisplay the Edit menu. 

UNDO - CANCELLING CURRENT EDITING CHANGES 

The UNDO command cancels all the changes made to the current 
series since you began the Edit operation. If you select UNDO on a 
newly-created series, the series is completely erased. 

Keep in mind that the UNDO command cancels all editing changes 
made since selecting the series, not just the most recent change. 

EDIT - RETURNING TO THE ENTRY LEVEL 

The EDIT command takes you back to the Edit entry level, without 
executing any of the Edit menu commands. At this level, you can position 
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the cursor with the arrow keys, change data points by entering new ones, 
enter additional data points at the end of the series, or press ESC to 
redisplay the .Edit menu. 

FILL - ADDING TO A SERIES 

The FILL command lets you insert values into the middle of a series, or 
direct the program to interpolate missing values between two known 
values. Values can be inserted in either an arithmetic or geometric 
progression, beginning with the value at the current cursor location. 
You can also select another entire series, and insert it into the series 
being edited. 

The FILL command displays its own menu containing the following 
items: 

• The ARITH menu item first prompts for the number of values to be 
inserted. You type the number, and press RETURN. The number can 
be any value that will not cause the total series to exceed the max­
imum of 150 points, or 645 points in memory. Next, you are prompted 
for the factor to be used in the calculation of the new values. Again 
you type the number, and press RETURN. Each succeeding data 
point is computed by adding the factor to the previous data point, up 
to the the specified number of values to be inserted. 

• The GEOMET menu item works much like ARITH. First, you are 
prompted for the number of values to be inserted. You type the 
number, and press RETURN. The number can be any value that will 
not cause the total series to exceed the maximum of 150 points, or 645 
pOints in memory. Next, you are prompted for the factor to be used in 
the calculation of the new values. Again you type the number, and 
press RETURN. Each succeeding data point is computed by multiply­
ing the previous data point by the factor, up to the the specified 
number of values to be inserted. 

• The SERIES menu item displays the current list of series in memory. 
You can select one. The entire chosen series is inserted into the 
current series, at the cursor location. If you insert a series into itself, 
the inserted values are those that existed before entering the Edit 
operation. 

• The INTERP menu item performs a linear interpolation to fill in missing 
data values (zeros). The interpolation begins at the first zero value 
and continues to the first nonzero value. You position the cursor on 
the first zero value in the sequence before invoking the operation. 

If the value at the cursor is not zero, or if there is no nonzero value 
later in the series, a beep cancels the operation. The INTERP opera­
tion gets the starting point from the preceeding period, and the 
ending point from the next nonzero value. All points in between are 
then linearly interpolated. 
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• The EXIT menu item returnS! to the Edit entry lev~l without performing 
any Fill operation. 

PRACTICING WITH EDIT COMMANDS 

The following e:x;ercise:; give you some practice with the mare fre­
quemtly used Edit cOIIlInands. To do these exercises you must load the file 
SAMPLE 2 from the ViS!iTrend/Plot program diskette. If you need to 
review the steps, refer to the section LOADING DATA INTO MEMORY 
in Lesson One. 

Exit to the Main menu, clear the FIRST series from memory, and load 
the file named SAMPLE 2. This file contains one series also natned 
SAMPLE 2. When the series list appears, select RETURN to go back to the 
Main menu. 

Select EDIT from the Main menu, then select the series; SAMPLE 2. This 
series has 133 data points and a period of 12 (monthly). Its! s;tart date is 
1977 1, the firet period of 1977 (January 1977). 

The screen fills with numbers when you select the series. For each date 
there are 12 periods, and for each period there is a value. The dates 
appear in the first column. The periods appear in the eeconel column, 
and each value appears to the right of the QorreepQn.ding period, 

Moving the Cursor and Scrolling the Screen 
Although the SAMPLE 2 series contains 133 data points, the sGreen cap 

display only 20 of them at a time. To eee the v~Jg.es beyonel the first 20, 
move the CurSO:r to the bottom of the screen with the --+ key. Continue 
pressing the ~ key. Additional dates and values appear at the bottom of 
the screen, and previously displayed values disappear off the top. This is 
called scrolling. You can use the arrow keys to scroll i:rl either direction; 
scrolli:rl9 is one way to move to any PQintin the series. 

Moving With the JUMP Com.mand 
If you wanted to add mOre values to the end of this l3eries, you, COll.ld 

press the ~ key up to 133 times to reach the ~nd of the series. The JUMP 
command Can save yOu both time (ind effort. Press ESC to display the 
Edit menu. With the cursor on JUMP, press RETURN. 

The status area displays your three choices: you can p:ress ~ to jump 
directly to the top of the series, you can press ~ to jump directly to the 
bottom, or you can type (lny date in the serieS! and jump directly to it.. 
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Type 1981, and press RETURN. The status area next prompts for the 
period, because this series has a period other than 1. Type 1, and press 
RETURN. The data on the screen is replaced by a new screenfull of data. 
The cursor highlights the first period of 1981 at the bottom of the screen. 
If you had specified the same date and period from a later point in the 
series, the target date would have appeared at the top of the screen. The 
location of the target date on the screen depends on the direction the 
cursor must move. 

To practice using the arrow keys with the JUMP command, press ESC, 
and select JUMP again from the Edit menu. Press -. The screen display 
changes so that the cursor highlights the end of the series. 

Formatting the Data 

The values in this series are displayed to different degrees of preci­
sion. The floating-decimal format makes the values rather difficult to 
read. The FORMAT command lets you display the values in a more con­
sistent and readable form. 

Press ESC to display the Edit menu, and select FORMAT. The top line 
of the status area displays the current format: in this case, FLOATING. 
For a fixed-decimal series, the number of places of precision is displayed 
on this line. 

The second line displays the format options you can enter, as 
described in the previous section FORMAT - CHANGING THE DATA 
DISPLA Y. Pressing RETURN twice retains the existing format and 
column width, and cancels the FORMAT command. 

Type 2 to specify a fixed-decimal format with two places of precision 
after the decimal. Press RETURN. The status area now displays the cur­
rent column width, and prompts for a number for the column width. 

The column width is the total number of digits to be displayed. This 
total includes the decimal point, the sign, and the exponent (if any). 
Positive values have an implied plus sign ( + ), and one position is always 
reserved for the sign. The width you specify can be any number from 6 
through 15. Pressing RETURN, without entering a value, retains the cur­
rent column width. For now, press RETURN. 

The series on the screen displays the decimal points lined up with two 
digits to the right of the decimal point. Numbers to the right of the 
decimal are rounded to the specified number of places, not truncated. 
Press ESC to display the Edit menu. 
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Inserting Data into the Current Series 
Select the JUMP command, and display the beginning of the series. 

Move the cursor to the first period of 1978. The data insertion occurs at 
the cursor location, and data later in the series is moved downward. The 
insertion point must be determined before you select INSERT. Press ESC, 
and select the INSERT command from the Edit menu. 

Notice period 1 of 1978: the value that was in this location, and all 
subsequent values in the series, have moved down one place. The cursor 
now highlights an open space for your insertion. The dates in the series 
did not change; however, one new period has been added to the end of 
the series. 

You can now insert a new value at this point in the series. Type 99, and 
press RETURN. The value 99 is inserted into 'the location for period 1 
of 1978. 

Next, you'll practice inserting multiple values by pressing ~ after typ­
ing each value. Press ESC, select INSERT again, and enter two more 
values of 99. Press ~ after typing each value. In each case, the value is 
inserted in the current open space, and a new space is automatically 
opened in the following position. To terminate the insertion, press 
RETURN. Data values later in the series move up again to fill the last 
open space. 

Deleting Data From a Series 
To remove the three values of 99 from the series, you'll use the DELETE 

command. 

From the Edit entry level, move the cursor to the first 99. This is the 
starting point for the deletion, and must be determined before you select 
the DELETE command. Press ESC to display the Edit menu, and select 

- DELETE. 

The status area displays the cursor position as the current range of the 
deletion: DELETE FROM 1978 1 TO 1978 1. If you press RETURN now, 
only this single value will be deleted. You can also press ESC to cancel 
the deletion. 

Instead, press ~ twice, and watch the status area as you press the key. 
The period of the TO date increments from 1 to 3 as the cursor moves 
from value to value. With the cursor on 1978 3, press RETURN. The 
screen display is rewritten without the three values of 99. The cursor has 
returned to the top of the series, and the program is at the Edit entry 
level. 
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Press ESC to display the Edit menu, and select EXIT to return to the 
Main menu. 

FUNCTIONAL SUMMARY 

Operation 

ENTERING EDIT 

Enter Edit 
Operation 

CREATING SERIES 

Create and save a 
new data series 
in memory 

Save series in 
diskette file 

From 

Main menu 

Main menu 

Edit entry level 
Edit menu 
Main menu 

Select or Type 

1. EDIT 

1. EDIT 
2. [NEW SERIES] 
3. series name 
4. period (1 through 99) 
5. starting year 
6. first value ---+ 

7. additional values ---+ 

8. RETURN 
9. ESC 

10. EXIT 
11. SAVE 
12. NORMAL/DIF 
13. series name/ 

[ALL] 
14. existing file name/ 

[NEW FILE] then 
new file name 

ADDING, CHANGING, AND DELETING SERIES VALUES 

Add value(s) to short 
series 

Add value(s) to long 
series 

Main menu 

Main menu 

Edit menu 
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1. EDIT 
2. series name 
3. ---+ beyond last value 
4. value(s) ---+ 

5. RETURN 

1. EDIT 
2. series name 
3. ESC 
4. JUMP 
5. ---+ 

6. ---+ 

7. value(s) ---+ 

8. RETURN 
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(Continued) 

Operation From Select or Type 

ADDING, CHANGING, AND DELETING SERIES VALUES (Continued) 

Insert new value(s) 

Insert value(s) by 
addition or 
multiplication 

Insert values from 
another series 

Change an existing 
value 

Do linear inter­
polation 

Delete one existing 
value 

Delete several 
existing values 

Series 

Edit menu 

Series 

Edit menu 

Series 

Edit menu 

Series 

Series 

Edit menu 

Series 

Edit menu 

Series 

Edit menu 
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1. - or +- to value to 
be preceded 

2. ESC 
3. INSERT 
4. new value 
5. RETURN or -

1. +- or - to value 
to be followed 

2. ESC 
3. FILL 
4. ARITH/GEOMET 
5. number of values 
6. factor 

1. +- or - to value 
to be followed 

2. ESC 
3. FILL 
4. SERIES 
5. series name 

1. - or +- to old 
value 

2. new value 
3. RETURN or -

1. +- or - to first 0 
value 

2. ESC 
3. FILL 
4.INTERP 

1. - or +- to value 
2. ESC 
3. DELETE 
4. RETURN 

1. - or +- to first 
deletion value 

2. ESC 
3. DELETE 
4. - or +- to last 

deletion value 
5. RETURN 
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(Continued) 

Operation From Select or Type 

JUMPING THE CURSOR 

Go to beginning or Series 1. ESC 
end of a series Edit menu 2. JUMP 

Series 3. - to end; +-- to 
beginning 

Go to a specific Series 1. ESC 
point in a series Edit menu 2. JUMP 

3. year (and period if 
periodicity is not 1) 

FORMATTING 

Change from floating Series 1. ESC 
to fixed point Edit menu 2. FORMAT 

3. number of places 
(0-6) 

4. column width 
(6-15)/RETURN 

Change from fixed Series 1. ESC 
to floating point Edit menu 2. FORMAT 

3. -1 
4. column width 

(6-15)/ RETURN 

Change column Series 1. ESC 
width Edit menu 2. FORMAT 

3. RETURN 
4. column width (6-15) 
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Operation From 

CHANGING SPECIFICATIONS 

Change series name 

Change series period 

Change start of 
range 

Series 
Edit menu 

Series 

Series 
Edit menu 

CANCELLING CURRENT EDIT 

Erase all editing 
changes during cur­
rent Edit operation 

PRINTING 

Print series 

Series 
Edit menu 

Series 
Edit menu 
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Select or Type 

1. ESC 
2. SPECS 
3. NAME new 

name/RETURN 

1. ESC 
2. SPECS 
3. PER 
4. new period 

1. ESC 
2. SPECS 
3. START 
4. new year/RETURN 
5. period (if period 

other than 1) 

1. ESC 
2. UNDO 

1. ESC 
2. PRINT 
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LESSON FOUR: THE TREND 
SUBPROGRAM -
ANALYZING & FORECASTING 

LESSON FOUR 

You need to have some familiarity with statistics to completely under­
stand this lesson and the meanings of formulas and calculations. 
However, to perform the program operations as directed, you need no 
special background. 

The Trend subprogram analyzes data series, and develops trend 
forecasts. It uses the following statistical techniques: 

• Moving averages, smoothed data, percent of change, adjacent dif­
ference, leading, lagging, and cumulative totals. 

• Mathematical and logical transformations of data into new series. 

• Linear multiple regressions with up to five independent variables 
(using ordinary least squares), including standard errors of coeffi­
cients and regressions, T-statistic, R-bar squared statistic, F-statistic, 
and the Durbin-Watson statistic. 

• Statistical minimums, maximums, means, variances, standard devia­
tions, and correlation coefficients. 

ACCESSING THE TREND SUBPROGRAM 

• If you are not continuing directly from Lesson Three, make sure your 
computer is OFF; then load the program diskette according to the 
directions in the section LOADING THE VISITREND/PLOT PRO­
GRAM in Chapter 1. Your screen displays the Main menu. 

• If you are continuing directly from Lesson Three, your screen 
displays the Main menu. Lesson Four uses 13 series in a large file. If 
you have any new or modified series in memory, store them on 
diskette with SAVE. Then remove all series from memory with CLEAR. 
The Main menu is again displayed on the screen. 

From the Main menu, select LOAD. When the list of files appears, 
select the file SECURITIES MKT to be loaded into memory. After examin­
ing the list of series in the file, select RETURN to display the Main menu. 

Select TREND to load the Trend subprogram. The Main menu is 
replaced by the Trend menu, as shown in Figure 2-37. 
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018-044/P 

Figure 2-37. Trend Menu 

Five of the eight menu items should look familiar. You used EDIT, 
MAIN, DISPLA V, CLEAR, and PLOT in the first three lessons. These menu 
items perform identically when selected from any menu in which 
they appear. 

EDIT 

MAIN 

DISPLAY 

CLEAR 

PLOT 

allows you to enter new series data and to modify existing 
data. This operation is identical to the Edit operation in the 
Main subprogram. 

reloads the Main subprogram and passes control to it. This 
operation is identical to its counterpart in the Plot sub­
program. 

shows a list of all series currently in memory. This operation 
is identical to the Display operation in the Main sub­
program. 

removes series from memory. This operation is identical to 
the Clear operation in the Main subprogram. 

loads the Plot subprogram and passes control to it. This 
operation is identical to the Plot operation in the Main sub­
program: data must first be loaded in memory before the 
Plot subprogram can be used. 

If you are unsure of the use of any of these operations, review the 
discussion and examples in Lessons One, Two, or Three. The remaining 
three operations are the heart of the Trend subprogram: 
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ANALYZE performs linear multiple regression and trendline 
forecasting; calculates the common statistical measures of 
series such as variance, standard deviation, and coefficient 
of correlation; generates tabular output; and formats 
the data. 

FUNCTION generates new series from existing series. It calculates the 
moving average, percent of change, adjacent difference, 
and cumulative total; does exponential smoothing; and 
generates leading and lagging series. 

XFORM allows you to develop your own transformation of a data 
series. You can manipulate series through mathematical 
and logical operations, and functions. 

The multiple regression operation in ANALYZE creates two new series. 
Each operation in FUNCTION creates one new series. Before you use 
these operations, you should select DISPLAY to list the number of series 
(and data points) available for new series. If there is insufficient space to 
complete the Trend operation, you must use CLEAR to remove some 
series from memory. 

USING THE ANALYZE OPERATION 

ANALYZE displays an Analyze menu containing five items. Move the 
cursor to ANALYZE, and press RETURN. Your screen should resemble the 
one in Figure 2-38. 

018-045/P 

Figure 2-38. Analyze Menu 
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This menu contains two familiar items: 

EXIT 

FORMAT 

returns immediately to the Trend menu. 

specifies how the data is displayed. This menu item works 
exactly like FORMAT in the Edit menu. If you need to 
review the Format options, refer to the section FORMAT­
CHANGING THE DATA DISPLAY in Lesson Three. 

The remaining menu items, TABLE, STATS, and REGRESS, are discussed 
in the following sections. 

Listing Series in Table Format 
TABLE lets you display series information on the screen, or print series 

information on a printer. 

Because the screen size limits the space available for displaying series 
data, TABLE displays those series that fit on the screen, beginning with 
the first series selected. The number of series that can be displayed 
depends on the column size and precision currently in effect. The pro­
gram defaults are the floating-decimal display, and a column width of 10. 
You can change these defaults with the FORMAT menu item. 

With the cursor on TABLE, press RETURN. A new menu appears offer­
ing the choice of SCREEN or PRINTER. 

If you select PRINTER from this menu, the entire table to be generated 
will be printed to a supported printer. Refer to Appendix B for detailed 
information on graphics printers. 

For now, press RETURN with the cursor on SCREEN. The list of series 
in memory appears next below the status area. 

With the cursor on XV EARNINGS, press the space bar. An asterisk 
marks this series for selection along with any other series you mark with 
an asterisk. You can erase an asterisk by putting the cursor on an 
asterisked name, and pressing the space bar again. When you press 
RETURN, all series marked with an asterisk, and the series currently 
highlighted by the cursor are selected. 

Next, mark XV DIVIDENDS for selection by moving the cursor, and 
pressing the space bar. Finally, move the cursor to XV BOOK VALUE, and 
press RETURN. You have selected the first three series for the table. 

The status area displays a range that represents the union of the 
ranges for the selected series. The union of ranges means the earliest 
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start date and the latest end date that occur in any of the selected series. 
You must now specify whether you want to KEEP that range, or CHANGE 
it. If you decide to CHANGE the range, you are prompted for a begin­
ning date, ending date, and period (if applicable). With the cursor on 
KEEP, press RETURN. 

The screen displays series values lined up by date, for easy com­
parison and evaluation. The dates are displayed in the first column at the 
left of the screen. The remaining columns display the series in the same 
order that they were selected. When series names are too long to fit on 
one line in the column width, they are divided onto two lines. Names that 
exceed two lines are truncated. 

The series table contains information for the XV EARNINGS series, the 
XV DIVIDENDS series, and XV BOOK VALUE series. Your screen should 
resemble Figure 2-39. 

018-046/P 

Figure 2-39. Table of Series 

Because the full table cannot be displayed on one screen, the status 
area displays two choices CONTINUE or EXIT. The EXIT menu item returns 
you to the Trend menu without displaying the remaining points in the 
series. Select CONTINUE. 

2-77 



VISITRENDIPLOT™ ~tT~~S APPLE II 
LESSON FOUR TUTORIAL 

A maximum of 16 periods are displayed on each screen. Each time you 
select CONTINUE, the successive screen displays 16 more periods, up to 
the end of the table. When the entire table has been displayed, the status 
area prompts PRESS ANY KEY. Remember that you must not press the 
RESET key. Press the ESC key, for example, and you are returned to the 
Trend menu. 

The table just created is not saved in memory or on diskette; you can 
save it only in hardcopy form by printing it. You can recreate the table 
simply by following the preceding procedure. 

To continue with the discussion of ANALYZE, select it again from the 
Trend menu. Move the cursor to STATS in the Analyze menu, and 
examine the long prompt in the status area. 

Calculating Series Statistics 
The ST A TS menu item displays a table of common descriptive statistical 

measurements. The table includes: 

1. The count of the number of items used in calculations. 

2. The minimum and maximum value in each series. 

3. The arithmetic mean (average). 

4. The variance. 

S. The standard deviation. 

6. The calculated coefficients of correlation between all pairs of 
selected series, when multiple series are selected. 

The number of series displayed, as in the Table operation, is deter­
mined by the current column width and precision. These can be changed 
by using FORMAT. 

With the cursor on STATS, press RETURN. The list of series is displayed 
as it was for TABLE. Select XY EARNINGS, XY DIVIDENDS, and XY BOOK 
VALUE using the space bar and RETURN. 

The status area displays a range that represents the intersection of the 
ranges in the selected series. You again have the choice of keeping this 
range, or changing it. With the cursor on KEEP, press RETURN. 

When the computations are complete, the calculated values are 
displayed in columns with each series name at the top. The left-hand 
column lists the meaning of each value. The bottom of the table lists the 
range that the data covers. Figure 2-40 shows how the specified statistics 
are displayed. 
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018-047/P 

Figure 2-40. Display of Statistics 

You have the option to CONTINUE or to PRINT the statistics. The only 
way to save the statistics is to print them now on your printer; they are not 
saved on diskette or in memory. After printing, the program automati­
cally continues. Select CONTINUE without first printing. 

A display of correlation coefficients appears next on the screen. STATS 
calculates any coefficients of correlation between the selected series, 
and displays them in a matrix as shown in Figure 2-41. 

018-048/P 

Figure 2-41. Coefficients of Correlation Display 
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You now have the option to RETURN to the Trend menu, or to PRINT the 
coefficients. Again, the only way to save this information is to print it now 
on your printer; it is not saved on diskette or in memory. After printing, 
the program automatically returns to the Trend menu. Select RETURN 
without first printing. 

Performing a Linear Multiple Regression 

To continue the discussion of the Analyze menu items, select ANALYZE 
again from the Trend menu. This time, move the cursor to REGRESS, and 
examine the long prompt in the status area. REGRESS performs a linear 
multiple regression (least squares) on selected series. The series in ques­
tion are referred to as variables. 

Multiple regression is a method of developing a formula that relates a 
single variable (the dependent variable) to other variables (the indepen­
dent variables). The resulting equation can explain the dependent 
variable in terms of the independent variables, and an optional constant. 
Stated simply, REGRESS can tell you if there is a linear relationship 
between the independent and the dependent series. 

The multiple regression technique can typically be used to forecast the 
output of one industry on the basis of the output of another industry. For 
example, you could assume that the performance of the auto industry is 
closely related to that of the steel industry. Multiple regression can 
likewise be used to forecast the performance of a stock in terms of the 
measures of the economy. 

The technique develops a constant (B) and coefficients (m) for each 
independent variable (x) such that a point in the dependent variable (y) 
is approximated from the corresponding period (i) data in the indepen­
dent variables according to the formula: 

NOTE: You can do exponential and other types of regressions by 
using XFORM to convert series to a form acceptable for a linear multiple 
regression. This XFORM conversion oper,ation is discussed later in this 
lesson under WRITING YOUR OWN SERIES TRANSFORMATION. 

REGRESS also calculates and displays the statistical measures of a 
linear multiple regression. These include the T -statistic, the R-bar 
squared statistic, the corrected R-bar squared statistic, the standard 
error for the regression and for the coefficients, the sum of the squared 
residuals, the F-statistic, and the Durbin-Watson statistic. The formulas 
used by VisiTrend/Plot for computing these statistics are shown under 
REGRESS in Chapter 3: REFERENCE. 
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Two new series are generated by the Regression operation. The first is 
a fitted series developed from the generated constant and coefficients. 
The second is a series containing the differences (residuals) between the 
actual dependent series values and the fitted values. The new series have 
the same name as the dependent series, plus an extension that serves as 
an identifier. These identifiers are listed in Table 2-2. 

Table 2-2. Name Identifiers for Fitted & Residual Series 

Identifier Series Type 

.Fn Fitted series 

.Rn Residual series 

Where 

n is a program-generated 
number. The number is the same 
as the one for a residual series 
from a single regression. 

n is a program-generated 
number. The number is the same 
as the one for a fitted series from 
a single regression. 

Now, you'll practice using multiple regression techniques. With the 
cursor on REGRESS, press RETURN. 

The list of series in memory is again displayed. The status area prompts 
you to select a dependent variable. This example will test the assumption 
that the price/earnings ratio can be explained by earnings, dividends, 
and book value. Move the cursor to XV PE RATIO, and press RETURN. 

The list is erased and immediately redisplayed. This time the status 
area prompts you to select the independent variables. You can select 
from one to five series as independent variables. The independent 
variables must have the same period as the dependent variable. With the 
cursor on XV EARN I NGS, press the space bar. Do the same for XV 
DIVIDENDS. Then put the cursor on XV BOOK VALUE, and press 
RETURN. 

The status area displays a range that represents the intersection of the 
ranges in the dependent and independent variables. Intersection means 
that the limits of the range are the earliest date and latest date that are 
common to all the selected series. You again have the choice of keeping 
this range, or changing it. 
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You must consider one important point on the subject of the range: as a 
minimum, there must be two more data points in the range than there are 
independent variables, regardless of whether or not a constant is used in 
the regression. For example, when you select three independent 
variables, you must have five data points in the intersection of the ranges 
in the dependent and independent variables. 

The range displayed in the status area is appropriate for this example. 
With the cursor on KEEP, press RETURN. 

Next, the status area prompts you to choose whether or not a constant 
is used in generating the regression. With the cursor on YES, 
press RETURN. 

The time necessary to compute the regression increases as the number 
of data points and number of independent series increase. As the com­
putation is completed, the regression analysis is displayed as shown in 
Figure 2-42. 

018-049/P 

Figure 2-42. Regression Analysis Display 

You now have the option to RETURN to the Trend menu, or to PRINT the 
regression analysis screen display. Again, the only way to save this infor­
mation is to print it now on your printer; it is not saved on diskette or in 
memory. Select RETURN without first printing. 

Before erasing the regression analysis from the screen, the program 
asks if you want to save the series that were generated to contain the 
fitted and residual values. If you select NO, the series are discarded, 
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and you must perform the regression again if you want these series 
later. Select YES to save the series. The Trend menu reappears in the 
status area. 

To see thatthe new series have been saved in memory, move the cursor 
to DISPLAY, and press RETURN. Note that the bottom two items in the list 
of series are XY PE RATI,FO and XY PE RATI,RO. The series names are the 
same as that of the dependent series, plus an extension that identifies 
them as either fitted (F) or residual (R). The program supplied the same 
number for both series generated from this regression. To examine the 
values in these series, follow these steps: 

1. Select RETURN to display the Trend menu. 

2. Select ANALYZE from the Trend menu, then select TABLE from the 
Analyze menu. 

3. Select SCREEN to display the table of values on the screen. 

4. Use the space bar, arrow keys, and final RETURN to select XY PE 
RATIO, XY PE RATI,FO, and XY PE RATI,RO. 

5. When the range is displayed in the status area, select KEEP. 

The values for the series are displayed in three columns. The cor­
responding dates in the specified range occupy the first column. 

Figure 2-43 shows a line chart that was created in the Plot subprogram. 
On this chart, the actual data and the fitted data have been plotted 
together for easy comparison. 

018-050/P 

Figure 2-43. Actual and Fitted Series Line Chart 
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The status area displays the message PRESS ANY KEY. Press ESC, for 
example, and you return to the Trend menu. 

Performing Trend Forecasting 
The Regression operation also performs trend forecasting by 

calculating the best fitted straight line for the dependent variable. You 
are prompted for the number of periods to forecast. The fitted straight 
line is extended for the specified number of periods. 

When performing trend forecasting, REGRESS generates the same out­
put that is generated in multiple regression: a regression analysis screen 
display, a fitted series, and a residual series. Therefore, you must have 
enough space in memory for at least two more series in order to complete 
the Regression operation. 

If there is not enough memory space for the two generated series, the 
program displays the message CAN'TI NO ROOM. In such a case, the 
operation ends before completing all calculations, but the screen 
displays as much of the analysis as was performed before space was 
depleted. 

To free some memory space before beginning this operation, select 
CLEAR from the Trend menu, and remove the fitted and residual series 
you created earlier. Move the cursor to XY PE RATI,FO, press the space 
bar, move the cursor to XY PE RA TI ,RO, and press RETURN. 

A complete list of series in memory is redisplayed, showing that the fit­
ted and residual series are gone. With the cursor on RETURN, press 
RETURN to go back to the Trend menu. 

For this example, you will generate a five-period forecast of the XY PE 
RATIO series. Select the menu items ANALYZE, then REGRESS. For the 
dependent variable, select XY PE RATIO. 

You cannot include any series as independent variables when doing a 
trend forecast. When the prompt to select the independent variables is 
displayed, the bottom item in the list is [TREND]. Move the cursor to 
[TRE N D], and press RETURN. 

Next, you are prompted to specify the number of periods to be 
forecast. Type 5, and press RETURN. The maximum number of periods to 
be forecast is limited to the number of data points in the dependant 
series. Larger numbers are treated as 0 by the program, though no error 
message is displayed. When the range of the dependent variable is 
displayed in the status area, select KEEP. The regression analysis display 
appears on the screen. 
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You now have the same options you had with the multiple regression 
operation: to RETURN to the Trend menu, or to PRINT the regression 
analysis screen display. Again, the only way to save this information is to 
print it now on your printer; it is not saved on diskette or in memory. 
Select RETURN without first printing. 

Before erasing the regression analysis from the screen, the program 
also asks if you want to save the series that were generated here to con­
tain the fitted and residual values. The fitted series is the 5-year 
forecasted trend series of the dependent variable. Select YES to save 
these new series. The Trend menu reappears in the status area. 

Figure 2-44 shows a Line chart of the fitted series and the actual series 
plotted together in the Plot subprogram. 

018-051/P 

Figure 2-44. Trend Forecast Chart 

USING THE FUNCTION OPERATION 

The FUNCTION menu item in the Trend Menu displays its own menu 
containing seven different functions. You can use these functions to per­
form various computations and shifting of values in your series. 

Each item in the FUNCTION menu generates a new series. Before 
selecting FUNCTION, therefore, you must have enough space in memory 
for at least one more series in order to complete the operation. 
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If there is not enough memory space for a function to be performed, 
the program displays the message CAN'T! NO ROOM when you select 
the FUNCTION menu item. You must first use CLEAR to remove at least 
one series from memory. 

Select FUNCTION from the Trend menu. When the Function menu is 
displayed, move the cursor to each item as it is described, and examine 
the long prompt at the top of the status area. 

Each function generates a new series that has the same name as the 
source series, plus an extension that serves as an identifier. The iden­
tifiers added to the series name for each function are shown in Table 2-3. 

Table 2-3. Name Identifiers for Function Series 

Function Identifier Where 

Moving Average .Mn n = number of periods averaged 

Smoothing .S 

Percent Change .% 

Lag .-n n number of periods lagged 

Lead .+n n = number of periods leading 

Difference .D 

Total .T 

All the items in the Function menu operate in much the same way. 
After selecting an item, you select the source series from the list of series 
in memory. Some functions require no further input, while others prompt 
for an additional factor. This lesson describes each function. After the 
functions are individually discussed, an example is given using the mov­
ing average function. 

Computing Moving Average 
The MOVE AVG function calculates the moving average of the source 

series over a specified number of periods. The three common methods of 
calculating a moving average are: 

• The N + 1 method which locates the first point of the moving average 
series at one point beyond the periods being averaged. This is the 
method used by the Trend subprogram, as shown in Figure 2-45. 
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1970 1971 1972 1973 1974 1975 1976 I 

Source 

N + 1 
Moving Average 

..... ____ ...... __ "-_ ... Over 3 Periods 003-003 

Figure 2-45. Diagram of N + 1 Moving Average Method 

• The N method which locates the first point of the moving average 
series at the last point of the periods being averaged. This method is 
shown in Figure 2-46. 

1970 1971 I 1972 1973 1974 1975 

• I 

N Moving Average 
...... _ ....... _.....&. __ ..1.0-_ .... Over 3 Periods 003-004 

Figure 2-46. Diagram of N Moving Average Method 

• The Centered method which locates the first point of the moving 
average series at the center of the periods being averaged. This 
method is shown in Figure 2-47. 
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1970 I 1971 1972 1973 I 1974 1975 

. I d I 

Centered Moving Average (over en odd number of periods) 003-005 

Figure 2-47. Diagram of Centered Moving Average Method 

You can convert the Trend N + 1 moving average to an N or Centered 
moving average. See the MOVE AVG section of Chapter 3: REFERENCE 
for a detailed discussion. 

The moving average is essentially a smoothing technique. A common 
use of this function is to remove the noise (seasonal factors) from monthly 
or quarterly data. For example, if you have monthly sales data for several 
years and want to see the trends without the month-to-month fluctuations, 
you can generate a moving average over a 12-month period. For quarter­
ly data that contains seasonal noise, you can generate a moving average 
over a four-quarter period. 

After you have selected MOVE AVG, you select the source series from 
the list of series in memory, then you are prompted for the number of 
periods. 

Performing Exponential Smoothing 
The SMOOTH function performs a single exponential smoothing on the 

source series. The forecast generated by this technique is based on the 
most current data point and current forecast, and lags the source series 
by one period. 
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You are prompted for a smoothing factor ( A. ) which must be greater 
than 0 and less than 1. The smoothed series (Y) is generated from the 
source series (X) according to the following formulas. 

For the value i = 1: 

For the remaining i values: 

where: 

i is an integer ranging from 1 through the number of series data 
points. 

A high smoothing factor (a value greater than 0.5) gives greater 
weight to the more current point, and a low smoothing factor gives 
greater weight to the earlier point. The generated series lags the source 
series by one period, as shown in Figure 2-48. This lag is a one-period 
forecast for the data in the source series. 

Period.l Period 2 peciod3 Period 4 

. . . Source Series 

. . . Smoothed Series 

012-005 

Figure 2-48. Diagram of Smoothed Lag 
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Computing Percent of Change 
The PERCENT function calculates the percent of change between the 

dates represented by nand n + 1. The value is placed at date n + 1 in the 
new series. With this function, you can evaluate the change in related 
values, rather than trying to compare divergent magnitudes in the 
original values. For example, you may generate percent-of-change 
series for sales and cost-of-sales data. The original data could seem to 
demonstrate a low correlation; when, in fact, the percent of change 
shows a positive cause-and-effect relationship. 

Computing Adjacent Difference 
The DIFF function computes the difference between adjacent data 

points in a series. When DIFF is selected, you select a source series from 
the list of series currently in memory. 

Shifting Series to the Future 
The LAG function shifts the values in the source series a specified 

number of periods to the future in the new series. A common use ofdhis 
technique is to align data in time in a meaningful fashion. For example, if 
you spend X dollars on advertising in January, the effect of the expen­
diture will be seen in February sales. The LAG func1:ion shifts the adver­
tising expenditures in time where they can be evaluated against the sales 
they prompted, that is: 

Sales(i) = f(advertising expenditure(i-l» 

You are prompted to specify the number of periods to be lagged. The 
new series begins and ends the specified number of periods later than 
the source series. Figure 2-49 shows the effect of a one-period lag on a 
series. 

I Jan I Feb I Mar I Apr I May I 
100 

Lag 
.... _ ..... _ .... _ ........... _"""-_ ... Series 

I Feb I Mar I Apr I May I Jun 

Figure 2-49. Diagram of a One-period Lag 
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Shifting Series to the Past 
The LEAD function shifts the values in the source series a specified 

number of periods to the past in the new series. This function is the 
reverse of the LAG function. Using the same example, LEAD would allow 
you to shift the sales data back to the expenditure of advertising dollars 
for evaluation. 

You are prompted to specify the number of periods to be led. The new 
series ends the specified number of periods before the source series. 
Figure 2-50 shows the effect of a one-period lead on a series. 

100 

Dec 

I Jan I Feb Mar Apr May 

Source 
Ioo..,...-....... ..,.-__ ..,.. ...... ...,..---l.......,__ Series 

200 300 400 500 

Feb Mar Apr 

Figure 2-50. Diagram of a One-period Lead 

Computing a Cumulative Total 

012·007 

The TOTAL function calculates the running total of specified points in 
the source series. A given point in the new series is the total of all 
preceding points in the source series. The most common use of this func­
tion is to generate year-to-date totals of monthly or quarterly data. 

PRACTICING WITH THE MOVING AVERAGE FUNCTION 

This is an example of using the MOVE AVG function. Before starting, 
select EXIT from the Function menu; then select DISPLAY from the Trend 
menu. Examine the last line of the series display to be sure you have 
enough memory space for one more series. If you already have 16 series 
in memory, remove one with CLEAR. 

Select FUNCTION from the Trend menu. The Function menu is again 
displayed. 
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With the cursor on MOVE AVG, press RETURN. The list of series in 
memory is displayed. To select a series on which to calculate the moving 
average, move the cursor to XY DIVIDENDS, and press RETURN. Next 
you are prompted to enter the number of periods over which the average 
is to be calculated. Type 3, and press RETURN. 

The status area prints the message PLEASE WAIT", while the new series 
is being calculated. Then the program returns to the Trend menu. In 
order to view the new series, you will use TABLE from the Analyze menu. 

Move the cursor to ANALYZE, and press RETURN. With the cursor on 
TABLE, press RETURN. Select SCREEN for the table display. When the 
series list appears, move the cursor to XV DIVIDENDS, and press the 
space bar. Then, move the cursor to the new series named XY 
DIVIDEN,M3, and press RETURN. When the range prompt is displayed, 
select KEEP. Your screen should resemble the table of the two series in 
Figure 2-51. Select CONTINUE to see the remainder of the table on the 
next screen. Then press ESC to return to the Trend menu. 

018-052/P 

Figure 2-51. Table of Series After Moving Average 

You can convert the VisiT rend N + 1 moving average to an N or 
Centered moving average. These conversions are for an average over an 
odd number of periods, and over an even number of periods. Procedures 
for these conversions are detailed in the MOVE A VG section of Chapter 
3: REFERENCE. 
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WRITING YOUR OWN SERIES TRANSFORMATION 

While the FUNCTION and ANALYZE menu items offer many series data 
functions, they cannot meet all your needs. The XFORM menu item 
allows you to do series transformations. This can include the conversion 
of exponential values to first order values for inclusion in a linear mul­
tiple regression. 

For example, if you think that there may be a meaningful correlation 
such that: 

Y = f(X2) where f(.) is a linear function 

you can transform the X2 values to first order values with XFORM to 
create a new series (Z) that is equal to X2. then you use the new series (Z) 
as an independent variable to perform the linear regression: 

Y = f(Z) 

As a further example of the use of XFORM, suppose you suspect that 
dependent variable (D) is related to the sine of the cube of independent 
variable (I): 

D = f(sin(13» 

To test this hunch, use XFORM to compute: 

II = sin(13) 

then do a linear regression with D as the dependent variable and II as the 
independent variable: 

D = f(lI) 

If the regression shows a good fit, your hunch about the relationship 
between D and sin(I3) is correct. 

The XFORM function lets you write your own transformation formula. 
Formulas are limited to two lines (80 characters). You have the use of the 
following mathematical, logical, and comparative operators in writing 
your transformation formula: 

• Mathematical operators: + (addition), - (subtraction), * (multiplica­
tion), / (division), and 1\ (exponentiation). 

• Logical operators: AND, OR, and NOT. 

• Comparative operators: < (less than), < = (less than or equal to), 
(equal to), > (greater than), and> = (greater than or equal to). 
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You can use parentheses to control the execution order of the formula. 
All operations in parentheses are performed before the operations outside 
the parentheses. All parentheses must be closed or an error will occur. 

In addition to the mathematical, logical, and comparative operators, 
you can use the following functions: 

• SGN: Sign 

• INT: Integer part of 

• SQR: Square root 

• LOG: Natural logarithm 

• EXP: e to the power of 

• RND: Random number between 0 and 1 

• ABS: Absolute value of 

• SIN: Sine 

• COS: Cosine 

• TAN: Tangent 

• ATN: Arctangent 

These functions are used as they are in a BASIC program. The only 
difference here is that you can use a series as the variable on which the 
function operates. In this case the function is performed on each data 
point in the series. For example, SQR(XY EARNINGS) generates a series 
with the same beginning and ending dates and period. Each data point in 
the new series is the square root of the corresponding data point in 
XY EARNINGS. 

You must include at least one series name in your transformation 
formula. The XFORM function displays the list of series currently 
in memory. You select a series by pressing - to move the cursor into the 
list of series. Then you move the cursor to the desired series name, and 
press RETURN. 

The following example creates a new series with the name BO AVG. 
The new series is the average of the daily high and low stock prices con­
tained in the series BO HIGH and BO LOW. 

Before beginning, use OISPLA V (and CLEAR, if necessary), to make 
sure you have enough memory space for a new series. 

From the Trend menu, select XFORM. The program prompts you to 
name the series that will qontain the transformed data. Type BD AVG, 
and press RETURN. 
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If you don't enter a series name, the Trend subprogram automatically 
supplies a name in the form SERIESn, where n is a sequential number. 

A list of the series in memory is displayed. The top line of the status 
area prompts ENTER TRANSFORM, -, OR RETURN. Your choices are: 

• You can enter any transform operator or function from the keyboard. 

• You can enter a series name into a formula by first moving the cursor 
into the list with -. You continue pressing - or ~ until the the cor­
rect series name is highlighted by the cursor and appears in the status 
area. Then press RETURN. 

• You can press RETURN to indicate that the formula is complete. 

The transform formula you will practice uses all of these. 

When you want to erase part of a formula you have entered, press 
ESC. If a series name is in the formula when the ESC key is pressed, it is 
enclosed by slashes for easier reading. If you press ESC to correct a 
series name, the whole name is erased with a single press of the key. You 
do not have to erase each letter of the name. 

Type a left parenthesis. Next, press -. The cursor moves into the 
series list, highlighting the first name in the list. This ~eries name also 
appears in the formula line in the status area. Press - again; the cursor 
moves down, and the name in the status area changes accordingly. Move 
the cursor to BO HIGH, and press RETURN. The cursor disappears from 
the list and BO HIGH remains in the formula. 

Type the plus sign ( + ), and again press -. This time, move the cursor 
to BO LOW in the series list, and press RETURN. 

Type a right parenthesis, a slash (for division), and 2. You now have a 
formula in the status area that reads: 

( BO HIGH + BO LOW )/2 

To generate a new series from this formula, press RETURN. If the last 
item in the formula had been a series name, you would have had to press 
the RETURN key twice: once to enter the series name, and once to 
execute the formula. 

When the Transform operation has finished, the Trend menu is 
displayed. Select OISPLA Y to see the new series named BO AVG at the 
end of the list. Select RETURN to redisplay the Trend menu. 
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Figure 2-52 shows an overlay chart created in the Plot subprogram. 
The new series is plotted as a Line, overlaying a High-Low-Close chart of 
BO HIGH, BO LOW, and BO CLOSE. 

018-053/P 

Figure 2-52. Chart After Transformed Series 

CONTINUING WITH THE TREND SUBPROGRAM 

You can go back to the functions you have used in this lesson and 
analyze your data. You should be able to practice with the Function 
menu items that you have not yet used. Finally, you should know how to 
save your Trend series output on the data diskette, and plot the data with 
the Plot program. 

If you are unsure of any of the VisiT rend operations, review this lesson, 
and refer to the detailed sections of each menu item in Chapter 3: 
REFERENCE. For a review of the Main subprogram, see Lesson Two; and 
for a review of the Plot subprogram, see Lesson One. 
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FUNCTIONAL SUMMARY 

Operation 

Load Trend sub­
program 

Construct a table of 
series 

Calcula te series 
statistics 

Perform a linear 
multiple regression 
using your own 
variables 

From 

Main menu 

Trend menu 
Analyze menu 

Trend menu 
Analyze menu 

Trend menu 
Analyze menu 
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Select or Type 

1. TREND 

1. ANALYZE 
2. TABLE 
3. SCREEN/PRINTER 
4. - or - to series 

name(s) 
5. space bar/RETURN 
6. KEEP/CHANGE 

then start and end 
years 

7. ESC 

1. ANALYZE 
2. STATS 
3. - or - to series 

name(s) 
4. space bar/RETURN 
5. KEEP/CHANGE 

then start and end 
years 

6. CONTINUE/PRINT 
7. RETURN/PRINT 

1. ANALYZE 
2. REGRESS 
3. dependent variable 

series name 
4. 1 to 5 independent 

variable series 
names - I - / space 
bar/RETURN 

5. KEEP/CHANGE 
then start and end 
years 

6. YES/NO (use con­
stant) 

7. RETURN/PRINT 
8. YES/NO (save fitted 

and residual values) 
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(Continued) 

Operation From Select or Type 

Perform a linear Trend menu 1. ANALYZE 
multiple regression Analyze menu 2. REGRESS 
using program- 3. dependent variable 
supplied variables series name 
(Trend Forecasting) 4. [TREND] 

5. number of periods to 
forecast 

6. KEEP/CHANGE 
then start and end 
years 

7. RETURN/PRINT 
8. YES/NO (save fitted 

and residual values) 

Perform single Trend menu 1. FUNCTION 
exponential Function menu 2. SMOOTH 
smoothing 3. name of series to be 
of a series smoothed 

4. smoothing factor 
(between 0 and 1) 

Calculate percent of Trend menu 1. FUNCTION 
change between Function menu 2. PERCENT 
points in a series 3. series name 

Compute the dif- Trend menu 1. FUNCTION 
ference between Function menu 2. DIFF 
adjacent data 3. series name 
points in a series 

Shift values to the Trend menu 1. FUNCTION 
future Function menu 2. LAG 

3. series name 
4. number of periods 

Shift values to Trend menu 1. FUNCTION 
the past Function menu 2. LEAD 

3. series name 
4. number of periods 

Compute cumulative Trend menu 1. FUNCTION 
totals in a series Function menu 2. TOTAL 

3. series name 
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(Continued) 

Operation From Select or Type 

Calculate a moving Trend menu 1. FUNCTION 
average Function menu 2. MOVE AVG 

3. series name 
4. number of periods 

Trend menu 5. ANALYZE 
Analyze menu 6. TABLE 

7. SCREEN/PRINTER 
8. ~ or - to source 

series name 
9. space bar 

10. ~ or - to new 
series name 

11. RETURN 
12. KEEP/CHANGE 

then start and 
end years 

13. CONTINUE/EXIT 
14. ESC 

W rite a series Trend menu 1. XFORM 
transformation 2. name series to con-

tain transformed 
data 

Series list 3. formula with func-
tions, operators, 
series names (use 
- ,RETURN) 

4. RETURN 
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LESSON FIVE: PLOTTING EXAMPLES 

This lesson presents a series of step-by-step examples showing how to 
make VisiTrend/Plot charts. The data series that are used in these 
examples are stored on the VisiTrend/Plot example diskette in the three 
files named ACME REPORT, REGIONAL, and XYCHART. 

• ACME REPORT contains series that record annual revenue, units 
shipped, annual expenses, and income taxes for the year 198!. 

• REGIONAL contains series that show total Acme Company sales by 
geographic region in the year 1981. 

• XYCHART contains two series of values for two math functions. 

Before beginning this lesson, make. sure you have read and used the 
operations descrihed in LESSON ONE: THE PLOT SUBPROGRAM, and 
LESSON TWO: THE MAIN SUBPROGRAM. 

GETTING STARTED 

• If you are not continuing directly from Lesson Four, make sure your 
computer is OFF; then load the program diskette according to the 
directions in the section LOADING THE VISITREND/PLOT PRO­
GRAM in Chapter 1. Your screen displays the Main menu. 

• If you are continuing directly from Lesson Four, your screen displays 
the Trend menu. Select CLEAR, and then [KEEP NONE] to empty the 
computer memory. When the Trend menu is redisplayed, select 
MAIN to load the Main subprogram. Your screen displays the Main 
menu. 

Select LOAD from the Main menu. When the list of files appears, load 
the files ACME REPORT, REGIONAL, and XYCHART into memory. Files 
are loaded one at a time, so you must seleCt LOAD three times from the 
Main menu. Now load the Plot subprogram. The Select menu appears in 
the status area at the bottom of the screen. 

The examples in this lesson show you how to generate many different 
charts, and how to combine.charts. Each exercise begins with a picture 
of the chart that you will create. The picture is followed by a list of steps 
used to generate the chart. A word or phrase printed in light typeface in­
dicates where the cursor must be positioned, before you press the follow­
ing key. A word or phrase enclosed in quotation marks indicates that you 
must type the word or phrase at the keyboard, before you press the 
following key. For example: 
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LINE RETURN - move the cursor to LINE, and press the RETURN key. 

"0" RETURN - Type ° at the keyboard, and press the RETURN key. 

SPACE BAR - press the space bar. 

ESC - press the ESC key. 

GENERATING A SINGLE-LINE CHART 

Figure 2-53. Sample Single-Line Chart 

Beginning in the Select menu, follow these steps: 

LINE RETURN 

REVENUE RETURN 

PLOT RETURN 

018·054/P 

You generated several single-line charts like this one in Lesson One. 
This chart has a different Y-axis scale. The Y -axis scale is labeled THOU 
at the top, indicating that the values represent thousands: 50,000, 
100,000, etc. Press ESC to display the Plot menu. 
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GENERATING A TWO-LINE CHART 

Figure 2-54. Sample Two-Line Chart 

Beginning in the Plot menu, follow these steps: 

NEW RETURN 

SELECT RETURN 

LINE RETURN 

REVENUE SPACE BAR 

UNITS SHIPPED RETURN 

. PLOT RETURN 

APPLE II 
TUTORIAL 
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This chart contains two lines instead of one. Each line is plotted with a 
different symbol: the square (which is always the first symbol used by the 
program), and the plus sign ( + ). The two-line legend at the bottom of the 
chart identifies the chart type for each series, shows which plotting 
symbol was used, and lists the series name. Press ESC to display the 
Plot menu. The bottom line of the status area lists the first series selected, 
the type of chart, and three dots. These dots indicate that you selected 
multiple series. 

Note that both series were selected before the chart was plotted. 
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GENERATING A THREE-LINE CHART 

Figure 2-55. Sample Three-Line Chart 

Beginning in the Plot menu, follow, these steps: 

NEW RETURN 

SELECT RETURN 

LINE RETURN 

REVENUE SPACE BAR 

UNITS SHIPPED SPACE BAR 

EXPENSES RETURN 

PLOT RETURN 

LESSON FIVE 

018-056/P 

The new feature of this chart is the use of the circle (0) as the plotting 
symbol of the third series. 

This chart is rather difficult to read. The information for the years 1977 
through 1980 is fit tightly into a small space. The only plot line that shows 
up well is the 1980-1982 annual revenue. This chart might be satisfactory 
if its purpose is to show the revenue increase beginning in 1980. 
However, if the other information is equally important, it might be a good 
idea to change the range to 1975 through 1980. You could then handle 
the 1980 through 1982 revenue figures in a separate chart. 
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Another approach might be to change the scale to show the earlier 
data clearly, and let 1980-82 revenues go off the chart. You could 
indicate important value(s) with a moveable title. Be aware that rescaling 
this chart works only if the series to be truncated is selected last. Before 
rescaling, reverse the order of the series: select EXPENSES, UNITS 
SHIPPED, then REVENUE. You'll also need to label the plots with 
moveable titles, since generating an off-scale chart won't produce any 
legends. This is the approach used in Figure 2-56. 

018-057/P 

Figure 2-56. Rescaled Three-Line Chart 

Experiment with the improvements to this chart that were suggested in 
the preceding paragraphs. After you've made these improvements, 
return to the Plot menu. When the Plot menu appears, go to the Select 
menu. Select the LINE chart type; then observe the series list that 
appears, but do not select any series. 

You'll now select the same three series - but this time, with a shortcut. 
Notice that the last entry in th~ list is [SAME]. Choosing [SAME] selects 
all the series that were plotted in the preceding chart. Instead of select­
ing each series separately, you only need to position the cursor on 
[SAME], and press RETURN. Do that now. 

When the Plot menu reappears, select PLOT. The chart is replotted in 
its original form with the same three series. 

2-104 



APPLE II VISITRENDIPLOT™ ~~T~~s 
TUTORIAL LESSON FIVE 

[SAME] can be used as a shortcut in plotting any chart type except a 
Pie chart and an XY chart. The [SAME] setting is cancelled once you 
select NEW from the Plot menu, or if you transfer to the Main subprogram 
or Trend subprogram, then return to the Plot subprogram. 

So far, you've used the Plot subprogram to generate single and 
multiple-series plots with up to three series. As you've noticed, each 
series has a corresponding legend at the bottom of the chart. 

Although up to 16 series can be plotted on the same chart using a com­
bination of PLOT and OVERLAY, a maximum of the first six legends can 
be displayed on the bottom of a chart. Three or fewer legends are 
centered under the X-axis of the chart, as shown in the preceding 
photograph. Four, five, or six legends are laid out somewhat differently. 
Follow the steps below to plot four series in a Line chart. You cannot use 
the [SAME] shortcut, since you're adding a series to the original set 
of three. 

ESC 

SELECT RETURN 

LINE RETURN 

REVENUE SPACE BAR 

UNITS SHIPPED SPACE BAR 

EXPENSES SPACE BAR 

MARKET RETURN 

PLOT RETURN 

The chart is drawn on the screen with four series and four correspond­
ing legends. Notice that the legends are still under the X-axis, but they 
are now in two columns. When you are ready to continue, press ESC to 
display the Plot menu. 
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GENERATING A SINGLE BAR CHART 

Figure 2-57. Sample Single Bar Chart 

Beginning in the Plot menu, follow these steps: 

NEW RETURN 

SELECT RETURN 

BAR RETURN 

NORMAL RETURN 

REVENUE RETURN 

PLOT RETURN 

APPLE II 
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Again, this chart is very similar to the bar charts you plotted in Lesson 
One. However, the chart can be plotted differently by selecting half­
width bars. Press ESC to display the Plot menu. Repeat the sequence of 
steps above, but this time substitute LEFT for NORMAL in the fourth step. 
The chart is plotted as shown in Figure 2-58. 
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Figure 2-58. Sample Left-Bar Chart 

Press ESC to redisplay the Plot menu. The only differences in this chart 
are the width of the bars, and the bottom line of the status area which 
designates LEFT BAR where BAR was previously listed. 

The half-width bars are most useful for plotting comparative charts, as 
shown in the next example. 

GENERATING A COMPARATIVE BAR CHART 

018·060/P 

Figure 2-59. Sample Comparative Bar Chart 

2-107 



VISITREN DIPLOT™ ~~T~~s 
LESSON FIVE 

Beginning in the Plot menu, follow these steps: 

NEW RETURN 

SELECT RETURN 

BAR RETURN 

LEFT RETURN 

REVENUE RETURN 

PLOT RETURN 

ESC 

SELECT RETURN 

BAR RETURN 

RIGHT RETURN 

EXPENSES RETURN 

OPTIONS RETURN 

COLOR RETURN 

BLUE RETURN 

OVERLAY RETURN 

APPLE II 
TUTORIAL 

There were two differences between the way this chart was generated; 
and the way you generated the multiple Line charts: 

1. Instead of choosing multiple series at once and plotting them, you 
selected and drew each series on a separate pass through the Select 
menu. The OVERLAY choice, in effect, plotted a second chart on top 
of the first. 

2. You selected the color blue for the second set of bars. Alternatively, 
you could have selected a format (outlined or shaded) instead of a 
color, with the FORMAT item in the Options menu. 

If you had followed the steps above, but had selected neither a color 
nor a format with the Options menu, both sets of bars would have 
been the same color. The half-bars on the two overlaid charts 
wouldn't have shown up as clearly. 

You can create a comparative Bar chart more quickly by selecting 
BOTH from the Bars menu. The program prompts you to select the left 
series from the list; then the list is displayed again and you are prompted 
to select the right series. The two series are plotted on the same pass. 
When multiple series are plotted this way, the program chooses a color 
for the second set of bars; in this case, the color would be green. The 
color chosen depends upon the current background color, and the chart 
type. See the BACKGR section in Chapter 3: REFERENCE for details. 
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To try this method, press ESC to display the Plot menu, and follow 
these steps: 

NEW RETURN 
SELECT RETURN 

BAR RETURN 

BOTH RETURN 

REVENUE RETURN 

EXPENSES RETURN 

PLOT RETURN 

When you select NORMAL width from the Bars menu, the program 
allows you to select multiple series at the same time from a single series 
list. You use the space bar to place an asterisk by each series to be 
selected. When you select PLOT, a different type of Bar chart is drawn. 
The series chosen together from the same list are stacked on top of each 
other as shown in Figure 2-60. 

018-061/P 

Figure 2-60. Stacked-Bar Chart 

The values of the series are added. You can use this style of Bar chart 
when you are interested in graphically displaying the sum of multiple 
series. When bars are stacked, the legends reflect the order of stacking. 
That is, the first legend corresponds to the topmost set of bars, the second 
legend corresponds to the next lower set of bars, and so on. 
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USING OVERLAYS WITH LEGENDS AND TITLES 

When you plotted the first comparative Bar chart, you used OVERLAY 
rather than PLOT for the last step. OVERLAY draws a new chart on top of 
the existing chart. It uses the same range and scale as the existing chart. 
Up to 15 overlays can be drawn on a single chart. 

Overlaying the REVENUE series chart also preserved the REVENUE 
series legend, and added a second legend to correspond with the 
EXPENSES series overlay. However, overlaying does not always treat 
legends in this way. To see what other effects overlaying can have on 
legends, follow the steps in the next exercise. 

Redisplay the Plot menu, then draw a Bar chart for the MARKET 
series, using Left bars. You are going to write-over the current legend 
with a First bottom title. Display the Plot menu, select OPTIONS, and then 
select TITLE. 

When the Title menu appears, select FIRST. The flashing cursor 
appears on the title-entry line of the status area. Type MARKET, and 
press RETURN. When the Typeface menu appears, select NORMAL. 
Erase the Title menu by pressing ESC, and you see that the original one­
line legend has been replaced by the MARKET title. Your screen should 
resemble Figure 2-61. 

018-062/P 

Figure 2-61. Chart With Modified Legend 
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Now overlay the displayed chart as you did earlier. First press ESC, 
then select EXIT to return to the Plot menu. Now follow this sequence of 
steps: 

SELECT RETURN 

BAR RETURN 

RIGHT RETURN 

REVENUE RETURN 

OPTIONS RETURN 

COLOR RETURN 

GREEN RETURN 

OVERLAY RETURN 

This time the overlay EXPENSES chart did not generate a correspond­
ing EXPENSES legend, because you supplied a bottom title line for the 
first series plotted. The legend for the overlaid series is also suppressed 
if you add a moveable title to the existing chart. Your chart should 
resemble Figure 2-62. 

018-063/P 

Figure 2-62. Overlaid Chart With Modified Legend 

If you want to add a legend corresponding to the overlay, use the TITLE 
item again, and place the overlay legend on the Second bottom title line. 
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One more feature regarding overlays and legends is helpful when 
experimenting with a chart layout. The legend corresponding to the most 
recent overlay can be displayed by selecting the LEGEND item in the 
Title menu. Be aware, however, that displaying that legend erases any 
title residing on the same legend line. 

Even if more than six series are plotted and overlaid on a chart, the 
maximum number of legends that can appear on one chart is six. When 
there are more than three legends, their order is always columnar: top­
to-bottom and left-to-right. This order holds true whether the chart was 
drawn with multiple-series plots, overlays, or a combination of the two. 
See the discussion of PLOT or OVERLAY in Chapter 3: REFERENCE for 
details on plotting up to 16 charts. 

REDRAWING OFF-SCALE DATA DURING AN OVERLAY 

When you used OVERLAY to create a comparative Bar chart with the 
example series, you encountered no problems with scale, range, or other 
plotting factors. However, when you use the Overlay operation on your 
own charts, it's often easy to create off-scale charts. 

In Lesson One, you encountered an off-scale condition when overlay­
ing was not involved. The program gave you two choices: PROCEED or 
CANCEL. When overlaying is involved, the program gives you a third 
choice: REDRAW. This section of Lesson Five will let you experiment with 
REDRAW for off-scale Overlay operations. 

Return to the Plot menu and select NEW_Then SELECT a LINE chart 
type, choose the REVENUE series, and PLOT it. Press ESC to redisplay the 
Plot menu, then select OPTIONS, TITLE, and MOVEABLE. Type 
REVENUE, and press RETURN. Use M, I, and the arrow keys to move the 
title, until it is just above the point for the year 1977. Press RETURN to 
display the Typeface menu, and FIX the title (NORMAL typeface is 
automatically chosen). When you have completed these steps, your 
screen should resemble Figure 2-63. 
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Figure 2-63. Line Chart With Moveable Title 

Next, plot a second series using the Overlay operation. EXIT from the 
Title menu. When the Plot menu appears, the sequence of steps is: 
SELECT, LINE, UNITS SHIPPED, and OVERLAY. Notice that the legend for the 
overlaid series is not displayed. This is because you added a Moveable title 
to the existing series. The overlay legend is also suppressed when any bot­
tom title is added to the existing chart. You can always supply missing 
legend(s) by using the moveable or bottom title menu items. You can also 
display the legend of the most recent overlay by selecting LEGEND from 
the Title menu. Try this last method by selecting OPTIONS, TITLE, and 
LEGEND. Remove the menu with ESC, and you see the second legend. 

Now, label the lower line for the series UNITS SHIPPED with a 
Moveable title, UNITS. Fix the title UNITS just above the point for the 
year 1982, in NORMAL typeface. 
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So far, you have been able to plot two series on the same scale using 
the Overlay operation. Your screen should resemble Figure 2-64. 

018-065/P 

Figure 2-64. Overlaid and Titled Line Chart 

Next, you'll use another Overlay operation to plot a third series on this 
chart. Once again, EXIT to the Plot menu. Follow this sequence of steps: 
SELECT, LINE, MARKET, and OVERLAY. This time, the overlay didn't pro­
ceed because the data in the MARKET series is off-scale. You now have 
three choices, as indicated by the menu in the status area: PROCEED, 
REDRAW, or CANCEL. PROCEED and CANCEL operate as you saw in 
Lesson One. REDRAW, however, rescales the chart, then redraws it. This 
has several consequences, as you will see. 
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Select REDRAW. The message WARNINGI INTERMEDIATE SERIES LOST 
appears briefly in the bottom status area. Your screen should resemble 
Figure 2-65. 

018·066/P 

Figure 2-65. An Off-scale Chart Redrawn 

Notice that all plot labels disappeared, and so did the UNITS SHIPPED 
series. Using REDRAW after overlays erases all previously overlaid 
series; it also erases all legends, and any titles. Only the originally plot­
ted series and the series produced by REDRAW remain. 
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The relationships among legends, overlays, and the REDRAW function 
are illustrated in Figure 2-66. 

Operations 

1. Plot Series 1 
2. Add Titles 

3. Overlay with Series 2 
4. Add Titles 

5. Overlay with Series 3 
6. Redraw 

Note: Overlays plot only 
first and last series 
on Redraw and strip off 
Legends and Titles. 

Display 

Series 1 

Series 2 

Series 1 

Series 1 

Series 3 

012-009 

Figure 2-66. Relationships Among Legends. Overlays. & REDRAW 

When you are ready to continue, press ESC to display the Plot menu. 
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GENERATING AN XY CHART 

Figure 2-67. Sample XY Chart 

Beginning in the Plot menu, follow these steps: 

NEW RETURN 

SELECT RETURN 

XY RETURN 

PRICE RETURN 

QUANTITY RETURN 

PLOT RETURN 

LESSON FIVE 
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An XY chart consists of two sets of series values plotted against each 
other. This type of chart graphically indicates the presence or absence of 
a correlation between the two sets of values. 

As you can see, this chart does not have a time axis; instead it has two 
scale axes. The Y-axis contains the scale for the QUANTITY series, and 
the X-axis contains the scale for the PRICE series. 
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The plotted points represent the correlation of values from the two 
series. The two series must have the same periodicity, and their ranges 
must intersect. The VisiTrend/Plot program determines correlation 
values between the two series when data points in the two series have 
matching dates (and periods). Each time the date of a data point in one 
series matches the date of a data point in the other series, a correlation 
value is determined. Each correlation value results in one point on the 
XY chart. 

To plot an XY chart for two series when the data points in question do 
not have matching dates, use the Edit operation in either the Main or the 
Trend subprogram. Then select SPECS, and change the start and end 
years and/or period of one of the series. 

The VisiTrend/Plot program automatically plots an XY chart with 
hollow square symbols to indicate each correlation point. You can cause 
data points to be drawn with lines only, points only, or both symbols and 
lines, by selecting OPTIONS from the Plot menu. Then select FORMAT, 
choose LINES, POINTS, or BOTH, and plot the chart again. As with other 
chart types, you can respecify that only symbols be used by repeating the 
procedure and selecting SYMBOLS from the Format menu. 

NOTE: the Overlay operation cannot be used with an XY chart. 

USING A WINDOW TO DISPLAY TWO CHARTS 

When you are ready to continue with the lesson, press ESC to display 
the Plot menu. 

The WINDOW menu item divides the screen into two parts, either ver­
tically or horizontally. You can plot different charts in each window. Any 
chart type can be displayed in a window, except a Pie chart. Plotting a 
Pie chart requires the use of the entire screen. 

When you select WINDOW from the Plot menu, a Window menu is 
displayed in the status area. Your choices are: 

EXIT 

HORIZ 

VERT 

SWITCH 

NONE 

returns to the Plot menu, retaining the current display. 

creates top and bottom windows. 

creates left and right windows. 

switches windows, thus making the other window the 
active window. 

cancels the Window operation, and returns to one full 
screen display. 

2-118 



APPLE II VISITREN DIPLOT™ ~~T~~s 
TUTORIAL LESSON FIVE 

The first active window is the top one when you choose HORIZ win­
dows, and the left window when you choose VERT windows. 

When you switch between windows, the series and options for the win­
dow you are leaving are no longer active. If you return to a window and 
want to change an option, you must start over, and PLOT the chart again. 
You should, therefore, try to complete all refinements to one chart before 
switching windows to plot and refine the other chart. 

Two series, BEFORE and AFTER, will be plotted in horizontal windows 
for this example. BEFORE has only three data points representing three 
existing sales regions. AFTER has four data points that include an addi­
tional fourth sales region. It is often desirable to show different forms of 
data in two different charts at the same time. 

The following practice in using windows directs you to create a display 
resembling Figure 2-68. 

Figure 2-68. Sample Window Charts 

Beginning in the Plot menu, follow these steps: 

NEW RETURN 

WINDOW RETURN 

HORIZ RETURN 

BAR RETURN 

NORMAL RETURN 
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BEFORE RETURN 

PLOT RETURN 

ESC 

WINDOW RETURN 

SWITCH RETURN 

BAR RETURN 

NORMAL RETURN 

AFTER RETURN 

PLOT RETURN 

Press ESC to redisplay the status area. Your currently active window is 
indicated by a code on the extreme right of the bottom status line. The 
code is W for window; followed by T for top, B for bottom, R for right, or L 
for left. In this case, the code is WB, meaning that the bottom horizontal 
window is the active window. 

Legends are not included in charts drawn with the Window operation. 
You must create any required legends using the Title menu. Only the 
Moveable title can be used on a chart occupying the space of one win­
dow. You could include the meaning of the numbers under each column, 
replace the numbers with descriptive names, or supply meaningful 
abbreviations such as N, W, S, and C - for North, West, South, and 
Central. 

Figure 2-69 shows one of the ways the charts could be enhanced using 
the Moveable title item. 

Figure 2-69. Sample Annotated Window Charts 
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There are two ways to cancel the Window operation. You can select 
NEW from the Plot menu, or NONE from the Window menu. With the Plot 
menu displayed, select NEW. The Window operation is cancelled, the 
screen clears, and the Plot menu is redisplayed. 

GENERATING A PIE CHART 

In the following sections, you are going to plot Pie charts. The 
VisiTrend/Plot program has three important requirements for data series 
that are to be drawn as Pie charts. These requirements are: 

• Each value to be used in a Pie chart must be from a different series. 
The value from each series becomes a slice of the pie. Up to 8 series 
can be used effectively. 

• All the series used in a Pie chart must have the same period. The steps 
for plotting a Pie chart give you an opportunity to check the period 
before selecting each series. 

• All values to be plotted must be at the same location in each series. In 
other words, at least one location must be common to all the series 
used for a Pie chart. For example, if you specify a Pie chart to show 
data for 1978, each series being used must contain a value for 1978. 

Pie charts can use values that are keyed to points in time, or to a set of 
circumstances. In the next exercise, values are keyed to a set of circum­
stances: data point 0 represents revenues split among three regions; data 
point 1 represents revenues split among four regions. If keyed to points 
in time, the values could represent, for example, total revenues for each 
month of the year. 

A Pie chart shows a single point in time (or a single set of circum­
stances), instead of a comparison of different points (or circumstances) 
as other charts can. 
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Figure 2-70 shows how these Pie chart requirements apply to four data 
series. 

Series A 

Series B 

Series C 

Series 0 

Common Range 

Common 
Periodicity 
(12) 

Figure 2-70. Choosing Series for a Pie Chart 

012-008 

The data for the charts you'll plot in this exercise are contained in 
three series: NORTH, WEST, and SOUTH. Each series has two data points. 
The first data point in each series represents the total revenue attributed 
to four existing regions. The second data point in each series reflects the 
allocation of total revenue if a fifth region were added. 
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Figure 2-71 shows the first example Pie Chart. 

Figure 2-71. Sample Pie Chart 

Beginning in the Plot menu, follow these steps: 

SELECT RETURN 

PIE RETURN 

NORTH SPACE BAR 

WEST SPACE BAR 

SOUTH RETURN 

"0" RETURN 

LESSON FIVE 
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Each segment of the pie is labeled with a letter. The letter refers to the 
items in the legend. This order of the series around the pie and in the 
legend is significant; it is the order in which you selected them. If you 
had selected the series in the opposite order, A would be SOUTH, and C 
would be NORTH. Also, their relative positions on the pie would be 
reversed. The first series always begins at the 3 o'clock position, and 
subsequent series extend in a clockwise direction. 

The bottom line of the legend contains a 0 and a 1. Zero is the date or 
reference number of the selected data. One is the periodicity. 

Next, you'll add some enhancements to the Pie chart. Remember that 
neither the Overlay nor the Window feature is available with Pie charts. 
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Shading and Titling a Pie Chart 
Press ESC to display the status area, and proceed to the Shading 

operation. 

The Shading operation first prompts you to enter a letter, or press 
RETURN. A letter indicates the label of the pie segment to be shaded, 
and RETURN exits the Shading operation (after you confirm the end). 
You can specify labels in any order, and you can skip any segments you 
don't want shaded. If you change your mind, you can change the shade 
of any segment. 

Type A, and press RETURN. The Shade menu is displayed. If you have 
a color display unit, you can choose any color. Refer to the sections on 
PIE and COLOR in Chapter 3: REFERENCE for details on compatible 
colors in a Pie chart. If you have a black-and-white display unit, you 
should limit your selections to black, white, and one other color. All 
other colors look the same on a black-and-white monitor. For now, select 
WHITE1 or WHITE2, and press RETURN. Segment A is filled in. 

The same prompt returns, allowing you to continue shading. Type B, 
and press RETURN. This time, select GREEN, and press RETURN. The B 
segment is filled in. Leave the C segment as it is, in black. Press 
RETURN. You are asked to confirm that you want to exit the Shading 
function. This confirmation is provided because you have only one 
chance to shade a Pie chart. When you leave this operation, you cannot 
return to it without selecting and plotting the chart again from the begin­
ning. 

Type Y, and when the Pie Chart Option menu appears, select TITLE. 

The Title menu for Pie charts contains the same items as the Title menu 
for other chart types. There is one important difference: The LEGEND 
item for all other charts was used to restore the legend that was covered 
by bottom title(s) and overlays. With Pie charts; LEGEND is used to 
remove the current legend, and the segment labels. Move the cursor to 
LEGEND, and press RETURN. 

The MOVEABLE title item f~r Pie charts offers the choices of the 
Typeface menu, and the opportunity to descriptively label all the 
elements of the chart. Use Moveable titles to enhance your chart so that it 
resembles the one in Figure 2-72. If you need to review, see the sections 
on Moveable titles in Lesson One. 
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Figure 2-72. Shaded and Titled Pie Chart 

When you've finished retitling the Pie chart, select EXIT from the Title 
menu. The Pie Chart Option menu reappears. SCREEN saves the Pie 
chart image on diskette, or loads another chart image, as described in 
Lesson One. PRINT prints the Pie chart on a supported printer, also as 
described in Lesson One. TEXT is described in the following section 
CREATING ANNOTATED CHARTS AND TEXT PAGES. EXIT erases the 
Pie chart from the screen, and displays the Select menu from which you 
can choose another chart, or go to the Plot menu. 

Experiment now with plotting another Pie chart. Use the same three 
series, plus the CENTRAL series; and type 1 for the year, instead of O. 
When you are ready to continue with the lesson, select NONE from the 
Select menu. The Plot menu is displayed in the status area. 

CREATING ANNOTATED CHARTS AND TEXT PAGES 

Suppose you've created a chart on the screen, and you'd like to use it 
in a management report or in a slide presentation. The chart itself might 
need some enhancements, such as a boldface title, different X-axis label­
ing, and a supporting page of supplementary information. You could use 
the Title operation to make some of these enhancements, but not all of 
them. 

Another VisiTrend/Plot program feature, the Text operation, does 
everything that the Title operation can do, and more. TEXT allows you to 
place text in a variety of styles, anywhere on a displayed chart. With 
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TEXT, you can also create entire pages of text, and combine a chart on the 
same page with that text. 

You'll use this example of a slide presentation to practice the features 
of the Text operation in this lesson. You are going to enhance an existing 
chart image from the sample diskette, and then create a page of sup­
plementary notes in support of the chart. 

The chart you need is on the data diskette in the file named 
ACMEl.PIX. To load this chart image, you'll follow the same steps that 
were described in Lesson One. From the Plot menu, select SCREEN. 
Then select LOAD , move the cursor in the list to the file named 
ACME 1 ,PIX, and press RETURN. When the chart is completely loaded on 
the screen, it should resemble Figure 2-73. 

018-072/P 

Figure 2-73. Chart for Text Exercise 

To begin the Text operation, press ESC. In a moment, the Screen 
menu appears. Select EXIT to return to the Plot menu, then select TEXT. 
The status area disappears, and the cursor appears as a small rect­
angular block in the upper-left corner of the screen. The location of the 
cursor is where the characters you type at the keyboard will appear on 
the screen. Certain keys allow you to move the cursor anywhere on 
the screen. 

First, take a few minutes to experiment with moving the cursor in the 
Text operation. The --+ key and +- key move the cursor one space to the 
right and one space to the left, respectively. RETURN moves the cursor 
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to the beginning of the next line, much like the return key on a 
typewriter. CTRL-O moves the cursor straight up one space, and CTRL-L 
moves the cursor straight down one space. These cursor-movement keys 
are the only way that the cursor can be moved onto the chart itself, 
without blanking out anything. The space bar also moves the cursor, but 
erases existing spaces as the cursor moves. 

When you've familiarized yourself with these cursor-movement keys, 
position the cursor back in the upper-left corner of the screen. Take a 
look at Figure 2-74. It shows what the currently loaded chart will look like 
after you've changed it. 

018-073/P 

Figure 2-74. Chart Enhanced With Text Operation 

The first change consists of titling the chart in bold typeface. To turn on 
the bold typeface, press CTRL-B. Type ACME INC. SALES AND EARN­
INGS on the top line, beginning in column 1. Now, return to normal 
typeface by pressing CTRL-B a second time. 

Next, you'll replace the THOU indicator on the Y-axis with the scale 
value $200. To do this, you must first erase THOU, then type $200 in its 
place. Move the cursor over the T using RETURN and -. Now press the 
space bar five times to erase THOU. Even though most of THOU is now 
erased, you see some residue of the bottoms of the letters, because the 
word was not resting directly on the second line. You need to position the 
cursor in smaller increments so that the space bar can erase the residue. 
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CTRL-Z changes the cursor to a dot that moves only a tiny increment. 
This increment change is useful for such tasks as erasing small areas of a 
chart, positioning the cursor between normal lines, and typing 
superscript or subscript characters. 

Before changing the cursor movement, position the cursor at the 
beginning of the line containing the residue. 

Now, press CTRL-Z. The block cursor is reduced to a single dot posi­
tioned at the top-left corner of the former block. Pressing CTRL-Z a sec­
ond time restores the remainder of the block cursor. Pressing the cursor 
movement keys with CTRL-Z in effect, moves the dot only a tiny fraction 
of the normal cursor movement. Practice moving it around now. 

When the dot cursor is positioned where you want it (slightly above the 
residue), press CTRL-Z again. The block cursor returns and normal cur­
sor movement is again in effect. 

Now, press the space bar again to erase the remammg residue of 
the word THOU, move the cursor back by pressing ~ three times, then 
type $200. 

The next enhancement is a vertical label along the left side of the 
Y-axis. The label reads "Thousands $" to explain the abbreviated Y-axis 
values. Press RETURN to move the cursor to the beginning of the next 
line, and type T. Now press CTRL-A to turn on lower-case letters. Then 
alternate RETURN with the remaining letters of the word down the side of 
the screen. Skip a line, and type $. Turn off lower-case letters by press­
ing CTRL-A twice. 

Your next task is to expand the letter abbreviations along the X-axis. 
Move the cursor to the line containing the letter abbreviations, and erase 
them by pressing the space bar; use the dot cursor, as necessary, for 
positioning. 

Move the cursor to the beginning of the X-axis to enter the month 
abbreviations. For clarity's sake,· each three-letter abbreviation should 
be centered under the tick mark representing that month. However, if 
you use only normal cursor movement across the line, your later words 
will be slightly off-center. You'll need to use some trial-and-error, and 
repositioning with the dot cursor, in order to center each abbreviation 
under a tick mark. 
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The last change is to modify the legend. Again, you must erase the 
existing words in the legend first, then type the new words. Be careful to 
erase only the words in each legend item. If you accidentally erase a 
plotting symbol, the only way to restore the symbol is to reload the chart. 
The reloading will destroy all the changes you've made so far. 

First, position the cursor directly on top of the first B (use the CTRL-Z 
dot cursor as needed), and press the space bar twice to erase BL. Now 
press - three times, and use the space bar to erase ACMESALE. Back 
up the cursor with +-, and type = SALES to the right of the plotting 
symbol. When you've finished changing the first legend, repeat these 
steps to alter the second legend. You should have the words 
= EARNINGS after the second symbol. 

Your completed enhancements on the loaded chart should now 
resemble Figure 2-74, shown earlier. 

Because this lesson assumes you are using the enhanced chart for part 
of a slide presentation, you should store it on a diskette file. Press ESC to 
terminate the Text operation, and display the Plot menu. Select SCREEN, 
and then select SAVE. A list of file names appears with the extension .PIX 
appended to each name. At the bottom of this list is [NEW FILE]. Move the 
cursor to [NEW FILE], and press RETURN. The list disappears, the chart 
you're going to save reappears, and the status area prompts for a file 
name. Type SLIDEI, then press RETURN. As soon as the screen has been 
saved on the diskette file, the Screen menu reappears. Select EXIT to 
return to the Plot menu; then select TEXT again. 

The modified chart remains on the screen, but it must be erased before 
the next exercise can begin. To erase the screen press. CTRL-@. Hold 
down CTRL while you press SHIFT and @ together. The only thing you 
should see on the screen now is the block cursor in the upper-left corner. 
The Text operation is still active, and you are ready to begin the 
next exercise. 
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In the next example, you'll practice using the Text operation to create 
a text-only page. The page you are going to create will resemble 
Figure 2-75. 

018-074/P 

Figure 2-15. Sample Text Page 

Again, you'll use most of the same Text features that you used to 
enhance the Sales and Earnings Bar chart image. In addition, you'll try 
two new features: tab and inverse video. 

As the figure shows, you must first center a title, in boldface type, at 
the top of the page. Then you'll add boldface bulleted subtitles, followed 
by numbered items in normal typeface. Follow these steps: 

1. Press CTRL-I three times to tab the cursor toward the center. Each 
pressing of CTRL-I jumps the cursor ahead five spaces. 

2. Press CTRL-B to turn on boldface. 

3. Type HIGHLIGHTS, and press RETURN twice to skip a line after the 
title. 

4. With the boldface feature remaining in effect, type the letter 0 for a 
bullet. Press the space bar, then type 2ND HALF EARNINGS UP 
102%. 

5. Press CTRL-B to turn off boldface, then press RETURN twice to skip a 
line after the subtitle. Use the space bar to indent, and the RETURN to 
double space your next entries. Type the three numbered items, and 
the second subtitle as shown. 
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Notice that the first item under the second subtitle shows $300K in 
inverse video and boldface characters. To create this combination, press 
CTRL-B for boldface, then press CTRL-R for inverse video. This sequen­
tial order is not required. You could also turn on inverse video before 
boldface. After you've typed $300K, remember to turn off each feature 
by pressing CTRL-B and CTRL-R again. 

When you've finished creating the text page, store it in a diskette file 
just as you stored the chart - with the SAVE item in the Screen menu. 

In these last two exercises, you've learned all the features of the Text 
operation, and you've seen how some features can be combined for 
special effects. All features of the Text operation can be combined with 
each other, as desired. 

FUNCTIONAL SUMMARY 

Operation 

PLOTTING SERIES 

Draw multi-Line 
chart 

Draw single Bar 
chart 

Draw comparative 
Bar chart with 
user-selected 
formatting 

From 

Plot menu 
Select menu 

Plot menu 

Plot menu 
Select menu 
Bar menu 

Plot menu 

Plot menu 
Select menu 
Bar menu 

Plot menu 
Options menu 

Format menu 

Plot menu 

Plot menu 
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Select or Type 

1. SELECT 
2. LINE 
3. ~ or ~ to series 

name(s) 
4. space barf 

RETURN 
5. PLOT 

1. SELECT 
2. BAR 
3. NORMAL 
4. series name 
5. PLOT 

1. SELECT 
2. BAR 
3. LEFT 
4. series name 
5. OPTIONS 
6. FORMAT (or 

COLOR) 
7. OUTLINED/ 

SHADED/ SOLID 
(or color) 

8. PLOT 
9. ESC 

10. SELECT 
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(Continued) 

Operation From Select or Type 

PLOTTING SERIES (Continued) 

Draw comparative Select menu 11. BAR 
Bar chart with Bar menu 12. RIGHT 
user-selected 13. series name 
formatting Plot menu 14. OPTIONS 
(Continued) Options menu 15. FORMAT (or 

COLOR) 
Format menu 16. OUTLINED/ 

SHADED/ SOLID 
(or color) 

Plot menu 17. OVERLAY 

Draw comparative Plot menu 1. SELECT 
Bar chart with Select menu 2. BAR 
program-selected Bar menu 3. BOTH 
formatting 4. left series name 

5. right series name 
Plot menu 6. PLOT 

Draw stacked Bar Plot menu 1. SELECT 
chart Select menu 2. BAR 

Bar menu 3. NORMAL 
4 . .- or - to series 

names 
5. space bar/RETURN 

Plot menu 6. PLOT 

Draw, shade, and Plot menu 1. SELECT 
title Pie chart Select menu 2. PIE 

3 . .- or - to series 
names 

4. space bar/RETURN 
5. year or reference 

number 
Displayed chart 6. ESC 

7. segment letter 
Shade menu 8. (color)/program 

default shading 
9. RETURN (to end) 

10. Y (to confirm) 
Pie options menu 11. TITLE 
Title menu 12. TOP/BOrrOMI 

SIDE! MOVEABLE 
(see SUMMARY for 
Lesson One) 
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(Continued) 

Operation From Select or Type 

PLOTTING SERIES (Continued) 

Remove Pie chart Title menu 13. LEGEND 
legend 14. EXIT 

Pie options IS. SCREEN/PRINT/ 
menu TEXT/EXIT 

Draw XY chart Plot menu 1. SELECT 
Select menu 2. XY 

3. series name for 
X-axis 

4. series name for 
Y-axis 

Plot menu S. PLOT 

Replot previously- Plot menu 1. SELECT 
selected series Select menu 2. (chart type) 

3. [SAME] 
Plot menu 4. PLOT 

USING WINDOWS 

Display two charts Plot menu 1. WINDOW 
at once Window menu 2. HORIZ/VERT 

Select menu 3. (chart type) 
4. first series name 

Plot menu S. PLOT 
6. OPTIONS 

(if needed) 
Plot menu 7. WINDOW 
Window menu 8. SWITCH 
Select menu 9. (chart type) 

10. second series name 
Plot menu 11. PLOT 

Add titles to window Window display 1. ESC 
charts Plot menu 2. OPTIONS 

Options menu 3. TITLE 
Title menu 4. MOVEABLE (see 

SUMMARY for 
Lesson One) 

2-133 



VISITREN DIPLOT™ ~~f~~s 
LESSON FIVE 

(Continued) 

Operation 

USING TEXT 
FEATURE 

From 

Annotate charts and 
create text screens 

Plot menu 
Block cursor 

Change cursor movement intervals 

Move cursor up 

Move cursor down 

Move cursor left 

Move cursor right 

Tab cursor five spaces to 
right 

Move cursor to beginning of 
next line 

Erase character 

When upper case, change all subsequent 
characters to lower case 

When lower case, change only 
next character to upper case 

When lower case, change all subsequent 
characters to upper case 

Turn on bold face (upper case 
case only) 

Turn off bold face 

Turn on inverse video 

Turn off inverse video 

Clear entire screen 

Return to Plot menu 
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Select or Type 

1. TEXT 
2. Type desired text; 

select a function as 
follows: 

CTRL-Z 

CTRL-O 

CTRL-L 

CTRL-I 

RETURN 

Space Bar 

CTRL-A 

CTRL-A 

CTRL-A twice 

'CTRL-B 

CTRL-B 

CTRL-R 

CTRL-R 

CTRL-@ 

ESC 
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REFERENCE 

USER'S 
GUIDE 

CHAPTER 3 
REFERENCE 

Chapter 3: REFERENCE is designed to give you quick and easy access 
to specific information about the VisiTrend/Plot program. You can use 
the Reference sections during the lessons, or any time you need to 
refresh your memory and enhance your knowledge of program details. 

The first several pages of this chapter discuss general information and 
program concepts. These include: 

• Useful Facts About Program Operations 

• Keyboard Usage 

• Status Areas 

• Color Codes 

• Series Naming Conventions 

• Ranges 

• Scales 

The remainder of this Reference chapter presents all VisiTrend/Plot 
menu items in alphabetical order. This second part of the chapter begins 
with a three-part diagram of program flow between menus in each of the 
VisiTrend/Plot subprograms. The sections that follow describe each 
menu item, and identify that item with the subprogram and with the 
specific menu in which the item appears. 

USEFUL FACTS ABOUT PROGRAM OPERATIONS 

• You can load or create up to 645 data points or 16 series in memory. 

• Anyone series can contain up to 150 data points. 

• Up to 16 series can be plotted on the same chart, except for a Pie 
chart which can effectively plot 8 series. 

• A maximum of six legend lines can appear on a multi-series plot. 

• An intersection of the ranges of two or more series must contain at 
least one data point. 

• A union of the ranges of two or more series can contain a maximum of 
150 data points. 

• You can select one dependent variable and up to five series as 
independent variables in a linear multiple regression. 
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• The intersection of ranges in a linear multiple regression must con­
tain at least two more points than the number of independent 
variables, regardless of whether or not a constant is used in the 
regression. 

• An XFORM formula can contain a maximum of 80 characters. 

• A Moveable title can contain up to 37 characters. 

• A Top or any bottom title can contain up to 37 characters. 

• A Side title can contain up to 14 characters. 

• A file name can contain the maximum number of characters allowed 
by DOS (1 to 30); the VisiTrend/Plot program shortens the name to 16 
characters for display. 

• Up to 37 characters can be entered for a series name; however, the 
VisiTrend/Plot program shortens the name to 14 characters for 
display. 

KEYBOARD USAGE 

001-002 

Figure 3-1. The Keyboard 

Most of the keys on the keyboard in Figure 3-1 are self-explanatory. A 
few keys have special uses: 

RETURN selects the item highlighted by the cursor from a menu or 
from a list, and enters data typed at the keyboard. In the 
Text operation, RETURN moves the cursor to the beginning 
of the next line on the screen. 

Space Bar marks (with an asterisk) and unmarks list items when multi­
ple selection is allowed. In a menu, the space bar moves the 
cursor up or down one line. In the Text operation, the 
space bar moves the cursor to the right, erasing text as the 
cursor moves. 
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ESC 

y 

I 

M 

@ 

CTRL 

moves the cursor to the right in a menu line, and down in a 
list; at the end of the list or line, ~ causes the cursor to 
wrap around to the beginning. For Moveable titles, ~ 
moves the title to the right. In the Text operation, ~ moves 
the cursor to the right without disturbing any existing 
characters. 

moves the cursor to the left in a menu line, and up in a list; 
at the beginning of the list or line, ~ causes the cursor to 
wrap around to the end. For Moveable titles, ~ moves the 
title to the left. In the Text operation, ~ moves the cursor to 
the left without disturbing any existing characters. 

corrects errors during data entry by erasing characters to 
the left of the cursor, beginning with the last character 
typed. This key also removes and redisplays the status area 

. when a chart is displayed. 

is an affirmative response to the prompts that verify your 
request to change programs, initialize (format) files, delete 
files, exit the Pie chart shading function, and exit (QUIT) 
the VisiTrend/Plot program. 

moves a Moveable title upward on the screen. 

moves a Moveable title downward on the screen. 

when typed as the last character of a top or bottom title, 
causes that title to be left-justified on the chart. 

is pressed simultaneously with another key as follows: 

CTRL-C interrupts the printing of a chart or list. 

CTRL-Z creates a small-increment dot cursor in the Text 
operation. 

CTRL-O moves the cursor up one line in the Text 
operation. 

CTRL-L moves the cursor down one line in the Text 
operation. 

CTRL-I tabs the cursor five spaces to the right in the Text 
operation. 

CTRL-A changes between upper and lower case letters in 
the Text operation. 

CTRL-B turns onloff bold face in the Text operation. 

CTRL-R turns onloff inverse video in the Text operation. 

CTRL-@ clears the screen in the Text operation. 
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WARNING: NEVER PRESS THE RESET KEY. Pressing RESET will 
usually take you out of the VisiTrend/Plot program. An asterisk (*) or a 
right-bracket 0) prompt appears on the screen. The VisiTrend/Plot pro­
gram diskette and your data diskette can be damaged. If you acciden­
tally press RESET, reload the program as described under LOADING 
THE VISITREND/PLOT PROGRAM in Chapter 1. 

STATUS AREAS 

Figure 3-2 shows the Main, Trend, and Plot subprogram status areas 
and their components. 

Data--­
Disk Drive 
Identifier 

Series 
Name 

Chart 
Type 

018-075/P 

018-076/P 

Figure 3-2. Subprogram Status Areas 
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• The long prompt gives a description of the menu item highlighted by 
the cursor. 

• The cursor highlights a menu item. The highlighted item is selected 
when you press the RETURN key. 

• The data disk drive identifier indicates the drive that contains the 
data diskette. The LOAD, SAVE, FORMAT, and DELETE operations are 
directed to the identified drive. 

W~.~~ .. 'i:Cti~ti~;H~ia.::::·Dls~;:I~· .. ij~~iIecte(I·.·:t~ •. :the, •. ·.co~p~ter .~ila·:rs 
'speqifiea~sthe data.d.i$k,thevolu$9 nu.mberi$· also ideJ:Jtified . 

•• , X' •• " .:". '. '. < : :'". < ~h' • :." •• '.'. '''' :. 'Vj..,':. ~ ":.' ": '"':" .:' : ': '". . : ." ':.:. " .. ' .:- '"'". ". .' .. ". : " " .... . ,.". :', < ", '< 

• The series name shows the selected series or the first of multiple 
selected series (followed by three dots). 

• The chart type shows the type of chart that was last selected. 

• The menu contains the items available for selection. 

• The color codes indicate the plotting color in use (left of the period) 
and the background color in use (right of the period). When multiple 
series are selected, only the first plotting color is shown in the status 
area. 

• The window code indicates that Window mode is in effect, and which 
window is currently active: top (WT), bottom (WB), left (WL), or right 
(WR). 

COLOR CODES 

Table 3-1 lists each VisiTrend/Plot color, the code that appears in the 
Plot status area, and the black-and-white representation of that color. 

Color 

Blackl 
Green 
Violet 
White 1 
Black2 
Orange 
Blue 
White2 

Table 3-1. Color Codes 

Code 

Bl 
GR 
VI 
WI 
B2 
OR 
BL 
W2 
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Black 
Grey 
Grey 
White 
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SERIES NAMING CONVENTIONS 

The VisiTrend/Plot program creates several series that are computed 
from existing series. These computed series are produced by the Trend 
subprogram. The VisiTrend/Plot program uses the name of the source 
series with an extension appended to the end as the name of the new 
series. The extension serves as an identifier of the new series type. Table 
3-2 lists the identifiers generated by the program, and their meaning. 

Identifier 

.Fn 

.Rn 

.Mn 

.S 

.T 

.% 

.-n 

.+n 

.D 

RANGES 

Table 3-2. Series Name Identifiers 

Series Type 

Fitted series 
Residual series 

Moving average 

Smoothed series 

Total series 

Percent change 

Lagging series 

Leading series 

Computed difference 

Where 

n is a program-generated 
number. The number is the 
same for a residual and fitted 
series from the same regression. 

n is the number of periods 
averaged. 

n is the number of periods 
lagging. 

n is the number of periods 
leading. 

Range is normally the period of time covered by a plotted chart. The 
VisiTrend/Plot program plots range against the X-axis (the horizontal 
axis). Although range is usually measured in units of time, range can 
also be reference numbers assigned to series items. The VisiTrend/Plot 
User's Guide treats most ranges as factors of time because most ranges 
are measured as daily, weekly, monthly, quarterly, or yearly. 

A range has two parts: the major range which is usually expressed as 
years, and the minor range known as the period. The period divides the 
range into parts. You can divide the range into any number of parts from 
1 (no division) to 99. Periods are most commonly used to divide a year 
into months (12 parts), quarters (four parts), or weeks (52 parts). 
However, a major range could represent months, weeks, or even days. 
Likewise, the period could represent any division you desire. 

3-6 



APPLE II VISITREN DIPLOT™ ~~~~~s 
REFERENCE 

Calculating the Range 
The VisiTrend/Plot program determines the range before plotting each 

chart by using the date information contained in the selected series. 

The range for a single series is the time span from the start date to the 
end date. The range for multiple series is calculated by the program, and 
depends on the type of chart being plotted. 

The union of selected series ranges is used for Line and Area charts. 
Union means that the start date for the range is the earliest start date from 
among the selected series, and the end date for the range is the latest end 
date from among the selected series. 

The intersection of selected series ranges is used for High-Low-Close, 
Bar, and XY charts. Intersection means that the limits of the range are the 
earliest date and latest date common to all selected series. 

The maximum number of points allowed in a range is 150, and the 
minimum number of points is 2. If you try to draw a chart from several 
series whose combined data points exceed 150, the program displays the 
error message CAN'TI BAD RANGE. 

Figure 3-3 shows how union and intersection apply to two sample 
series. 

Series A Series B 
Range Range 

1973 
1974 
1975 

Union 1i~~-------------1i~f--l,ntersection 
!~r~ _____________ !~Z~ __ _ 
1979 
1980 

!~~!--------------------

Figure 3-3. Example of Union and Intersection of Ranges 

012-010 

These concepts of range do not apply to Pie charts, because a Pie chart 
is a comparison of different series at a single reference point or date­
rather than a comparison of one or more series across different reference 
points or dates. 
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Changing the Range 
The VisiTrend/Plot program automatically determines a range for 

whatever series are being plotted. At times, you may want to expand or 
limit that range. The range you specify must have at least two, but no 
more than 150, data points. At least two data points in the range must be 
present in each of the selected series. 

The RANGE item in the Options menu allows you to change the pro­
gram-calculated range. 

SCALES 

Scale is the scope of values plotted against the Y-axis (vertical axis) of 
a chart. The scale values depend upon the data being plotted. The values 
may be positive, negative, or span zero in either direction. The incre­
mental units (intervals) of the scale may be fractional values, or any 
numbers up to the 38th power. 

Calculating the Scale 
The VisiTrend/Plot program selects a scale of values to include the 

highest and lowest values in the series. This scale is rounded up or down 
to even numeric values. A number of intervals are set to the scale so that, 
whenever possible, round and even numeric labels appear at the tick 
marks. The number of intervals is usually 10, but other appropriate 
numbers occur. 

Normally, the program selects a good set of scale values. Occasion­
ally, the resulting values are un rounded and not well-scaled. When this 
happens, you should use the RESCALE item in the Options menu to create 
more useful Y-axis labels. 

Changing the Scale 
The VisiTrend/Plot program automatically determines a scale for 

whatever series are being plotted. In some circumstances, you may want 
to expand or limit that scale. 

The RESCALE item in the Options menu lets you change the program­
calculated scale values and the number of intervals. To choose the 
number of intervals, subtract the low scale value from the high scale 
value, and determine a number that divides evenly into that difference. 
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When prompted for rescale values and a number ofintervals, you must 
enter the values in decimal format as opposed to exponential format. The 
program converts large and small numbers to exponential notation for 
display purposes, when necessary. Large numbers may be abbreviated 
by the program, and a scaling factor supplied at the top of the Y-axis. 
When a scaling factor (such as THOU) is in effect, values entered for 
rescaling must be complete; for example, you would type 30000, not 30. 

UNDERSTANDING THE INTERPLAY BETWEEN 
SCALE AND RANGE 

When you change the range of a chart, the scale is automatically 
recalculated for the data points within the new range. If you change the 
scale before or after changing the range, the program does not recalcu­
late that scale. 

THE VISITREND/PLOT MENU ITEMS 

This portion of Chapter 3 describes the VisiTrend/Plot menu items in 
alphabetical order. Each item is first identified with the subprogram and 
with the specific menu in which the item appears. 

To help you access the various menu items, the following three-part 
diagram shows the flow between menus in each of the VisiTrend/Plot sub­
programs. Figure 3-4 details the Main subprogram, Figure 3-5 the Trend 
subprogram, and Figure 3-6 the Plot subprogram. 

Note that to access the other two subprograms, you select PLOT or 
TREND from the Main subprogram menu, MAIN or PLOT from the Trend 
subprogram menu, and MAIN or TREND after exiting from the Plot sub­
program menu. 
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Table 
Stats 
Regress 
Format 

Display 

Return 
Print 

Initial Load 

Main 
Subprogram 
(Main Menu) 

Edit 

Jump 
Insert 
Delete 
Specs 

Format 
Print 
Undo 
Edit 

Fill 
Exit 

Figure 3-4. Main Subprogram Flow 

Trend 
Subprogram 
(Trend Menu) 

Figure 3-5. Trend Subprogram Flow 
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Move Avg 
Smooth 
Percent 
Diff 
Lag 
Lead 
Total 
Exit 
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Main 
Subprogram 

--Bar 

Normal LIne I Area I PIe 
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ANAL YZE [Trend subprogram/Trend menu] 

ANALYZE invokes the VisiTrend/Plot analysis operations. These opera­
tions list series contents, calculate and display series statistics, perform 
linear multiple regressions' and trendline forecasting, and format da1a. 
For information on the specific operations, see TABLE, STATS, REGRESS, 
and FORMAT later in this chapter. 

AREA [Plot subprogram/Select menu] 

AREA specifies that an Area chart is to be plotted. You choose one or 
more series from a list. When choosing multiple series, all series must 
have the same period. When multiple series are plotted, each series is 
drawn over the previous series. You should select the series with the 
largest values first, then the next largest, etc. If the series have a mixture 
of values, you will not get full detail for the series. In this situation, use 
OVERLAY to plot a Line chart of one or more of the series. All area charts 
are plotted from the base line; they are not stacked. 

ARITH [Main subprogram/Fill menu] 
[Trend subprogram/Fill menu] 

ARITH inserts new data into the series being edited, beginning at the 
location of the cursor. The new data is an arithmetic progression. You 
are prompted for the number of points to be generated. The number can 
be any value that will not cause the total series to exceed the maximum of 
150 points, or 645 points in memory. Next, you are prompted for the fac­
tor by which each preceding point is to be increased or decreased. The 
new data points are inserted immediately following the data point cur­
rently highlighted by the cursor. 

BACKGR [Plot subprogram/Options menu] 

BACKGR sets the background color of a plot. BACKGR can be used 
with all chart types except a Pie chart. This item displays the Color 
menu, offering a selection of eight colors. With black-and-white display 
monitors, only three backgrounds are available; all non-white and non­
black colors produce the same grey halftone on the black-and-white 
screen. 

The program displays a code for the color in the lower-right corner of 
the status area. Two colors are listed; the first is the plotting color and the 
second is the background color. 
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Any background color is retained until you explicitly change it with 
BACKGR, or until you reset the color to the program default with NEW. 

When you change background color, the VisiTrend/Plot program 
automatically changes the plotting color to avoid duplicate colors, and to 
draw a clear and readable plot. Table 3-3 lists the plotting colors that the 
program automatically selects with your choice of background color. 
You can, of course, change the plotting color after changing the 
background color. 

The table shows the plotting colors for both single-series plots and 
multiple-series plots. If you select and overlay a single series, the series 
1 color is used. If you select more than two series, the colors repeat; that 
is, the third series is plotted in the same color as the first series. 

NOTE: If you want three different colors for multiple series charts, 
you must select the first plotting color with the COLOR menu item. See 
COLOR for the colors used. 

Table 3-3. Plotting Colors Generated by BACKGR 

Line and YX Area and Bar* 

Selected First Second First Second 
Background Color Color Color Color 
Color (and 3rd) (and 4th) (and 3rd) (and 4th) 

Black1 White White White Green 
Green Black White White Black 
Voilet Black White White Black 
White1 Black Black Black Green 
Black2 White Orange White Blue 
Orange Black White White Black 
Blue Black White White Black 
White2 Black Blue Black Blue 

* Stacked bar charts may be slightly offset from one series to the next, due to the manner in 
which the Apple II handles color display. 

3-13 



VISITRENDIPLOT™ ~tT~~S APPLE II 
REFERENCE 

BAR [Plot subprogram/Select menu] 

BAR specifies that a Bar chart is to be plotted. You choose one or more 
series from the list(s). With NORMAL width bars in effect, you can 
choose multiple series from the same list. In this case, the bars for the 
various series are stacked on top of each other. The first series chosen is 
plotted on the base line; and subsequent series, in order, are plotted 
from the top of the existing bars. 

Bar charts offer you the choice of full-width (NORMAL) bars centered 
on the tick marks, or half-width bars located to the LEFT or RIGHT of the 
tick marks. Half-width bars are normally used to draw comparison 
charts. A very slight overlap might exist between the left and right bars 
of a comparative chart. A slight offset might also occur at the divisions of 
stacked-bar charts. 

Negative values can be plotted for Bar charts, but no zero line is drawn 
on the screen. 

You can display the bars for a Bar chart in one of three formats using 
the FORMAT menu item: solid, outlined, or shaded (outline plus horizon­
tal stripes). 

BOLD [Plot subprogram/Title menu] 

BOLD displays the subject title in bold characters. The alternatives to 
bold titles are normal or inverse video titles. All chart titles can be 
displayed in the bold typeface. 

BOTH [Plot subprogram/Bar, Format, Grid, and 
Unlabel menus] 

BOTH specifies that both of the subject items are to be affected. 

• In the Bar menu, BOTH means that a left bar and right bar will be plot­
ted, in contrasting colors, at each major tick mark. 

• In the Format menu (Line and XY charts only), BOTH means that plot­
ting symbols and lines are to be drawn on the chart. 

• In the Grid menu, BOTH means that horizontal and vertical grid lines 
are to be drawn on the chart. 

• In the Unlabel menu, BOTH means that horizontal and vertical labels 
are to be erased from the chart. 
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CANCEL [Plot subprogram/ data-off-scale condition] 
[Plot subprogram/Moveable title Typeface menu] 
[Plot subprogram/Exit menu] 

When the message DATA OFF SCALE, CHOOSE ACTION appears during 
an attempted plot, you may select CANCEL. This choice cancels the PLOT or 
OVERLAY request, and returns to the Plot menu. The alternate choices are 
PROCEED and, in an Overlay operation, REDRAW. 

In the Typeface menu for a Moveable title, CANCEL erases the title and 
returns to the Title menu. 

In the Exit menu, CANCEL returns to the Plot menu instead of exiting from 
the Plot subprogram. 

CLEAR [Main subprogram/Main menu] 
[Trend subprogram/Main menu] 
[Plot subprogram/Range menu] 

In the Main and Trend subprograms, CLEAR removes the selected series 
from the computer memory. You can select ail, none, or any number of 
specific series to be removed. This operation does not affect the files stored 
on diskette. 

In the Plot subprogram, CLEAR disregards the range values you 
previously SET, and uses the range values stored with the series. This 
item has no effect if you did not previously set a range. 

COLOR [Plot subprogram/Options menu] 

COLOR changes the plotting color used to draw a chart. This item 
displays a Color menu with a selection of eight colors. With black-and­
white monitors, only three colors are available; all non-white and non­
black colors produce the same halftone grey on the black-and-white 
screen. 

A code for the chosen color is displayed in the lower-right corner of 
the status area. Two color codes are shown; the first is the plotting color 
and the second is the background color. 

The program automatically changes the plotting color when the 
background color is changed. See BACKGR for a listing of the plotting 
colors generated when BACKGR is used. Note that only two plotting 
colors are used when you choose a BACKGR color. 
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Table 3-4 lists the colors used for second and third selected series 
when you choose the first plotting color with the COLOR menu item­
after or without selecting a BACKGR color. 

These multiple plotting colors only apply to multiple selected series 
that you plot or overlay simultaneously. The sequence is not carried over 
between plotting and overlaying. This means that when you do an 
overlay, the color sequence for the overlay(s) starts over with the first 
color - regardless of the number of series already plotted. 

Selected 
Color 
(and 4th) 

Blackl 
Green 
Violet 
White 1 
Black2 
Orange 
Blue 
White2 

Table 3-4. Plotting Colors Generated by COLOR 

Second Third 
Color Color 
(and 5th) (and 6th) 

Green Violet 
Violet White 
Green White 
Violet Green 
Orange Blue 
Blue White 
Orange White 
Blue Orange 

CONTINUE [Main subprogram/various menus] 
[Trend subprogram/various menus] 

CONTINUE appears in several operations where data is displayed on 
the screen. If you have more data to be displayed than can fit on one 
screen, CONTINUE displays the next screenful. When the last screen is 
displayed, the status area prompts you to press any key. Press ESC to 
return to the Edit menu. 

DEFAULT [Plot subprogram/Color and Backgr menus] 
[Plot subprogram/Print menu] 

DEFAULT in the Color and Backgr menus returns the background and/or 
plotting colors for a chart to the initial program-selected colors: Blackl 
and Whitel (BloWl). If you had not previously changed these colors, 
DEFAULT has no effect. When used with the BACKGR menu item, DEFAULT 
changes both the background and the plotting colors. With the COLOR 
menu item, DEFAULT changes only the plotting color, to Whitel (WI). 

DEFAULT in the Print menu allows you to change the currently selected 
printer driver and the printer slot. The change is made by selecting a dif­
ferent driver and slot from the displayed list. You can also specify 
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automatic line feeds. The new selections remain in effect throughout the 
current VisiTrend/Plot program session and all subsequent 
VisiT rend/Plot program sessions. The driver/slot default can be changed 
at any time by selecting DEFAULT again, or by selecting DRIVER (which 
changes the driver/slot for the current session only). 

DELETE [Main subprogram/Edit menu] 
[Trend subprogram/Edit menu] 
[Main subprogram/Files menu] 

In the Edit menus of both the Main and Trend subprograms, DELETE 
removes selected data points from the current series. The range of the 
deletion begins at the entry highlighted by the cursor when DELETE is 
selected, and ends at the entry to which you move the cursor. The range 
is displayed in the status area, and changes as you move the cursor. You 
can move the cursor up or down in the series. Pressing RETURN deletes 
all the points in the range, inclusively. If you move the cursor beyond the 
end of the series, the DELETE operation is cancelled. DELETE is also 
cancelled if you press ESC. 

In the Files menu, DELETE erases a selected file from the data diskette. 
You select the file from the displayed list. Before a file is erased, the pro­
gram prompts you to press Y TO CONFIRM the permanent deletion. 
Pressing either N or ESC cancels the deletion. An error message is 
displayed if the data diskette has a write-protect tab on it. 

DEVICE [Main subprogram/Main menu] 
[Plot subprogram/Screen menu] 

DEVICE is only meaningful when you have more than two disk drives 
connected to the computer. DEVICE changes the drive and slot iden­
tifiers assigned to the disk drive where you have inserted the data 
diskette. The identifier of the currently assigned data disk drive (with 
related slot number) is displayed in the status area. The remainder of the 
screen contains a list of available drive/slot numbers. You change the 
current assignment by moving the cursor to the desired entry in the list, 
and pressing RETURN. A change of drive remains in effect throughout 
the current session only. The data disk drive identifier reverts to 2 the 
next time the program is loaded. 
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Make sure your disk drives are connected to the computer as shown in 
Figures 3-7 or 3-8, whichever is appropriate. 

Drive 1 
Program Diskette 

" I 
Slot 6 

I , 

\..,----",/ 
Slot 5, 4, 3, 2, 1 

I 
018-004 

Figure 3-7. Connecting Floppy Disk Drives Only 

Corvus Hard Disk Drive: 

Data Diskette '-, ____ ",1 
Slot 6 

1 

First Two Floppy Disk Drives: 
Drive 1 
Program Diskette " ~ 

Slot 4 , " 
Other Floppy Disk Drives: 

" I 
Slot 5, 3, 2, 1 , , 

018-005 

Figure 3-8. Connecting Floppy Disk Drives and Corvus Hard Disk Drive 
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DIF [Main subprogram/Save menu] 

DIF (data interchange format) specifies that the series you are saving will 
be stored in a DIF file. Data in this format can be used with other VisiCorp 
products, such as the VisiCalc program. The alternative to DIF is the 
NORMAL format, which is usable only by the VisiTrendlPlot program. 

Refer to Appendix D for more information on DIF files. 

DIFF [Trend subprogram/Function menu] 

The DIFF (Difference) function computes the difference between adja­
cent data points in the source series. When DIFF is selected, a list of all 
series currently in memory is displayed. From that list you select one 
series at a time for a DIFF operation. Once the difference between adja­
cent data points in the selected series is computed, the program creates a 
new series containing these computed differences. The new series has 
the same name as the source series, plus the extension .D that serves as 
an identifier. 

DISPLAY [Main subprogram/Main menu] 
[Trend subprogram/Trend menu] 

DISPLAY lists the data series that are currently in memory. The display 
includes the series name, period, start date, end date, and number of 
data points in each series. After the display appears on the screen, the 
status area prompts you with RETURN and PRINT. Selecting RETURN 
returns to the Main or Trend menu, as appropriate. Selecting PRINT 
prints the entire list of series in the same format that is displayed on the 
screen, and then returns to the menu. The program also automatically 
displays the same display list after each LOAD and CLEAR operation. 

DRIVER [Plot subprogram/Print menu] 

DRIVER allows you to change the currently selected printer driver and 
slot number for the current VisiTrend/Plot session only. The change is 
made by selecting a different driver and slot from the displayed list. You 
can also specify automatic line feeds. The new selections remain in effect 
during the current session, until you select DRIVER again, or select 
DEFAULT. 
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EDIT invokes the Edit operation of the VisiTrend/Plot program. You are 
prompted to select a series from those currently in memory or to create a 
new series. When creating a new series, you are prompted for the name, 
period, starting date, and first data point. See the following Edit 
commands: 

DELETE 
FILL 
FORMAT 
INSERT 

JUMP 
PRINT 
SPECS 
UNDO 

EXIT [Main, Trend, and Plot subprograms/ 
various menus] 

EX!T leaves the current menu without performing an operation. EXIT 
either returns to a preceding menu, or loads another subprogram. 

FILES [Main subprogram/Main menu] 

FILES offers you two file management operations: to FORMAT a diskette 
so that it is prepared to accept data, or to DELETE a data file or .PIX file 
permanently from the data diskette. A file to be deleted is selected from 
the displayed list(s) of files currently in memory. Either operation can be 
cancelled by pressing ESC. 

FILL [Main subprogram/Edit menu] 
[Trend subprogram/Edit menu] 

FILL lets you insert values into the middle of a series, or direct the pro­
gram to interpolate missing values between two known values. Values 
can be inserted in either an arithmetic or geometric progression. You are 
prompted for the number of values and a factor by which to increase or 
decrease the series values. See ARITH, GEOMET, INSERT, and INTERP for 
more information. 

You can also select another entire series from a displayed list, and insert 
that series into the series being edited. See SERIES for more information. 

In all cases, the new data is inserted following the item currently 
highlighted by the cursor. 
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FIRST [Plot subprogram/Title menu] 

FIRST, like SECOND and THIRD, specifies a title line to be entered at the 
bottom of a charlo FIRST specifies the first of the three possible bottom titles. 
Up to 37 characters are allowed on any bottom title line. The title is 
centered across the bottom of the chart. If the @ symbol is typed as the last 
character in the title, the title is left-justified. You can choose bold, nor­
mal, or inverse video typeface for any title. Bottom titles write over any 
legend occupying the same line. 

FIX [Plot subprogram/Moveable title Typeface menu] 

FIX appears in the Typeface menu for Moveable titles. It is used to turn a 
Moveable title into a fixed title, in its current position on the chart. If you 
select FIX without first choosing a typeface, the title is fixed in NORMAL 
typeface, by default. 

FORMAT [Main subprogram/Edit menu] 
[Trend subprogram/Edit menu] 
[Trend subprogram/Analyze menu] 

FORMAT in the Edit and Analyze menus lets you specify how data is to 
be displayed on the screen. By default, the VisiTrend/Plot program 
displays data in the floating decimal-point format. You can specify fixed 
format display by typing a number from 0 to 6 for the precision (number of 
digits to the right of the decimal point). You can also select a number from 
6 to 15 for the column width (the total number of characters used to display 
the number). 

Resulting numbers that are displayed as a series of "greater than" sym­
bols (» are either too large for the column width, or are numbers in 
exponential notation with a chosen fixed format. Exponential numbers can 
only be displayed in floating-decimal format. 

You cannot enter values in exponential notation (Such as lE+ .09). The 
program converts numbers less than or equal to 0.001, and numbers greater 
than 9 digits to the left of the decimal point, to exponential notation. 
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FORMA T [Main subprogram/Files menu] 

FORMAT in the Files menu allows you to format (initialize) a diskette so 
that it is prepared to accept data. You are prompted to insert the data 
diskette in the disk drive. You can cancel the Format operation even after 
a diskette has been inserted, by pressing ESC. If the diskette is already 
initialized (and is not blank), a message appears in the status area. At 
that point, you can press Y to continue, or press ESC to cancel FORMAT. 
Be advised that the Format operation destroys all the data previously on 
the data diskette. 

FORMAT [Plot subprogram/Options menu] 

FORMAT in the Options menu lets you specify how a Line, Bar, or XY 
chart will be displayed. This item is not available for Area, Pie, and 
High-Low-Close charts. If FORMAT is chosen for an unsupported chart 
type, the message CAN'TI NO OPTION HERE is displayed. 

The formatting choices displayed with a Bar chart are different that the 
ones displayed with a Line or XY chart. For a Line or XY chart, the 
options are: symbols only, lines only, points only, or both symbols and 
lines. For a Bar chart, the options are: solid, shaded, or outlined bars. 

A chart format is retained until you do one of the following: select FOR­
MAT again, plot a different type of chart, or choose the NEW menu item. 

FUNCTION [Trend subprogram/Trend menu] 

FUNCTION computes one of seven functions on a specified series. 
These calculations produce the following results from series data: the 
moving average, exponential smoothing, the percent of change in series 
values, differences between adjacent data points, new series with a 
specified lead or lag from an existing series, and a new series with 
cumulative totals. For further information on these specific functions, see 
MOVE AVG, SMOOTH, PERCENT, DIFF, LAG, LEAD, and TOTAL. 

GEOMET [Main subprogram/Fill menu] 
[Trend subprogram/Fill menu] 

GEOMET lets you insert new data into the current series in a geometric 
progression. You are prompted for the number of data points to be 
generated. The number can be any value that will not cause the total 
series to exceed the maximum of 150 points, or 645 points in memory. 
Next, you are prompted for the factor by which each preceding point is 
to be multiplied. The data points are inserted immediately following the 
data point currently indicated by the cursor. 
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GRID [Plot subprogram/Options menu] 

GRID draws grid lines for all major (labeled) tick marks on the cur­
rently displayed chart. The operation is valid for all charts except Pie 
charts. GRID offers the choice of vertical, horizontal, or both vertical and 
horizontal grid lines. You can erase grid lines by selecting them a second 
time. For example, if you select horizontal grid lines while horizontal 
grid lines are displayed, you erase those lines. You can erase horizontal, 
vertical, or both. You cannot invoke this option until a chart is displayed. 

HI-LO-CL [Plot subprogram/Select menu] 

H I-LO-CL lets you draw a High-Low-Close chart. You are prompted to 
select the high series, the low series, and the close series from displayed 
lists of the series in memory. When prompted for the close series, you 
can select NONE. You can specify the high and low series in either 
order; the program automatically uses the series with the highest values 
to plot. High-Low-Close charts are displayed as a series of vertical lines 
connecting the high and low values. The vertical lines are not connected 
from time period to time period. 

A High-Low-Close chart can only be generated with one high, one low, 
and one close series; however, you can overlay charts to display multiple 
series. A High-Low-Close chart that is overlaid with a Line chart, effec­
tively emphasizes the high, low, or close values; since the Line chart is 
plotted with both symbols and lines. 

HORIZ [Plot subprogram/Grid, Unlabel. 
and Window menus] 

HORIZ performs differently in each menu where it appears. 

In the Grid menu, HORIZ draws horizontal grid lines on the displayed 
chart. If horizontal grid lines already exist, this item is used to erase them. 

In the Un label menu, HORIZ erases the range labels (X-axis). 

In the Window menu, HORIZ divides the screen into top and bottom win­
dows, rather than vertical left and right windows. 
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INSERT lets you insert one or more new data points anywhere within the 
selected series. The first new point is inserted immediately preceding the 
data point at the current cursor location. Existing points later in the series 
are pushed ahead to the next year and/or period. The last point in the 
series is given a new end date one period beyond the old end date. Up to 
149 values can be inserted in a series. You can perform multiple insertions 
by pressing - after a value; the cursor automatically moves to the fol­
lowing point and creates a space for the next value. You press RETURN to 
complete the insertion of new data points. 

INTERP [Main subprogram/Fill menu] 
[Trend subprogram/Fill menu] 

INTERP performs a linear interpolation of series values, beginning at the 
first zero value and continuing to the first nonzero value. The cursor must 
be highlighting the first zero value before you invoke this operation. 

If the value at the cursor is not zero, or if there is no nonzero value later 
in the series, a beep cancels the operation. The INTERP operation gets the 
starting point from the preceding period, and the ending point from the 
next nonzero value. All points in between are then linearly interpolated. 

INVERSE [Plot subprogram/Title Typeface menus] 

INVERSE appears in the Typeface menus for both fixed and Moveable 
titles. The item is used to display a chart title in inverse video. Other 
choices in the same menu are NORMAL and BOLD typefaces. 

JUMP [Main subprogram/Edit menu] 
[Trend subprogram/Edit menu] 

JUMP letssou move the cursor to any entry in the displayed series. You 
can either move to a specific date/period by typing that entry when 
prompted; or you can move the cursor to the beginning or end of the series 
with the arrow keys. The - key jumps the cursor to the end of the series 
and the +--- key jumps the cursor to the beginning. 
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LAG [Trend subprogram/Function menu] 

The LAG function creates a new series that lags the source series by a 
specified number of periods. The lagging series has the same values as the 
source series, but they are shifted to the future a specified number of 
periods. In effect, lagging a series by one period adds one to each date. 

The program gives the lagging series the same name as the source 
series, plus an extension in the form ". -nil that serves as an identifier. 
n is the number of periods of lag specified. For example, a series that lags 
the series PE RATIO by 2 periods is given the name PE RATIO. - 2. Figure 
3-9 shows the effect of the LAG function. You are prompted for the source 
series and for the number of periods to be lagged. The number of periods 
must not be more than exist in the source series. 

100 400 500 
Source 

... 1IiIIP" .......... ~-........ IIiIIP" ..... "-If' ..... Series 

Lag ... _ ..... _--" __ "'-_ ..... ____ Series 

I Feb I Mar I Apr I May I Jun 

Figure 3-9. Lag Function 
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LEAD [Trend subprogram/Function menu] 

The LEAD function creates a new series that leads the source series by a 
specified number of periods. The leading series has the same values as the 
source series, but they are shifted to the past a specified number of 
periods. In effect, leading a series by one period subtracts one from each 
date. 

The program gives the leading series the same name as the source 
series, plus an extension in the form". + nil that serves as an identIfier. n is 
the number of periods of lead specified. For example, a series that leads 
the series PE RATIO by 2 periods is given the name PE RATIO. + 2. Figure 
3-10 shows the effect of the LEAD function. You are prompted for the 
source series and for the number of periods to be led. The number of 
periods must not be more than exist in the source series. 

100 

Dec 

I Jan I Feb I Mar I Apr I May 

Source 
..... ,..-"""-..,... ...... -,. ........ --,_..L.-,--..... Series 

Feb Mar Apr 

Figure 3-10. Lead Function 

LEFT [Plot subprogram/Bar menu] 

012-007 

LEFT specifies that half-width bars are to be drawn on a Bar chart, and 
placed to the left of the tick marks. LEFT, along with RIGHT, is normally 
used for comparative Bar charts. 
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LEGEND [Plot subprogram/Title menu] 

LEGEND redisplays the chart legend after it has been erased by any bot­
tom titles. With a Pie chart, this item works differently: LEGEND erases the 
Pie chart legend and the pie segment labels. Once a Pie chart legend is 
erased, that legend cannot be redisplayed without replotting the Pie chart. 

Every legend line (except for a Pie chart) contains a chart type code, 
plotting symbol for the corresponding series, and the name of the cor­
responding series. The chart type codes are as follows: 

A - Area chart 

B Full Bar chart 

BL - Bar left chart 

BR - Bar right chart 

CL - Close data on a High-Low-Chart 

HI High data on a High-Low-Close chart 

L Line chart 

LO - Low data on a High-Low-Close chart 

X X-axis on an XY chart 

Y Y -axis on an XY chart 

LINE [Plot subprogram/Select menu] 

LINE specifies that a Line chart is to be drawn. You choose one or more 
series from a displayed list of the series in memory. When selecting 
multiple series, all series must have the same period. The program draws 
each selected series with a different symbol. If more than six series are 
selected, the first six symbols are reused. A maximum of the first six 
selected series are listed in the legend. The legend lists the names of the 
first six plotted series, and the symbol used for each. 

LINES [Plot subprogram/Format menu] 

LINES specifies that a Line or XY chart is to be drawn with connecting 
lines and without symbols. This option is only valid for Line and XY 
charts. . 
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LOAD [Main subprogram/Main menu] 

LOAD in the Main menu places a copy of a file (with all the series it 
contains) from the data diskette into the computer memory. You are 
prompted to select a file name from the directory of the current data 
diskette. The DEVICE item is used to change the drive/slot for the data 
diskette. 

When the out-of-room condition is about to occur, a partial load is per­
formed, if possible. The program loads as many series from the file as can 
fit in memory. The partial load only occurs with files stored in the normal 
VisiTrend/Plot format. Partial loads are not done with files stored in the 
DIF format. 

LOAD [Plot subprogram/Screen menu] 

LOAD in the Screen menu displays a list of all screen image (.PIX) files 
saved on the data diskette. When you select a .PIX file, the image saved 
in the file is drawn on the screen. A .PIX file cannot be altered with the 
normal Options menu items; however, all the features of the Text opera­
tion are available with .PIX files. See TEXT later in this chapter for details. 

MAIN [Plot subprogram/Exit menu] 
[Main subprogram/Files menu] 
[Trend subprogram/Trend menu] 

MAIN exits the Plot subprogram, Trend subprogram, or Files menu, and 
displays the Main menu. Series in memory are not lost in transit. 

MOVEABLE [Plot subprogram/Title menu] 

MOVEABLE is used to place a title anywhere on a chart. A Moveable title 
can contain up to 37 characters, and is initially displayed at the left center 
of the chart. There is no limit to the number of Moveable titles you can put 
on a chart. 

As the name implies, the title can be moved to any location on the 
screen. Movement is controlled by the I, M, +-, and ~ keys. The relative 
position of these keys on the keyboard suggests the directions in which 
they move the title. 

Each time you press a direction key, the title moves in the specified direc­
tion, until the title runs into the edge of the chart. When the edge is 
reached, a beep sounds until the key is released or the direction is reversed. 
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The number keys, 1 through 9, change the distance of each movement. 
The higher the number, the farther the title will move when a direction 
key is pressed. Initial movement is approximately at the 5 rate. 

When RETURN is pressed after positioning the title, a Moveable title 
Typeface menu appears. This menu is identical to the fixed title Typeface 
menu, with the addition of two items, CANCEL and FIX. 

CANCEL erases the Moveable title from the chart, and returns you to 
the Title menu. Note: if a Moveable title is covering any bars, lines or 
characters when you select CANCEL, a permanent black rectangle 
remains on the screen. To avoid this, move the title into an open black 
area of the screen before you display the Typeface menu to select 
CANCEL. 

Selecting FIX fixes the title in its current location, then returns you to 
the Title menu. If FIX is selected without first selecting a typeface, the 
title is displayed in NORMAL typeface by default. 

After a title is fixed in place, it can be erased by a mask created with 
the MOVEABLE title operation, or with the TEXT operation in the Plot 
menu. A mask consists of blank spaces bounded by periods. When a 
mask is positioned over any existing characters, and fixed in place, that 
portion of the chart is erased. 

MOVE AVG [Trend subprogram/Function menu] 

The MOVE A VG function calculates the moving average of a specified 
number of points within a selected series. The function prompts you to 
select the source series from a displayed list, and to specify the number 
of periods over which the moving average is to be computed. The 
number of periods must be between 1 and the number of data points in 
the source series. 

The program creates a new series to contain the moving average, and 
gives the new series the same name as the source series, plus and exten­
sion in the form \\ .Mn". n is the number of periods over which the 
average is calculated. For example, if you specify a moving average over 
three periods for the DIVIDENDS series, the new series is named 
DIVIDENDS.M3. 

The VisiTrend/Plot program uses the N + 1 method of calculating 
moving average. Series can be converted to the N or to the Centered 
Moving Average methods by following the steps described in the fol­
lowing paragraphs. Figures 3-11 through 3-13 show a source series and a 
moving average series over three periods, with each method of 
calculating moving average. 
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1970 1971 1972 1973 1974 1975 1976 I 

Source 

N + 1 
Moving Average 

"-_-'-_--' __ ...... _....1 Over 3 Periods 003-003 

Figure 3-11. N + 1 Moving Average Method 

Converting to an N Moving Average 
The N moving average method locates the first point of the moving 

average series at the last point of the periods being averaged. To convert 
the VisiTrend/Plot N + 1 moving average to an N moving average, follow 
these steps: 

1. Perform the N + 1 moving average for the desired number of periods. 
(Review the section "Computing Moving Average" in Lesson Four, if 
necessary) . 

2. Move the Mn moving average series back one period, with the EDIT 
operation. Select the moving average series from the displayed list. 

3. Select SPECS from the Edit menu; then select START. When prompted 
for the new start date, specify a date one period earlier than the cur­
rent start date. For example, if the start date is 1967, change it to 
1966; if the start date is 1966 period 4, change it to 1966 period 3. 

The N + 1 moving average series has now been converted to the N mov­
ing average series, and is displayed on the screen. 

You can also shift the N + 1 moving average series with the LEAD 
function. 
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N Moving Average 
~_-'-_"""' __ "--_'" Over 3 Periods 003-004 

Figure 3-12. N Moving Average Method 

Converting to a Centered Moving Average 

The Centered Moving Average method locates the first point of the 
moving average series at the center of the periods being averaged. To 
convert the VisiTrend/Plot N + 1 moving average to a centered moving 
average, follow the procedure below that applies to the number of 
periods in the series (odd or even). 

• Odd Number of Periods 

If the N + 1 moving average is over an odd number of periods (p), the 
generated series must be moved back, with the LEAD function, to the 
middle of the number of periods being averaged. In other words, the 
N + 1 moving average series must be moved backward (p + 1)/2 
periods, where p is the number of periods averaged. 

You can select ANALYZE, then TABLE, to display the averaged series 
after the conversion. 

• Even Number of Periods 

When the number of periods being averaged (p) is even, the conver­
sion to a centered moving average is more complex. Follow these 
steps: 

1. Perform a p period N + 1 moving average. (Review the section 
"Computing Moving Average" in Lesson Four, if necessary). 

2. Perform a 2 period N + 1 moving average on the series resulting 
from step 1. 
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3. With the LEAD function, move the series resulting from step 2 
backward in time by (p/2) + 2 periods, where p is the number of 
periods averaged in step 1. 

4. You can select ANALYZE, then TABLE, to display the averaged 
series after the conversion. 

1970 I 1971 1972 1973 1974 1975 

. I 

Centered Moving Average (over an odd number of periods) 

1971 I 1972 I 1973 I 1974 

..... -~--

Centered Moving Average 
(over an even number of periods) 003·005 

Figure 3-13. Centered Moving Average Method 
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NAME [Main subprogram/Specs menu] 
[Trend subprogram/Specs menu] 

NAME is used to change the name of the series being edited. You are 
prompted for the new name, and the change appears immediately at the 
top of the displayed series. 

NEW [Plot subprogram/Plot menu] 

NEW clears the screen and resets all options to the program defaults, 
including the plotting and background colors. NEW returns the program 
to the Plot menu, and cancels the [SAME] entry in the series list. If two 
windows are set, this item returns to single window operation. 

NONE [Plot subprogram/various menus] 

NONE lets you exit a menu without making a selection. NONE usually 
returns to the menu from which you called the current menu. 

NORMAL [Plot subprogram/Typeface menus] 
[Plot subprogram/Bar menu] 
[Main subprogram/Save menu] 

In the Typeface menus for both fixed and Moveable titles, NORMAL is 
used to display the subject title in normal typeface, instead of bold or 
inverse. If FIX is chosen without a typeface for a Moveable title, NORMAL 
is in effect by default. 

\ 

In the Bar menu, NORMAL specifies that a Bar chart is to be drawn 
with full-width bars centered on the tick marks. 

In the Save menu, NORMAL stores a series in the normal 
VisiTrend/Plot program data format, instead of the DIF format. In the 
normal format, the data can only be used with the VisiTrend/Plot pro­
gram. This NORMAL internal data format is described in Appendix C. 

OPTIONS [Plot subprogram/Plot menu] 

OPTIONS displays the Options menu from which you can change cer­
tain plotting and formatting values such as range, scale, color, 
background, and format; or add titles to a chart. For more information 
see TITLE, RANGE, FORMAT, GRID, UNLABEL, RESCi\LE, COLOR, and 
BACKGR. 
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OVERLAY [Plot subprogram/Plot menu] 

OVERLAY is used to plot charts on top of existing charts. Overlaying is 
different from PLOT which erases any existing charts before plotting new 
ones. Thus, if you follow an Overlay operation with a Plot operation, only 
the series selected with the last PLOT is/are drawn. 

OVERLAY does not compute range or scale values; the existing values 
of the displayed chart are used. If the chart to be overlaid does not fit in 
the existing range and scale, the program offers you the choice of 
overlaying on the existing scale (PROCEED) or overlaying on a new scale 
(REDRAW). 

You must PLOT at least one series before you can use OVERLAY for a 
second and subsequent series. Any overlaid chart must have the same 
period as the existing chart(s). You cannot change the RANGE or 
BACKGR between a PLOT and an OVERLAY. 

You can overlay all chart types except Pie charts. You can also mix 
chart types in overlay operations, with the exception of Pie and XY 
charts. 

Note that although a maximum of 16 series can be drawn on the same 
chart, you must use PLOT for up to the first six series, then use OVERLAY 
for up to the remaining number of series (in groups of no more than six 
series at a time). After the first six series have been plotted, the legend 
area is full. Subsequent Overlay operations draw the chart lines, but pro­
duce the warning message CANT! LEGEND FULL. This message is simply 
a notice that the program can display no more legend lines. The overlay 
just specified, and subsequent overlays, are drawn without legend lines. 

PER [Main subprogram/Specs menu] 
[Trend subprogram/Specs menu] 

PER is used to change the periodicity of the chart being edited. The 
current period is displayed, and you are prompted for a new period. 
Valid periods are 1 through 99. When a periodicity other than 1 is 
specified, you are also prompted for the first period of the starting year. 
A series can begin at any period in its starting year. When you specify a 
new periodicity , the currently displayed series is erased and redisplayed 
with the new periodicity. The current beginning date is retained. 

The most common periods are 1 (yearly), 2 (semi-annually), 4 
(quarterly), 12 (monthly), and 52 (weekly). Note that when a series with a 
period of 12 is plotted, the first X-axis' tick mark is labeled with the year (or 
reference point), then the remaining 11 tick marks are labeled for those 
months of the year with F M A M J J A SON D. 
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PERCENT [Trend subprogram/Function menu] 

The PERCENT function calculates the percent of change between suc­
cessive points in a selected series, and creates a new series containing the 
percent-change data. The program gives the new series the same name as 
the source series, plus an extension in the form \\. %" that serves as an 
identifier. For example, if you execute the PERCENT function on the series 
named EARNINGS, the program generates the series EARNINGS. % for 
the new data. 

The new series has the same period as the source series, and a start date 
one period later than the source series. If the source series has the range 
1971 through 1980 and a period of 1, the percent-change series has the 
range 1972 through 1980. 

PIE [Plot subprogram/Select menu] 

PIE specifies that a Pie chart is to be drawn. A Pie chart is a circle that is 
divided into segments. The size of each segment is determined by the ratio 
of the segment value to the sum of all the data values. 

An individual Pie chart effectively compares the values of from two to 
eight series at a specified date or reference number. It does not compare 
the different values in a single series. If you plot a Pie chart for a single 
series, the resulting chart is an undivided circle, and the single series 
represents 100% of the chart. 

In a Pie chart, the segments are drawn in a clockwise direction begin­
ning at the 3 o'clock position. You are prompted to select all the series 
from a displayed list. Each selected series must have a value for the 
specified year or reference point, and all selected series must have the 
same period. 

Segment labels around the chart correspond to lines in the legend. 
The legend is boxed to the right of the chart, and contains each label, 
series name, and relative percent of the total. The date/reference point 
and periodicity of the data is displayed at the bottom of the legend. 
Because of rounding, the percentages listed in the legend may not add 
up to 100%. Series that have very small relative values may produce 
overlapping segment labels around the chart. .If this occurs, you can 
change the order in which you select the series, so that small segments 
are not side-by-side on the chart. 

Once the Pie chart has been drawn, you press RETURN to display the 
shading prompt. You may shade any individual segment(s) or none at all. 
The program displays the same menu as generated by the COLOR item 
in the Options menu. 
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NOTE: Because of the manner in which the Apple II handles color 
display, segment divisions may be distorted if you select certain colors 
for adjacent segments. Refer to the colors listed in Table 3-4, earlier in 
this chapter, for compatible color sequences in a Pie chart. For example, 
three adjacent segments can have the colors violet, green, and white. 

After you confirm that all desired shading is completed, the Pie chart 
Options menu is displayed. The items in this menu let you add text to the 
chart, save the chart on a diskette file (or load another chart), print the 
chart on the printer, and add titles to the chart. 

If you select TITLES, all the normal fixed and moveable titling capabilities 
apply, with the exception of the LEGEND item. For Pie charts only, this 
item is used to erase the legend. When you have completed all titling, you 
EXIT back to the Pie Chart Options menu. 

PLOT [Main subprogram/Main menu] 
[Trend subprogram/Trend menu] 
[Plot subprogram/Plot menu] 

PLOT in the Main and Trend menus exits the current program and loads 
the Plot subprogram. Ser+es in memory are not lost in transit. 

t 

PLOT in the Plot menu allows you to draw a chart of the currently­
selected data series, according to the current options. PLOT erases an 
existing chart before it draws another one. After the chart is drawn, press­
ing ESC returns the Plot menu to the screen. 

Note that although a maximum of 16 series can be drawn on the same 
chart, you must use PLOT for up to the first six series, then use OVERLAY 
for up to the remaining number of series (in groups of no more than six 
series at a time). After the first six series have been plotted, the legend 
area is full. Subsequent Overlay operations draw the chart lines, but pro­
duce the warning message CAN'TI LEGEND FULL. This message is simply a 
notice that the program can display no more legend lines. The overlay just 
specified, and subsequent overlays, are drawn without legend lines. 

POINTS [Plot subprogram/Format menu] 

POINTS allows you to plot the data points in a series using dots only. 

PRINT [Plot subprogram/Plot menu] 
[Plot subprogram/Pie chart Options menu] 
[Main subprogram/various menus] 
[Trend subprogram/various menus] 
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PRINT in any VisiTrend/Plot menu lets you print the current screen 
image on a supported printer. In most cases, you are allowed to change 
the printer driver and/or printer slot before printing. CTRL-C can be 
used to interrupt the printing, and return to the menu from which PRINT 
was selected. Refer to Appendix B for information on supported graphics 
printers. 

PROCEED [Plot subprogram/ data-off-scale condition] 

The PROCEED option appears when an overlay or rescale operation will 
cause points in the series to be outside the current chart scale. If you select 
PROCEED, the program draws an off-scale, partial plot. Each time an off­
scale value is encountered, a beep sounds. The program continues to warn 
you that data is off-scale, and you are prompted to PRESS ANY KEY TO 
CONTINUE. Pressing ESC, for example, returns you to the Plot menu. 

QUIT [Main subprogram/Main menu] 
QUIT leaves the VisiTrend/Plot program, and returns you to DOS. The 

DOS prompt (n is displayed. To reboot the VisiTrend/Plot program, 
switch the computer power off, wait a couple of seconds, then switch it 
back on; or type PR#n where n is the slot number of the drive containing 
the program diskette. All series are cleared from memory when you 
select QU IT. 

RANGE [Plot subprogram/Options menu] 

RANGE is used to change the plotting range of the selected series. 
RANGE displays the current series range, and the Range menu in the 
status area. The Range menu lets you SET a new range, or CLEAR a range 
you have previously SET. If you ha.ve not previously changed the range 
with SET, the CLEAR item has no effect. 

When SET is chosen, you are prompted for new starting and ending 
dates, and a period if other than 1. The chart is redrawn when PLOT is 
selected. You can also choose to EXIT the Range operation without clear­
ing or setting the range. 

Refer to the description of Range at the beginning of this chapter for 
more information on range and scale operations in the VisiTrend/Plot 
program. 

REDRAW [Plot subprogram/ data-off-scale condition] 

The REDRAW option appears when an Overlay operation will cause 
points in the series to be outside the current chart scale. Your other two 
options are PROCEED and CANCEL. If you select REDRAW, the chart is 
rescaled, then redrawn. However, all previously overlaid series, all 
legends, and any titles are erased in the process. Only the originally 
plotted series, and the series produced by REDRAW remain. 
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REGRESS [Trend subprogram/Analyze menu] 

REGRESS calculates an ordinary least-squares multiple regression, 
such that: 

You are prompted to select the dependent variable, then from one to 
five independent variables, from lists of the series currently in memory. 
Next, you are prompted to either keep or change the current range for 
the selections. 

In a regression, the current range is the logical intersection of the 
ranges of the dependent and independent variables. This range must 
have at least two more data points than there are independent variables, 
regardless of whether or not a constant is used. Next, you are prompted 
to choose whether the regression is to be computed with a constant, or 
through the origin (no constant). 

Two new series are generated by the Regression operation. The first is 
a fitted series developed from the generated constant and coefficients. 
The second is a series containing the differences (residuals) between the 
actual dependent series values and the fitted values. The new series have 
the same name as the dependent series, plus an extension that serves as 
an identifier. These identifiers are in the form" .Fn" for the fitted series, 
and ".Rn" for the residual series. n is a program-generated number, and 
is the same for both series that result from a single regression. 

The Regression operation can also be used to generate a forecast 
series. This option is chosen by selecting [TREND] as the only indepen­
dent variable. You are then asked to specify the number of periods to be 
forecast. The program develops a straight-line series based on the 
dependent variable. The series is then extended by the specified number 
of periods. 

The REGRESS calculations typically take from 15 to 60 seconds to be 
completed. The results are displayed on the screen. These include the 
name of the dependent variable, the range, and the number of data points 
(# 08S:). For each independent variable (and the constant, if used), the 
program displays the coefficient, standard error, and T-statistic. 

At the bottom of the screen, the regression statistics are displayed. 
These are the R-bar squared statistic, the corrected R-bar squared 
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statistic, the standard error of regression, the sum of the squared 
residuals, the F -test value of the regression, and the Durbin-Watson 
statistic. When you perform a regression on one independent variable 
with no constant, the F-statistic and the corrected R-bar squared are 
meaningless and, therefore, not computed. 

The Durbin-Watson statistic (DW) is the last item calculated. If there is 
not enough room for the fitted and residual series, they are not created, 
and the Durbin-Watson statistic is not calculated. A message that there is 
no room in memory appears in the status area. You should return to the 
Main menu, CLEAR at least two series from memory, then perform the 
regression again. 

After the results of the computations are displayed, you can print the 
analyses on the printer. If you do not print the screen display, it is 
discarded. 

Whether or not you choose to print the display, the program next asks 
if you want to save the two generated series in memory. You then return 
to the Trend menu. 

The formulas used by the VisiTrend/Plot program in computing 
regressions are summarized here for your convenience. For additional 
information on these and related formulas, refer to current textbooks 
dealing with econometrics and statistics. 

The values in formulas are defined as follows: 

Let 

( ') . th d t . t f . th. ddt . Xj 1 = 1 a a pom rom] In epen en senes. 

m{i) = ith regression coefficient. 

y{i) = ith data point from dependent series. 

n = number of series data points. 

k = number of regression coefficients to be estimated. 

and let 
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For the least squares regression coefficient: if you want a constant 
computed in the regression, then independent series 0 is an artificial 
series with all data values equal to 1. In this case, all the values in column 
o of X are 1. If n > k and (X'X) is invertible, then the least squares regres­
sion coefficient estimates m(O), ... , m(k-l) are given by 

M = (X'X)-l X'y 

Coefficients for a Trend subprogram forecast are also computed in 
exactly the same manner. In this case, column 0 of X is an artificial series 
whose values are all 1, and column 1 of X is an artificial series whose 
values are 1, 2, 3, ... , n. 

Regression statistics: 

1. The standard errors of coefficients are given by 

s(i) = ~diagi (SER2 (X'X) -1) 

where diag denotes the ith diagonal element of a matrix. 

2. The T statistic is given by 

t(i) = m(i)/s(i), s(i) ::;:. 0 

3. If y(i) denotes the fitted value for the ith dependent data value, i.e. 

k-1 

9(i) = L m(j)xj(i) 
J = 0 

then the ith residual is defined to be 

e(i) = y(i) - y(i) 

The Sum of Squared Residuals (SSR) is then 
n-1 

SSR = L e2(i) 
i = 0 

4. The Standard Error of Regression (SER) is given by 

SER = ~ n =- k SSR 
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5. The Coefficient of Determination R2 is 

R2 = 1 - SSR (SST =1= 0) 
SST 

n - 1 

where SST = L (y(i) _ y)2 
i = 0 

n - 1 

where y = ~ L y(i) (mean of y(i)) 
n 

i = 0 

VISITREN DIPLOT™ ~~f~~s 

6. The Corrected Coefficient of Determination R2 is given by 

7. The F Statistic is 

F(k - 1, n - k) = n - k 
k - 1 

8. The Durbin-Watson Statistic is computed as 

n - 1 

L 
i = 1 (e(i) - e(i - 1))2 

SSR ifSSR =1= 0 OW = 
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RESCALE [Plot subprogram/Options menu] 

RESCALE is used to change the chart scale that was determined by the 
program. You are prompted for new minimum and maximum scale 
values, and the number of intervals into which the axis is to be divided 
(tick marks). For an XY chart, both axes represent scale values, and you 
are prompted once for each axis. For all other chart types (except Pie 
charts), the scale is represented on the Y-axis. 

If you specify a minimum value that is greater than the maximum, the 
program reverses the values. If you specify the same value for the 
minimum and maximum, the program uses the specified value as the 
minimum and sets a maximum that is approximately 20 percent higher. 

Refer to the discussion of Scale at the beginning of this chapter for 
more information on range and scale operations in the VisiTrend/Plot 
program. 

RETURN [Main subprogram/various menus] 
[Trend subprogram/various menus] 

After the completion of certain operations (LOAD, for example), the 
program offers you the choice of PRINT or RETURN. When RETURN is 
selected, the program returns to the Main or Trend menu, without first 
printing the screen contents. 

During the selection process from a displayed list of series in memory, 
the status area normally contains directions that include < RETURN>. 
When you press the RETURN key, the item currently highlighted by the 
cursor is selected. 

RIGHT [Plot subprogram/Bar menu] 

RIGHT specifies that a Bar chart is to be drawn with half-width bars 
located to the right of the tick marks. RIGHT along with LEFT, is normally 
used for comparative Bar charts. 

SAVE [Main subprogram/Main menu] 

SAVE in the Main subprogram is used to write one or more series on a 
diskette file for permanent storage. You must choose whether the data is 
to be saved in the normal VisiTrend/Plot format or the DIF format. You 
then select the series to be saved from a displayed list of the series cur­
rently in memory. 
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You can save a specific series, [ALL] series, or [NONE] by moving the 
cursor to that entry, and pressing RETURN. You can also use the space 
bar to indicate any number of individual series to be saved. An asterisk 
(*) marks a series when you press the space bar, but the marked series is 
not saved until you press RETURN to complete the Save operation. To 
erase an asterisk, press the space bar a second time. 

When you press RETURN, you save all the series marked with an 
asterisk and the series which the cursor is highlighting (whether or not 
the latter has an asterisk). Selecting either [ALL] or [NONE] disregards 
any asterisks that may be in the list. 

Next, the program displays a list of the files currently on the data 
diskette. You can choose to store the selected series in an existing file, or 
to create a new file. If you select an existing file, all the data that is cur­
rently in that file is erased and replaced by the series being saved. If you 
choose to store the series in a [NEW FILE], you are prompted to name the 
file. If you specified the file to be saved as a DIF file, the program 
automatically appends the extension .DIF to the file name. 

The SAVE request is cancelled if you do not specify a file name, if you 
press ESC when prompted for a file name, or if you select [NONE] from 
the series list. 

SAVE [Plot subprogram/Screen menu] 

SAVE in the Plot subprogram is used to store the screen image of a 
chart on a diskette file. The saved screen image can subsequently be 
loaded back onto the screen from the data diskette. 

The program displays a list of all screen image files currently stored on 
the data diskette. You can choose to store the screen image in an existing 
file, or to create a new file. If you select an existing file, the screen image 
that is currently in that file j.s erased, and replaced by the one being 
saved. If you choose to store the image in a [NEW FILE], you are prompted 
to name the file. To identify the file as a screen image, the program 
automatically adds the extension .PIX to your specified file name when 
the file is saved. 

SCREEN [Plot subprogram/Plot menu] 
[Plot subprogram/Pie chart Options menu] 

SCREEN is used to load a chart screen image (>PIX file) from the data 
diskette to the screen, save a chart screen image on a diskette file, and· 
specify a disk drive/slot for the data diskette. For more information see 
LOAD, SAVE, and DEVICE. 
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SECOND [Plot subprogram/Title menu] 

SECOND, like FIRST and THIRD, specifies a title line to be entered at 
the bottom of a chart. SECOND specifies the second of the three possible 
bottom titles. Up to 37 characters are allowed on any bottom title line. 
The title is centered across the bottom of the chart. If the @ symbol is 
typed as the last character in the title, the title is left-justified. You can 
choose bold, normal, or inverse video typeface for any title. Bottom titles 
write over any legend occupying the same line. 

SELECT [Plot subprogram/Plot menu] 

SELECT is used to select the type of chart to be plotted. SELECT does not 
clear the current active series from the screen until you PLOT a new 
chart, nor does SELECT change the current options. To clear the current 
series and options selections, use the NEW item first. 

The selected series name is displayed in the bottom line of the status 
area. If you select multiple series, the name of the first one selected is 
displayed, followed by three dots. 

SERIES [Main subprogram/Fill menu] 
[Trend subprogram/Fill menu] 

SERIES lets you insert the values of an entire series into the middle of 
the series being edited. You select the other series from a displayed list of 
the series currently in memory. If you choose to insert the current series 
into itself, the program inserts the series values before any editing 
changes occurred. 

The ~ew data is inserted following the value currently highlighted by 
the cursor, and given the next sequential dates as indicated by the 
period of the series. The values that follow the insertion are pushed 
ahead and given new dates and/or periods, as appropriate. 

Up to 149 values can be inserted in a series. 

SET [Plot subprogram/Range menu] , 
SET is used to set a new plotting range for the current series. You are 

prompted to enter new start and end dates, and periods for both dates if 
the period is other than 1. The range you set can be removed with the 
CLEAR item; then you can PLOT the chart again using the range stored 
wi th the series. 

3-44 



APPLE II VISITRENDIPLOT™ ~~T~~s 
REFERENCE 

SIDE [Plot subprogram/Title menu] 

SIDE specifies a title line to be entered at the left of a chart. The side 
title is written vertically from top to bottom, and centered outside the 
Y-axis. Up to 14 characters are allowed in a side title. 

The UNLABEL item in the Options menu can be used to erase this ver­
tical Side title, along with the Y-axis labels. 

SLOT [Plot subprogram/Print menu] 

SLOT is used to change only the currently assigned slot number for a 
printer. Up to seven slots are available; however, slot 1 is normally used. 
Once changed, the slot number remains in effect throughout the current 
session - until it is changed again using the SLOT item, or as part of 
DRIVER. The DEFAULT item can also be used to change the slot number, 
but this change is retained between sessions. 

When SLOT is selected, the currently-assigned slot number is 
displayed in the bottom line of the status area. The status area below the 
Main menu also displays the current slot number. 

SMOOTH [Trend subprogram/Function menu] 

The SMOOTH function performs a single exponential smoothing on the 
source series. The forecast generated by this technique is based on the 
most current data point and current forecast, and lags the source series 
by one period. 

You are prompted for a smoothing factor ( X ) which must be greater 
than 0 and less than 1. The smoothed series (Y) is generated from the 
source series (X) according to the following formulas. 

For the value i = 1: 

For the remaining i values: 

where: 

i is an integer ranging from 1 through the number of series data points. 
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A high smoothing factor (a value greater than 0.5) gives greater 
weight to the more current point, and a low smoothing factor gives 
greater weight to the earlier point. 

The generated smoothed series is saved with the same name as the 
source series, plus an extension in the form ".S" that serves as an iden­
tifier. The generated series lags the source series by one period. This lag 
is a one-period forecast for the data in the source series. 

SPECS [Main subprogram/Edit menu] 
[Trend subprogram/Edit menu] 

SPECS is used to change the specifications of the current series. The 
specifications that can be changed are: the name of the series, the 
period, and the start date. For further information see NAME, PER, and 
START. 

START [Main subprogram/Specs menu] 
[Trend subprogram/Specs menu] 

START is used to change the starting date of the series being edited. You 
are also prompted for the starting period of the specified date, if the cur­
rent series periodicity is other than 1. The series dates are changed 
immediately, and shown in the screen display. If you press RETURN 
without first entering a new start date, the date 0 is used by the program. 

STATS [Trend subprogram/Analyze menu] 

ST A TS computes statistics on one or more series currently in memory. 
When multiple series are selected, STATS also computes and displays the 
correlation coefficients of the selected series. If you do not explicitly set a 
data format, the statistics are displayed in floating-decimal point format, 
and the correlation coefficients are displayed to three decimal places. 

The following formulas are used in the computations: 

For a series x(i), i = 0,1, ... , n-l 

n - 1 

Lx(i) 
The mean i = i = 0 

---n 
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n - 1 

The population variance 0 2 = : where ss = L (x(i) - x)2 
i=O 

The population standard deviation 0 = ~ ~ 

The number of series that can be displayed in a ST ATS operation 
depends on the column width specified for the series. Therefore, when 
multiple series are selected, only those series that fit within the display 
width appear - beginning with the first series selected. 

The program first prompts you to select one or more series from a 
displayed list. The status area next displays a range that represents the 
intersection of the ranges in the selected series. You have the choice of 
keeping this range or changing it. If you select CHANGE, you are 
prompted for a starting and ending date (and period for each, if periodicity 
is other than 1). Lastly, you have the option of printing the statistics 
display(s) on the printer. 

SWITCH [Plot subprogram/Window menu] 

SWITCH makes the other window active when the program is in two­
window mode. This switching does not affect the chart displayed in the 
previously active window. The current window designation, which is 
displayed in the lower-right corner of the status area, is changed to show 
the window that is in use. 

When you switch between windows, the series and options for the win­
dow you are leaving are no longer active. If you return to a window and 
want to change an option, you must start over, and PLOT the chart again. 
You should, therefore, try to complete all refinements to one chart before 
switching windows to plot and refine the other chart. 

SYMBOLS [Plot subprogram/Format menu] 

SYM SOLS specifies that a chart is to be drawn using plotting symbols 
only (no interconnecting lines). This item appears in the Format menu for 
Line and XY charts. 
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Up to six different symbols are used for multiple series charts. When 
more than six series are drawn on the same chart, the symbols are 
repeated in sequence. That is, the first-series symbol is repeated for the 
seventh series, the second-series symbol is repeated for the eighth series, 
and so on. The symbols used by the VisiTrend/Plot program are shown 
here, in the sequence they appear on a chart: 

o First series (hollow square) 
+ Second series (plus sign) 
o Third series (hollow circle) 
x Fourth series o Fifth series (hollow diamond) 
X Sixth series (x over dot) 

TABLE [Trend subprogram/Analyze menu] 

TABLE produces a table of one or more series. If you do not explicitly 
set a data format, the series are displayed in floating-decimal point for­
mat, with a column width of 10. 

The number of series that can be displayed in a TABLE operation 
depends on the, current column width. Therefore, when multiple series 
are selected, only those series that fit within the display width appear­
beginning with the first series selected. 

The program first prompts you to select one or more series from a 
displayed list. The status area next displays a range that represents the 
union of the ranges in the selected series. You have the choice of 
keeping this range or changing it. If you select CHANGE, you are 
prompted for a starting and ending date (and period for each, if 
periodicity is other than 1). 

The table is displayed 18 lines at a time. After each 18 lines, you are 
prompted to continue to the next 18 lines, print the current screen 
display and continue, or exit to the Trend menu. 
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TEXT [Plot subprogram/Plot menu] 
[Plot subprogram/Pie chart Options menu] 

TEXT allows you to place customized titles, labels, legends, and notes 
on a displayed chart. You can also use TEXT to create text-only pages. 
When the Text operation is in effect, your computer and its associated 
printer operate much like an electronic typewriter. Text-only screens 
can be printed out as annotations or other supporting material for charts, 
and you can place more information on the charts themselves. TEXT can 
be selected for a new chart display, or for a .PIX file that has been loaded 
from a data diskette. Table 3-5 lists the special keyboard keys that can be 
used in the Text operation. 

Table 3-5. Summary of Text Operations 

Operation 

Erase a character 

Change cursor to small-increment dot 

Move cursor up one line 

Move cursor down one line 

Move cursor left 

Move cursor right 

Move cursor to beginning of next line 

When in lower case, change only the next 
character to upper case 

When in lower case, change all subsequent 
characters to upper case 

When in upper case, change all subsequent 
characters to lower case 

Tab five spaces to the right 

Turn onloff bold face (upper case only) 

Turn onloff in verse video 

Clear entire screen 

Terminate Text operation 
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Key(s) 

Space Bar 

CTRL-Z 

CTRL-O 

CTRL-L 

RETURN 

CTRL-A 

CTRL-A twice 

CTRL-A 

CTRL-I 

CTRL-B 

CTRL-R 

CTRL-@ 

ESC 
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THIRD [Plot subprogram/Title menu] 

THIRD, like FIRST and SECOND, specifies a title line to be entered at the 
bottom of a chart. TH I RD specifies the third of the three possible bottom 
titles. Up to 37 characters are allowed on any bottom title line. The title is 
centered across the bottom of the chart. If the @ symbol is typed as the last 
character in the title, the title is left-justified. You can choose bold, nor­
mal, or inverse video typeface for any title. Bottom titles write over any 
legend occupying the same line. 

TITLE [Plot subprogram/Options menu] 
[Plot subprogram/Pie chart Options menu] 

TITLE is used to add top, bottom, side~ and moveable titles to the cur­
rently displayed chart; and to remove or redisplay legend line(s). For 
more information, see TOP, FIRST, SECOND, THIRD, SIDE, LEGEND, and 
MOVEABLE. 

TOP [Plot subprogram/Title menu] 

TOP specifies a title line to be entered at the top of a chart. Up to 37 
characters are allowed on a top title line. The title is centered across the 
top of the chart. If the @ symbol is typed as the last character in the title, 
the title is left-justified. You can choose bold, normal, or inverse video 
typeface for any title. 

I 

TOTAL [Trend subprogram/Function menu] 

The TOTAL function generates a new series that contains the 
cumulative total of the data points in the source series. The generated 
total series is saved with the same name as the source series, plus an 
extension in the form ". Til that serves as an identifier. 

The first data point in the generated series is equal to the first point in 
the source series. The second point in the new series is equal to the sum 
of the first and second points in the source series, and so forth. Thus, any 
point in the total series is equal to the sum of all preceding points in the 
source series. 

TREND [Plot subprogram/Exit menu] 
[Main subprogram/Main menu] 

TREND exits the Plot subprogram or the Main subprogram, and 
displays the Trend menu. Series in memory are not lost in transit. 
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UNDO [Main subprogram/Edit menu] 
[Trend subprogram/Edit menu] 

UNDO discards all changes made to a series during the current editing 
session. The series is restored to its previous state - as it appeared when 
selected for the current Edit operation. If you select UNDO with a newly­
created series, the series is deleted. 

UNLABEL [Plot subprogram/Options menu] 

UNLABEL is used to erase the X-axis and/or Y-axis labels from a chart. 
The Unlabel menu is displayed which offers the choice of erasing 
horizontal (X-axis) labels, vertical (Y-axis) labels, or both. When vertical 
labels are erased, any side title on the chart will also be erased. If NONE 
is selected, the program returns to the Plot menu. 

VERT [Plot subprogram/Grid, Unlabel. and 
Window menus] 

VERT performs differently in each menu where it appears. 

In the Grid menu, VERT specifies that vertical grid lines are to be 
drawn. If vertical grid lines already exist, this item is used to erase them. 

In the Unlabel menu, VERT specifies that the scale labels (Y-axis) are to 
be erased. If a side title exists on the chart, it is erased along with the 
labels. 

In the Window menu, VERT specifies that the screen is to be divided into 
left and right windows, rather than horizontal top and bottom windows. 

WINDOW [Plot subprogram/Plot menu] 

WINDOW divides the screen into two windows, switches between win­
dows, and changes back to one full-screen window. A screen can be 
divided into either horizontal top and bottom windows, or vertical left and 
right windows. 

The chart legends are not displayed in the window mode. 

When window mode is in effect, the extreme right corner of the status 
area displays an appropriate code for the active window: WT, WB, WL, or 
WR - for top, bottom, left, or right window. 

Window mode is cancelled when you select NONE from the Window 
menu, or either NEW or PIE from the Plot menu. 
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XFORM [Trend subprogram/Trend menu] 

XFORM allows you to do series transformations. This can include the 
conversion of exponential values to first order values for inclusion in a 
linear multiple regression. 

In addition, XFORM lets you write your own transformation formula. 
Formulas are limited to two lines (80 characters). You have the use of the 
following mathematical, logical, and comparative operators in writing 
your transformation formula: 

Arithmetic operators: 

+ Addition 

Subtraction 

* Multiplication 

/ Division 

/\ Exponentiation 

Logical operators: 

AND 

OR 

NOT 

Comparative operators: 

< Less than 

< = Less than or equal to 

= Equal to 

> Greater than 

> = Greater than or equal to 

Functions: 

Sign 

Integer part of 

Square root 

Natural logarithm 

e to the power of 

SGN 

INT 

SQR 

LOG 

EXP 
RND 

ABS 

Random number between 0 and 1 

Absolute value of 
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Trigonometric functions: 

SIN 

COS 

TAN 

ATN 

Sine 

Cosine 

Tangent 

Arctangent 

VISITRENDIPLOT™ ~~~~~s 

You can use parentheses to control the execution order of the formula. 
All operations in parentheses are performed before the operations outside 
the parentheses. All parentheses must be closed or an error will occur. 

l\unctions are used as they are in a BASIC program. The only difference 
here is that you can use a series as the variable on which the function 
operates. In this case the function is performed on each data point in the 
series. For example, SQR(XY EARNINGS) generates a series with the 
same beginning and ending dates and period. Each data point in the new 
series is the square root of the corresponding data point in XY EARNINGS. 

When you select XFORM, you are first prompted to enter a name for 
the series to receive the transformed values. If you press RETURN 
without entering a series name, the program generates a name in the 
form SERIESn, where n is a digit representing the next series in memory. 
For example, if there are five series currently in memory, the new series 
is named SERIES6. 

After naming the new series, you are prompted to enter the transfor­
mation expression by typing it at the keyboard. You can include series 
names in any formula. The XFORM operation displays the list of series 
currently in memory for thi~ purpose. However, you do not type the name 
of a series. 

To enter a series name into the transform expression, press - to move 
the cursor into the series list. The name highlighted by the cursor 
appears in the transform expression. Pressing the arrow keys moves the 
cursor up and down the list in the normal manner. As the cursor moves, 
the currently highlighted series name replaces the previous name in the 
transform expression. To select a series, press RETURN, or enter the next 
character in the transform expression. 

You can erase entries in the formula by pressing ESC. ESC erases 
series names as well as characters entered from the keyboard. A series 
name is erased as a whole, not a character at a time. When ESC is first 
pressed, series names are bracketed with back slashes (\ \) so they are 
more easily identified. 
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When the expression is complete, press RETURN to perform the 
transformation and create the new series. 

XY [Plot subprog,ram/Select menu] 

XV specifies that an XY chart is to be drawn. Lists of the series in memory 
are displayed from which you select first the series to be plotted along the 
X-axis, and then the one to be plotted along the Y-axis. The X-axis is 
scaled to the minimum and maximum for the X-axis series, and the Y-axis 
is scaled correspondingly for the Y-axis series. The range ofaXY chart is 
the intersection of the two series, and is not explicitly shown in the chart. 
You can change the range of an XY chart. 

When you RESCALE an XY chart, you are asked for new scale values for 
both the X-axis and the Y-axis. 

An XY chart can be drawn with symbols only, lines only, points only, or 
both symbols and lines by selecting the FORMAT item in the Options 
menu. If you do not specify a format, plotting symbols are used. 
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ERROR MESSAGES 

This appendix lists the error messages issued by the VisiTrend/Plot 
program. The messages are in alphabetical order by the first word of the 
message. The error descriptions include suggestions on further action 
whenever possible. If an error message with a number appears, see The 
DOS Manual, Apple product number #A2L0036. 

(loud beep) 
A beep is sounded whenever inappropriate data is entered, or an 

illegal operation is attempted. When inappropriate data is entered, no 
message accompanies the beep. When you encounter this, try your entry 
again. You probably pressed the wrong key by mistake, such as pressing 
a letter key when the program was looking for numeric data. 

CAN'T! BAD FILE 
You attempted to load a data file that is not in the VisiTrend/Plot data 

format or the DIF format. Only files in these formats can be loaded by the 
VisiTrend/Plot program. 

CAN'T! BAD PERIODICITY 
You selected series that have different periods. All series used in a 

chart, whether a multiple series chart or an overlay of two or more 
charts, must have the same period. 

CAN'T! BAD RANGE 
If this message occurs as the result of an attempted PLOT, it means that 

a series being used does not have at least two data points, or that the 
series has more than 150 data points. Use the EDIT operation to check the 

. series, and make sure it contains at least two, but not more than 150, data 
points. 

Other conditions that can cause this message are: 

• There is no data in the range you specified with the RANGE item. 

• You attempted to draw a Pie chart with series that have no data at the 
date specified for the Pie chart. 
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If any pair of independent variables have very different scales (one in 
the range around .01 and the other in the range around 1,000,000, for 
example) a regression cannot be performed. Use the XFORM operation 
to multiply or divide one series by a power of 10 to eliminate the different 
scale problem. You must adjust the coefficient of the scaled variable. For 
example, if you divided a variable by 100 to run the regression, multiply 
the resulting coefficient of that variable by 100 to obtain the correct 
value. This technique affects the fitted and residual values; however, the 
descriptive statistics of the regression will be correct as shown. 

CAN'T! BAD TRANSFORM: BAD EXPRESSION 
You entered an XFORM expression that contains an illegal operator or 

unbalanced parentheses. There are several other ways you can make an 
error in creating a transform. You can specify an invalid operation such 
as division with zero. It's also possible to mismatch parentheses (or make 
a similar syntactical mistake) or type a series name instead of using the 
arrow keys to select it from the list. When an error is encountered, 
carefully enter the expression again. 

CAN'T! BAD TRANSFORM: DIVISION BY ZERO 
You specified a division by zero in an XFORM expression. Re-enter the 

correct formula. 

CAN'T! DISK FULL 
The data storage capacity on the diskette currently in use has been 

reached. The operation that was in process when this message appears 
has been lost. Replace the current diskette with another data diskette, 
and retry the operation. 

CAN'T! DISK ERROR or DISK 1/0 
This error can be caused by trying to save data on a diskette that is not 

ini tialized. 

Initialize the diskette with the FORMAT item in the Files menu of the 
Main subprogram. If you still get the error message, try placing the data 
diskette in a different drive (if you have multiple drives). You might also 
try a different data diskette. Make sure you use a data diskette for which 
you have a backup. It is always a good idea to have a backup of your 
diskettes, and a necessity when you are having problems. 

If you continue to get the error, see the troubleshooting guide that 
came with your computer and disk drives. 
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CAN'T! FILE EXISTS 
A file already exists with the name you typed. Choose another name, 

and try the operation again. 

CAN'T! FILE LOCKED 
You attempted to DELETE a file that has been locked, probably via a 

DOS command. Unlock the file as explained in The DOS Manual then 
retry the Delete operation. 

CAN'T! INSERT PROGRAM DISKETTE 
You tried to change programs when the VisiTrend/Plot program 

diskette was not in drive 1 connected to slot 6. Insert the program diskette 
in this drive, and press ESC to continue. 

CAN'T! LEGEND FULL 
You have done nothing wrong. "CAN'T!" in this instance only means 

that your chart has reached its maximum of six legends, and the program 
can't display any more legend lines. The overlay you just specified, and 
subsequent overlays, are drawn - but without corresponding legend 
lines. 

CAN'T! NO ACTIVE SERIES 
You attempted to invoke an operation that cannot be invoked until a 

series is selected through the Select menu, or until a series is loaded into 
memory. 

CAN'T! NO FILES HERE 
You selected the LOAD item from the Screen menu, or you selected the 

DELETE item from the Main menu, but there are no files to be loaded or 
deleted. Files must be loaded into memory before they can be loaded on 
the screen or deleted. Use LOAD from the Main menu. 

It is also possible that the disk drive door is open, there is no data 
diskette in the specified disk drive, or the diskette is wrong side up in the 
drive. Make sure that you have the correct data disk drive specified, and 
that you have a data diskette in the specified drive. Also make slire the 
diskette is inserted properly, and the disk drive door is closed. 

CAN'T! NO OPTION HERE 
Certain options are not applicable in all instances. When you see this 

error message, you tried to apply an option that is not valid in the current 
circumstances. Another cause of this message is selecting GRID when no 
chart is displayed on the screen. 
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CAN'Tl NO OVER LA Y HERE 
You attempted to use OVERLAY when there was no chart displayed; or 

you specified COLOR or BACKGR and then immediately tried to overlay. 
Another possible cause of this message is trying to overlay an XY chart. 

CAN'Tl NO OVERLAY OF XY WITH OTHER TYPE 
You tried to overlay an XY chart with another chart type during an 

overlay. XY charts cannot be used in an overlay operation. Choose an 
allowed set of chart types, or use other options to achieve the desired effect. 

CAN'Tl NO ROOM 
You tried to LOAD a file when there was not enough room in memory to 

hold all the series in the file. Another cause is that you tried to put more 
than 150 data points in a series. You must CLEAR enough series out of 
memory to make room for the series in the file. 

CAN'Tl PLEASE SELECT FIRST 
You selected the PLOT or OPTIONS items without first selecting a 

series. You may also have switched windows withou,t selecting a series for 
the new window. You must use the SELECT item in the Plot menu to select 
a series after switching windows, even if you want to plot the same series. 
Select a series, and then return to the PLOT or OPTIONS item. 

CAN'Tl PRESS ANY KEY 
You are drawing a chart that has an off-scale data point. This message 

occurs when the first off-scale point is encountered. This message also 
appears in the Trend subprogram when the last screenful of statistics or 
values is displayed. In this case, there is no error; just press ESC to 
return to the Edit menu. 

CAN'T! PRINTER DRIVER HAS BAD FORMAT 
You selected a printer driver with a format that is incompatible with the 

version of the program you have loaded in your computer. You might 
have erroneously transferred a version 1 driver onto a version 2 program 
diskette, for example. Check the list of available printer drivers again 
with the DRIVER or DEFAULT operations, and make sure that you are 
selecting the correct driver. 

It is possible to get this error message if a non-VisiTrend/Plot file is 
mistaken for a VisiTrend/Plot file, because of format similarities, and is 
loaded. 
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CAN'T! SINGULAR MATRIX 
You selected independent variables for a multiple regression that 

either exhibit a high degree of collinearity or have very different scales. 

When the independent variables are highly correlated, it is 
mathematically impossible to perform a regression. If two variables are 
simple multiples of each other, they are perfectly correlated. You should 
be careful in creating regression variables using the XFORM function. 

CAN'T! WRITE PROTECTED 
You attempted to save some series in a file on a write-protected diskette. 

Either replace the data diskette with one that is not write-protected or 
remove the protection tab from the diskette. Before removing the tab, you 
should determine why the diskette was write-protected. 

DATA OFF SCALE, CHOOSE ACTION 
You rescaled the chart and, in the new scale, some data points fall out­

side the specified scale. CANCEL cancels the entire plot operation. 
PROCEED causes a partial plot to be drawn. Each time an off-scale value 
is encountered, the beep sounds. If the chart is a Bar chart, the plot is 
cancelled when the first off-scale data point in encountered. 

When overlays are involved, REDRAW is a third choice of action. 
REDRAW causes the chart to be redrawn using a new Y-axis. However, 
interim overlays and all titles and legends are lost from the redrawn 
chart. 

DISKETTE ALREADY INITIALIZED 
You selected the FORMAT item, and the diskette in the data disk drive 

is already initialized. If you continue, the data currently on the diskette 
will be erased. Press the ESC key to cancel; press Y to continue the For­
mat operation. 
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APPENDIX B 

SUPPORTED GRAPHICS PRINTERS 

OVERVIEW 

The VisiTrend/Plot program works with a variety of graphics printers. 
This appendix contains a list of the printers supported by the program, and 
describes any required printer options and switch settings. If your printer 
is currently operating properly with other programs, you probably will not 
need to change printer switch settings and options. You may only need to 
select the appropriate driver for your printer from those included on the 
program diskette. If you are installing a new printer, you should expect to 
receive assistance from your dealer. 

The following graphics printers are supported by the VisiTrend/Plot 
program: 

• Apple Silentype ™ 

• Apple Daisy WheeFM 

• Apple Dot Matrix™ 

• Centronics 739® 

• Epson MX-80™ with GRAFTRAX 80™ option or GRAFTRAX-PLUSTM 
option installed 

• Epson MX-100TM 

• IDS Paper Tiger ™ models 440G and 445G 

• IDS Paper TigerTM models 460G and 560G with Dot Plot™ option 
installed 

• IDS Prism ™ models 80 and 132 

• NEC PC-8023A-C Dot Matrix ™ 

• NEC SpinwriterTM models 3530, 5510, 5520, 5530, 7710, 7720, and 
7730 

• Qume Sprint® models 5/45, 9/45, and 11140 PLUS 

• Trendcom 200G® 

Your printer requires a specific software routine, called a driver, to cor­
rectly print your textual or graphic screen images. Drivers are located on 
the VisiTrend/Plot program diskette, and permit the various listed printers 
to operate with the VisiTrend/Plot program. The names of the drivers that 
support each printer are listed in Table B-l. 
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Your VisiTrend/Plot program diskette is already set up to print on the 
Apple Silentype™ printer. You do not need to make any printer ch~nges, 
or select a driver if your printer is an Apple Silentype. 

If you have one of the other listed graphics printers connected to your 
computer, you'll·need to change drivers before you can print. See 
"Changing the Printer Driver" following Table B-l. 

INTERFACE CARDS AND DRIVERS 

The VisiTrend/Plot program operates correctly in serial mode with the 
Apple II Serial Interface card, the Apple II Communications Interface 
card, and the Apple II Super Serial Interface card. Operating the pro­
gram with any other serial or communications interface card may pro­
duce incorrect results or cause the program to stop processing 
altogether. 

The Silentype and Trendcom 200G printers work only with their own 
speCial interface cards provided with the printer. 

One important point should be noted about parallel driver programs: 
with two exceptions, the parallel drivers operate only with the Apple II 
Parallel Interface card. The exceptions are the Epson MX-80 and MX-100 
printers, which operate only with the Epson MXAppie II Interface card. 

The Epson MX-80 and MX-IOO drivers support high-density graphics. 
In high-density mode, twice as many dots are printed per inch as in 
normal density. 

Table B-1 lists the drivers for the various configurations of listed 
graphics printers. 
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Table B-1. Drivers for the Supported Printers 

Printer 

Apple Silentype 

Apple Daisy Wheel 

Apple Dot Matrix 

Cen tronies 739 

Epson MX-80 

Epson MX-100 

IDS Paper Tiger 
440G and 445G 

IDS Paper Tiger 
460G and 560G 
and IDS Prism 80 
and 132 

NEC PC-8023A-C 
Dot Matrix 

NEC Spinwriter 
5510, 5520 
7710, and 7720 

NEC Spinwriter 
3530,5530, 
and 7730 

Qume Sprint 
5/45, 9/45, 
and 11140 PLUS 

Trendcom 200G 

Other printers 

Description of Driver 

Silentype Interface; single width 

Silentype Interface; double width 

Apple II Serial Interface *; double width 

Apple II Super Serial Interface; double width 

Apple II Parallel Interface; double width 

Apple II Parallel Interface; double width 

Epson Parallel Interface; double width 

Epson Parallel Interface; double width 

Apple II Serial Interface *; single width 

Apple II Parallel Interface; single width 

Apple II Super Serial Interface; single width 

Apple II Parallel Interface; double width 

Apple II Serial Interface*; double width 

Apple II Super Serial Interface; double width 

Apple II Parallel Interface: double width 

Apple II Serial Inteface*; double width 

Apple II Super Serial Interface; double width 

Apple II Parallel Interface; double width 

Apple II Serial Interface *; double width 

Apple II Super Serial Interface; double width 

Trendcom Interface; double width 

Apple II Serial Interface * 

Apple II Parallel Interface 

Apple II Super Serial Interface 

*If you are using an Apple II Communications Interface card with your printer, you may use the Apple II 
Serial Interface drivers. 
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CHANGING THE PRINTER DRIVER 

The Print Menu in the Plot subprogram contains two items that allow 
you to change both the printer driver and the printer slot: DEFAULT and 
DRIVER. With either item, the change is made by selecting a different 
driver and slot from a displayed list. 

Automatic line feeds are software functions, not hardware options; you 
need no extra equipment to use them. If the line-spacing is wrong on 
your printouts, you can change the line feed specification. Both the 
DEFAULT and the DRIVER items allow you to do this. 

If you use DEFAULT, your new selections remain in effect throughout the 
current VisiTrend/Plot program session and all subsequent VisiTrend/Plot 
program sessions. If you use DRIVER, your new selections remain in effect 
during the current session only. You can change selections at any time by 
using DEFAULT or DRIVER again. 

Follow the steps below: 

1. Display the Plot menu, and select PRINT. 

2. When the Print menu appears, select either DEFAULT or DRIVER. The 
program next displays a list of printers with their specifications. 

3. The status area displays the current printer driver and interface card 
slot number, and notes whether automatic line feeds are in effect. You 
are prompted to move the cursor, or press RETURN. 

4. Use the arrow keys to position the cursor on the name of the correct 
printer driver, then press RETURN. 

5. If the driver you want is not displayed, move the cursor to [MORE] , and 
press RETURN. An additional list of drivers appears. Use Table B-1 to 
match a driver with your printer. 

6. The list of drivers disappears, and you are prompted to choose whether 
or not you want automatic line feeds. If your printing has been double­
spaced and you want single spacing, select NO. If lines have been 
printed on top of one another, or if you want your output to be double­
spaced, select YES. 

7. Finally, you are prompted for the slot number in which the printer inter­
face card currently resides. Type the correct number, and press 
RETURN. The program returns to the Print menu. You can then position 
the printer paper, and select PRINT to continue a printing operation. 

Always position the paper before you request the printing of listings or 
charts. No automatic form feeds or top of form are built into the 
VisiTrend/Plot program. 
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PRINTER SETUP AND SWITCH SETTINGS 

The following sections describe the preparation of the listed graphics 
printers and interface cards. These sections are intended only as an aid in 
preparing the printers and interface cards for use with the VisiT rend/Plot 
program. They are not complete directions on setting up the printers. For 
that information, see the documentation that the manufacturer ships with 
the printer and/or interface card, or contact your dealer. 

You must turn your printer off before setting switches. 

Only those switch settings that are necessary to print graphics are listed. 
Other switches may be dependent upon your configuration, or are mean­
ingless in this application. Therefore, no switch position is suggested. 

Note that there may be as many as three different sets of switches 
involved with a specific printer/interface card setup. The printer may have 
internal and/or external switches, and there may be switches on the inter­
face card in your computer. Make sure you are setting the correct switches. 

APPLE SILENTYPE 

No setup is required. No change of driver is necessary. 

APPLE DAISY WHEEL 

The Apple Daisy Wheel printer operates with the Apple II Serial Inter­
face card, The Apple II Communications card, or the Apple II Super 
Serial Interface card. Set up the switches for your printer and interface 
card according to the directions on the Apple Computer Daisy Wheel 
Printer Reference Card that accompanied your printer. 

APPLE DOT MATRIX 

The Apple Dot Matrix printer operates only with the Apple II Parallel In­
terface card. Set up the switches for your printer and interface card accor­
ding to the directions on the Apple Computer Dot Matrix Printer 
Reference Card that accompanied your printer. 
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CENTRONICS 739 

The Centronics 139 only operates with the Apple Parallel Interface 
card. There are only two switches on the printer and their settings are 
shown in Table B-2. 

Table B-2. External Switch Settings for the Centronics 739 Printer 

Switch Setting 

On-lineIOff-line On-line 

Power On 

EPSON MX-80 WITH GRAFTRAX 80 or 
GRAFTRAX-PLUS OPTION 

The Epson MX-80 operates only with the Epson MX Apple II parallel 
interface card. 

The printer contains internal DIP switches which must be set correctly 
for it to print graphics. The DIP switches are located near the back of the 
main circuit board. See your MX-80 User's Manual and the 
GRAFTRAX-80 or GRAFTRAX-PLUS supplement for complete details. 
Table B-3 lists the switch settings that· must be checked and set, if 
necessary. Switches that are not listed can be set as your system or con­
figuration requires. The Epson parallel interface card has no switches. The 
printer must be on-line. There are no other external switches to set. 

Table B-3. Epson MX-80 Printer Internal DIP Switch Settings 

Dip Switch Setting 

DIPSl SW2 On (CR=print) 

SW3 On (Buffer full = print) 

EPSON MX-IOO 

The Epson MX-lOO operates only with the Epson MX Apple II parallel 
interface card. 

The printer must be on-line, otherwise there are no internal or external 
switches to set. 
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IDS PAPER TIGER 440GI 445GI 460GI 560G and 
IDS Prism 80 and 132 

The IDS Paper Tiger printers operate with either a serial or parallel 
interface. You must have the Dot Plot graphics option on the model 440 
and 445 to print charts. The Dot Plot graphics option is denoted by a G in 
the model number, i.e. 460G. Without the Dot Plot graphics option, you 
can print only listings, not charts. 

Note that even though the IDS Prism printers are color printers, the 
printer drivers listed support only black-and-white output. 

Under some circumstances, IDS printers may begin to print continu­
ously when the power is turned on. To avoid this, you must load the DOS 
System Master diskette, and enter the commands: 

PR#1 

PR#O 

before turning on the printer. Then turn on the printer, insert the 
VisiTrend/Plot program diskette, and type the command RUN HELLO. 

Serial Operation 
The baud rate limit is 1200 with the Apple II Serial Interface card, and 

9600 with the Apple II Super Serial Interface card. 

With an unmodified Apple II Communications Interface card, the baud 
rate is 300. During printing, the data may also appear on the screen. 
When printing is completed, the screen image returns to normal. 

Table B-4lists the DIP switch settings that should be used with the Paper 
Tiger models 440G and 445G. Table B-5 lists the switch settings for the 
Paper Tiger models 460G and 560G, and the Prism models 80 and 132. 

B-7 



APPLE II 
APPENDIX B 

Table B-4. Paper Tiger Models 440G and 445G Printer Internal 
Switch Settings Used With Apple II Serial Interface Card 

Dip 

DIPS3 

DIPS4 

Dip 

DIPS4 

Switch 

SW6 

SW5 

SW6 

Option 

Graphics Print 
Capability Enable 

Auto-linefeed 

Remote Printer 
Control 
Deselect 

Switch Setting 

On (Switch is 
meaningless for 
printers without the 
graphics option) 

Off 

Off 

Table B-5. Paper Tiger Models 480G and 560G, and 
Prism Models 80 and 132 Printer Internal Switch 

Settings Used With Apple II Serial Interface Card 

Switch Option 

SW4 Automatic Boundary 

SW5 Auto-linefeed 

SW7 Expanded Function 

Switch Setting 

User Choice 
(cfAVTION: If On, 
make sure there are 
enough lines on the 
current page for the 
graph before print­
ing, otherwise the 
I-inch skip will occur 
within the chart.) 

Off 

Must be On 

The switches on the Apple II Serial Interface card should be set as 
shown in Table B-6. 

Table B-6. Apple II Serial Interface Card Switch Settings 

Switch Option 

SW5,6 Paper Size 
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With the Apple II Super Serial card, the printer and interface card 
should be set up as suggested in the Apple II Super Serial Card Installa­
tion and Operating Manual for printer mode. Be sure that the baud rates 
on the printer and interface cards are the same, and that the jumper 
block is pointing toward TERMINAL. Table B-7 lists the switch settings 
for the Apple II Super Serial Interface card. 

Table B-1. Apple II Super Serial Interface Card Switch Settings 

Dip Switch 

DIPS1 SW5,6 

DIPS2 SW3,4 

Parallel Operation 

Option 

Mode 

Line width and 
video 

Switch Setting 

Offlon for printer 
mode 

Offloff for 132 
charlline and video 
off 

With the Apple II Parallel Interface card, use the printer DIP switch 
settings shown in Table B-8 for the Paper Tiger models 440G and 445G, 
and the switch settings in Table B-9 for the Paper Tiger models 460G, 
560G, and Prism 80 and 132. 

Table B-8. Paper Tiger Model 440G and 44SG Printer Internal Switch 
Settings Used With an Apple II Parallel Interface Card 

Dip Switch 

DIPS3 SW6 

DIPS4 SW5 

SW6 

Option 

Graphics Print 
Capability Enable 

Au to-linefeed 

Remote Printer 
Control 
Deselect 
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Table B-9. Paper Tiger Models 460G, 560G and 
Prism models 80 and 132 Printers Internal Switch Settings Used 

with Apple II Parallel Interface Card 

Dip Switch Option 

DIPS4 SW4 Automatic Boundary 

SW5 Au to-linefeed 

SW7 Expanded Function 

NEC PC-8023A-C DOT MATRIX 

Switch Setting 

User Choice 
(CAUTION: If On, 
make sure there are 
enough lines on the 
current page for the 
graph before print­
ing, otherwise the 
I-inch skip will occur 
within the charl.) 

Off 

Must be On 

The NEC PC-8023A-C Dot Matrix printer operates only with the Apple II 
Parallel Interface card. Set up the switches for your printer and interface 
card according to the directions in the PC-8023A-C Dot Matrix Printer 
User's Manual lor Apple Users that accompanied your printer. 

NEC SPINWRITER 5510, 5520, 7710, and 7720 

The VisiTrend/Plot program supports the serial interface NEC Spin­
writers with the NEC-compatible graphics option. Models 5510, 5520, 
7710, and 7720 operate with the Apple II Serial Interface card, the Apple 
II Communications card, or the Apple II Super Serial Interface card. 

If your Apple II Serial Interface card has the P8 PROM, the serial opera­
tion speed cannot exceed 300 baud. If the P8A PROM is installed, the 
speed cannot exceed 1200 baud. 

For operation with the Apple II Communications Interface card, the 
baud rate is 300 for an unmodified card. During printing, the data may 
also appear on the screen. When printing is completed, the screen image 
returns to normal. 

For operation with the Apple II Super Serial Interface card, the baud 
rate limit is 1200. 
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The Spinwriter may beep and not start printing when you first attempt to 
print after the Apple II is powered on. To clear this, press the RETURN key 
on the keyboard. 

The switches on your Spinwriter should be set as shown in Table B-10. 

Table B-IO. NEC Spinwriter 5510, 5520, 7710, and -7720 Printer 
External Switch Settings 

Model Dip 

5510 NIA 
and 
5520 

7710 
and 
7720 

DIPS1 

DIPS2 

DIPS3 

Switch 

Local LF 

LF 

SP 

Remote/Local 

SW6 and SW7 

SW6 

SW1 

SW2 

SW3 

SW4 

Setting 

Off 

6 

10 

Remote (if switch is 
present) 

Off - buffer length 
163 characters 

Off - normal opera-
tion 

Off- normal opera-
tion 

Off - constant spac-
ing 

Off - 6 lines per inch 

Off - sing Ie line 
spacing 

The switches on the Apple II Serial Interface card should be set as 
shown in Table B-1!. 

Switch 

SW5,6 

Table B-II. Apple II Serial Interface Card Settings 

Option 

Paper Size 

Switch Setting 

User Choice (Must not be set 
to OniOn) 

With the Apple II Super Serial card, the printer and interface card 
should be set up as suggested in the Apple II Super Serial Card Installa­
tion and Operating Manual for printer mode. Be sure that the baud rates 
on the printer and interface cards are the same, and that the jumper 
block is pointing toward TERMINAL. Table B-12 lists the switch settings 
for the Apple II Super Serial Interface card. 
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Table B-12. Apple II Super Serial Interface Card Switch Settings 

Dip Switch Option Switch Setting 

DIPS1 SW5,6 Mode Offlon for printer 
mode 

DIPS2 SW3,4 Line width and Offloff for 132 
video charlline and video 

off 

NEe SPINWRITER 3530, 5530, and 1130 

The program supports the parallel interface NEC Spinwriters. All 
models operate only with the Apple II Parallel Interface card. 

To prepare any model, you must check, and if necessary set, DIP 
switches located on the circuit boards inside the printer. If you need help 
taking the printer apart contact the NEC Information Systems Regional 
Office or your local field service representative. See the NEe documen­
tation for the address and phone number. 

The DIP switches and their use are described in Appendix A of the 
Spin writer Model 5530 Product Description which comes with the 
printer. Table B-13 lists the necessary switch settings for the G9BNA 
board (furthest back) and Table B-14 lists the settings for the G9BNB 
board (next to the G9BNA board). 

Refer to the appropriate appendixes in the Product Description 
document for other models. 
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Table B-13. NEC Spinwriter Model 5530 Board G9BNA Internal DIP 
Switch Settings 

Switch 

SW5 

Option 

Auto Return 
Invalid 

Setting 

On 

Table B-14. NEC Spinwriter Model 5530 Board G9BNB Internal DIP 
Switch Settings 

Dip Switch 

DIPS1 SW5 

SW6 

SW7 

SW8 

DIPS3 SW2 

SW5 

SW6 

Option 

Test Printing 

Local/Remote 

Line Feed Pitch 

Line Spacing 

Local Line Feed 

Auto Return 

Spacing Pitch 

Setting 

Off 

On (remote) This 
switch must be Off if 
the 5530 has a front 
panel 

Off (6 lines per inch) 

Off (single spacing) 

Off 

Off (auto return off) 

Off (10 characters 
per inch) 

Table B-15 lists the front panel switch settings for the Models 3530, 5530, 
and 7730. 
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Table B-15. Spinwriter Models 3530, 5530, and 7730 Front Panel Switch 
Settings 

Model Dip Switch Setting 

3530 DIPS2 SWI Off - 6 lines per inch 

SW2 and SW3 Off -10 char. per 
inch 

SW4 Off - constant spacing 

DIPS3 SW2 Off - single line feed 

SW3 Off - normal opera-
tion 

5530 N/A Test Off 

LPI (lines per inch) Must be 6 

Single/Double Must be Single 

Remote/Local Must be Remote 

7730 DIPSI SW6 and SW7 Off - buffer length 
163 characters 

DIPS2 SW6 Off - normal opera-
tion 

DIPS3 SWI Off - normal opera-
tion 

SW2 Off - constant spacing 

SW3 Off - 6 lines per inch 

SW4 Off - single line 
spacing 

QUME SPRINT 5/45, 9/45, and 11/40 PLUS 

The VisiTrend/Plot program supports the Qume Sprint models 5/45, 
9/45, and 11140 PLUS with the Apple II Serial Interface card, the Apple II 
Communications Interface card, and the Apple II Super Serial Interface 
card. 

If your serial interface card has the P8 PROM, the maximum baud rate is 
300. With the P8A PROM the maximum baud rate is 1200. 

For operation with an unmodified Apple II Communications Interface 
card, the maximum baud rate is 300. During printing the data may also 
appear on the screen. When printing is completed, the screen image 
returns to normal. 
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For operation with the Apple II Super Serial Interface card, the max­
imum baud rate is 9600 for models that support that baud rate, and 1200 
baud for models that do not support 9600 baud. 

Table B-16 lists the printer switch settings for the model S/4S. Refer to 
your printer manual for the settings for models 9/4S and 11140 PLUS. Table 
B-17 lists the Apple II Serial Interface card switch settings for all three 
models. 

Table B-16. Qume Sprint Model 5/45 Printer External Switch Settings 

Switch Setting 

Auto LF Off 

Char. Spacing Must be 10 

Table B-17. Apple II Serial Interface Card Switch Settings When 
Used With the Qume Sprint 5/45, 9/45, and 11/40 PLUS Printer 

Switch Option 

SWS,6 Paper Size 

Switch Setting 

User choice (Must not be set to 
On/On) 

With the Apple II Super Serial card, the printer and interface card 
should be set up as suggested in the Apple II Super Serial Card Installa­
tion and Operating Manual for printer mode. Be sure that the baud rates 
on the printer and interface cards are the same, and that the jumper block 
is pointing toward TERMINAL. Table B-18 lists the switch settings for the 
Apple II Super Serial Interface card. 

Table B-18. Apple II Super Serial Interface Card Switch Settings 

Dip Switch Option Switch Setting 

DIPS 1 SWS,6 Mode Off/ on for printer 
mode 

DIPS2 SW3,4 Line width and video Offloff for 132 
char/line and video 
off 

TRENDCOM 200G 

No setup is required. Use the printer driver that matches your con­
figuration. 
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THE VISITRENDIPLOT™ INTERNAL DATA 
FORMAT 

VisiTrend/Plot data series can be stored in either of two formats: the 
VisiTrend/Plot data format and the DIF format. Data is stored in the 
VisiTrend/Plot data format when you select NORMAL from the SAVE for­
mat menu. It is stored in the DIF format when you select DIF. Data in the 
DIF format can be used by other VisiCorp programs. 

The VisiTrend/Plot data format is described in this appendix. The DIF 
format is described in Appendix D. 

A VisiTrend/Plot data file is a sequential text file which is described in 
The DOS Manual, Apple number A2L0036. The fields are variable 
length and each field is terminated with a RETURN. The following list 
contains a description of the contents and, in parentheses, the limitations 
on and expected contents of the fields. 

The fields of a data file are: 

Number of series (1-16) 

Series name (string - up to 14 characters) 

Number of data points (1-150) 

Periodicity (1-99) 

Start year (0-2500) 

Start period (I-periodicity) 

End year (1-2649) 

End period (I-periodicity) 

Data point 1 

Data point 2 

Data point n 

C-l 
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The following is the listing of a sample file containing two series, named 
FIRST and SECOND. FIRST has a period of 1 and contains five data points 
beginning at date 1. The values of the data points are 100, 200, 300, 400, 
and 500. SECOND has a period 1 and contains three data points beginning 
at date 1980. The values of the data points are 1111, 2222, and 3333. 

2 

FIRST 

5 

1 

1 

1 

5 

1 

100 

200 
,300 

400 

500 

SECOND 

3 

1 

1980 

1 

1982 

1 

1111 

2222 

3333 

Number of series in file 

Series name 

Number of data points 

Periodicity 

Start year 

Start period 

End year 

End period first series 

Data points 

Second series 
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GUIDE 

EXCHANGING FILES 

APPENDIX D 

NOTE: the technical information in this appendix is for 
VisiTrendiPlot users who are programmers and who wish to in­
clude or manipulate DIF -formatted data in their own programs. 

Non-programmers who need to exchange DIF files between the 
VisiTrendiPlot program and other products· ·such as the 
VisiCalc . program, normally do not . require the level of detail 
presented in this appendix. The end of Lesson Two demon­
strates two examples of how to transfer a DIF file between the 
VisiCalc and VisiTrend/Plot programs. 

The DIFTM format is a standard file format that allows unrelated programs 
to share data. A file saved in the DIF format is a text file that can be read 
by other DIF-supporting programs. Thus, a data series created by the 
VisiTrend/Plot program can be saved in the DIF format and read by other 
programs that support DIF. 

This appendix describes the file format and lists three sample programs 
in Applesoft BASIC that retrieve and save DIF files. 

THE DIF FORMAT 

The DIF format stores data in a form accessible to programs other than 
the VisiTrend/Plot program. To accommodate a wide range of languages 
in which such a program might be written, several simplifying techniques 
have been used: 

• Information about the size of the file is provided at the beginning. 

• Records are kept as short as possible. 

• The data type (string or number) of each value is explicitly defined. 

• Strings are stored one per line. 

• Strings that contain special characters are enclosed in quotation 
marks. 

• The file ends with an explicit End-Of-Data record. 

0-1 



VISITRENDIPLOT™ ~tT~~S APPLE II 
APPENDIX D 

Figure 0-1 shows a sample data series created in the VisiTrend/Plot 
program. Before this data series could be used by another program, such 
as VisiCalc, it would have to be saved in a OIF file in the VisiTrend/Plot 
program. 

Date XYZ Fund 

1980 1 227.16 
2 272.73 
3 317.71 
4 329.13 
5 378.24 
6 345.06 

1981 1 428.38 
2 496.02 
3 443.15 
4 485.82 
5 489.03 
6 503.32 012·014 

Figure D-I. Sample VisiTrend/Plot Data Series 

The OIF format stores the data in a series of slices; it can be sliced 
either h~rizontally (by rows) or vertically (by columns). Each of these 
slices is called a tuple; each slice along the other axis is called a vector. 
In the sample data series in Figure 0-1, the row formed by 80, I, and 
277.16 is a tuple; the column beginning with 1 is a vector; and the row of 
values beginning with 277.16 is another vector. 

A OIF file consists of a series of header records that describe the file, 
followed by one set of data records for each tuple, and ends with a pair of 
End-Of-Oata records. When the data series shown in Figure 0-1 is saved 
in the OIF format, it would be laid out as shown in the following three 
diagrams. 
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HEADER 
The header consists of four sets of three records that give information 

abou t the en tire file: 

TABLE 1---------
0.1 

TUPLE.OIF r--------
VECTORS r--------

r~~------
1---------

TUPLES r--------
0.12 ---------

LABEl 

1.1 ---------
TUPLE 

PERIOOICITY ---------
1.6 ---------
6 

MAJORSTART 

1980 

MINORSTART 

1.1 ---------
1 ---------
TRUELENGTH 

_~~3 ____ _ 
12 ---------
OATA ---------
0.0 ---------

DATA RECORDS 
The data records consist of a pair of header records that identify the 

beginning of a tuple, and a pair of records for each value in the tuple: 

-1.0 ---------
BOT ---------
0.277.16 ---------
V ---------
-1.0 ---------

BOT 

O. 317.71 ---------
V 

1.0 ---------
BOT ---------
0.329.13 ---------
v ---------

BOT 

0.503.32 
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END-OF-DATA RECORDS 

The End-Of-Data records mark the end of the file: 

WORKING WITH DIF FILES 

The following three programs demonstrate how BASIC programs 
might be written and used with the DIF format. They perform the follow­
ing functions: 

• Dump a DIF file just as it is stored, record by record. 

• Print a DIF file that contains a data series. 

• Create a DIF file by prompting for the file entries. 

DUMPING A DIF FILE 

This program prints the DIF file just as it is stored, record by record. It 
asks for the name of the file, and whether to print it. If not instructed to 
print the file, the program displays the file on the screen: 

100 • *u***u*u****u**u* 
110 • * INITIALIZATION * 
120 • ********************** 
130 NUL$ = CHR$(34) + CHR$(34) 
140 FALSE = 0 
150 TRUE = -1 
440 • 
450 • 

460 • ********************** 
470 • * MAIN ROUTINE * 
480 • ********************** 
490 • 
500 60SUB 1000' 
510 60SUB 1200 
520 60SUB 1400' 
530 60SUB IbOO' 
540 END 
940 • 
950 • 

960 • ********************** 
970 • * PROMPT FOR ORDERS * 
980 • ********************** 
990 • 
1000 CLS 
1010 INPUT "Filename: ",FILENAME$ 

* PROMPT FOR ORDERS * PRINT HEADER * PRINT DATA RECORDS * END-OF-PROGR~ CLEANUP 

1020 IF RI6HT$(FILENAttE$,4) <> ".DIF" THEN FILENAtE$ = FILENAtE$ + ".DIF" 
1030 INPUT "Print the file (Y or N): ",REPLY$ 
1040 IF REPLY$ = "Y" OR REPLY$ = "y" THEN HARDCOPY = TRlE 
1050 OPENFILENAME$ FOR INPUT AS .1 
lObO IF NOT HARDCOPY THEN CLS 
1070 IF HARDCOPY THEN LPRINT FILENAI'E$: LPRINT .. ":LPRINT ELSE PRINT FILENAtE$:P 
RINT:PRINT 
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1080 RETURN 
1140 ' 
1150 ' 

1160 ********************** 
1170 ' * PRINT HEADER * 
1180 ' ********************** 
1190 ' 
1200 INPUT #1, TITLE$ 
1210 INPUT #1, TYPE, NUMBER 
1220 INPUT #1, STRNG$ 

VISITREN DIPLOT™ ~~~~~s 

1230 IF HARDCOPY THEN LPRINT TITLE$:LPRINT TYPE; -,-; NUMBER ELSE PRINT TITLE$:P 
RINT TYPE; ","; NUMBER 
1240 IF STRNG$ = "" THEN IF HARDCOPY THEN LPRINT NlI...$ ELSE PRINT NUL$ ELSE IF HA 
RDCOPY THEN LPRINT STRNG$ ELSE PRINT STRNG$ 
1250 IF TITLE$ <> "DATA" THEN 1200 
1260 IF NOT HARDCOPY THEN GOSUB 2000 
1270 RETURN 
1340 
1350 ' 

1360 ********************** 
1370 * PRINT DATA RECORDS * 
1380 ********************** 
1390 
1400 INPUT #1, TYPE, NUMBER 
1410 INPUT #1, STRNG$ 
1420 IF CSRLIN > 20 AND NOT HARDCOPY THEN GOSUB 2000 
1430 IF HARDCOPY THEN LPRINT TYPE; ..... ; NUMBER: LPRINT STRN6$ ELSE PRINT TYPE; • 
,"; NUMBER: PRINT STRNG$ 
1440 IF STRNG$ <> "EOD" THEN 1400 
1450 RETURN 
1530 ' 
1540 ' 
1550 ' 
1560 • 
1570 • 
1580 
1590 ' 

********************** * END-OF-PROGRAM * * CLEANUP * 
********************** 

1600 CLOSE 1 
1610 RETURN 
1920 ' 
1930 ' 

1940 ' ********************** 
1950 ' * PRINT * 
1960 ' * "RETURN FOR MORE" * 
1970 • * MESSAGE AT BOTTOM * 
1980 ' ********************** 
1990 ' 
2000 LOCATE 24,1 
2010 PRINT "RETURN for more"; 
2020 REPLY$ = INPUT$(l)' 
2030 CLS 
2040 RETURN 

* WAIT UNTIL ANY KEY IS PRESSED 
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PRINTING A DATA FILE FROM A DIF FILE 

The following program prints the data series exactly the way it looks in 
the DIF formaL It asks for the name of the file in which the data series was 
saved in the DIF format, the width of columns to be printed, and whether 
the data series was saved by rows or by columns: 

60 • ********************** 
70 * INITIALIZATION * 
80 ' ********************** 90 • 
100 DIM WORKSHEET(50,50) 
110 FALSE = 0 
120 TRUE = -1 
130 BYROWS = FALSE 
440 ' 
450 
460 7 ********************** 
470 • * MAIN ROUTINE * 
480 ********************** 
490 • 
500 SOSWB 1000' 
510 SOSUB 1200' 
520 SOSUB 1400' 
530 IF NOT FILEBAD THEN SOSUB 1600' 
540 SOSUB 1800' 
550 END 
940 • 
950 • 

960 ' ********************** 
970 • * PROMPT FOR ORDERS * 
980 • ********************** 
990 ' 
1000 CLS 
1010 INPUT "File name: ", FILENAMES 

* PROMPT FOR ORDERS * READ HEADER * READ DATA RECORDS * PRINT THE WORKSHEET * END-OF-PROSRAM CLEANUP 

1020 IF RI6HTS (FILENAMES, 4) < > ". DIF" THEN FILENAMES = FILENAMES + ". DIF" 
1030 INPUT "Column width: ",COLUMNWIDTH 
1040 INPUT "Saved by row or column (R or C): ",REPLYS 
1050 IF REPLYS = "R" OR REPLY$ = "r" THEN BYROWS = TRUE 
1060 INPUT "Print the worksheet (Y or N): ",REPLYS 
1070 IF REPLYS = "Y" OR REPLY$ = "y" THEN HARDCOPY = TRUE 
lOBO OPEN FILENAMES FOR INPUT AS #1 
1090 RETURN 
1140 ' 
1150 
1160 • ********************** 
1170 * READ HEADER * 
1180 ' ********************** 
1190 
1200 INPUT #1, TITLES 
1210 INPUT #1, TYPE, NUMBER 
1220 INPUT #1, STRNSS 
1230 IF TITLES = "VECTORS" THEN VECTORS = NUMBER 
1240 IF TITLES = "TUPLES" THEN TUPLES = NUMBER 
1250 IF TITLES = "DATA" THEN RETURN 
1260 SOTO 1200 
1340 
1350 ' 
1360 • ********************** 
1370 • * READ DATA RECORDS * 
1380 ********************** 
1390 • 
1400 FOR ROW = 1 TO TUPLES 
1410 INPUT #1, TYPE, NUMBER 
1420 INPUT #1, STRNSS 
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1430 IF TYPE <> -lOR STRNS$ <> "BOT" THEN 
SOSUB 2000: 
RETURN 

1440 FOR COL = 1 TO VECTORS 
1450 INPUT .1, TYPE, NUMBER 
1460 INPUT .1, STRNS$ 
1470 IF TYPE <> 0 AND TYPE <> THEN 

SOSUB 2000: RETURN 
1480 IF BYROWS THEN IF TYPE = 0 THEN WORKSHEET$(COL,ROW) = STR$(NUMBER) 
ELSE WORKSHEET$(COL,ROW) = STRNS$ ELSE IF TYPE = 0 THEN WORKSHEET$(ROW,COL) = ST 
R$(NUMBER) ELSE WORKSHEET$(ROW,COL) = STRNS$ 
1490 NEXT COL 
1500 NEXT ROW 
1510 RETURN 
1540 7 

1550 7 

1560 7 ••••••• **** ••••••••• *. 
1570 7 • PRINT THE WORKSHEET* 
1580 7 ••••••••••••••••• * •••• 
1590 7 

1600 IF BYROWS THEN WDTH = TUPLES: DEPTH VECTORS ELSE WDTH VECTORS: DEPTH 
TUPLES 
1610 FOR ROW = 1 TO DEPTH 
1620 FOR COL = 1 TO WDTH 
1630 IF HARDCOPY THEN LPRINT WORKSHEET$(ROW,COL); TAB(COL.COLUMNWIDTH); 
ELSE PRINT WORKSHEET$(ROW,COL); TAB(COL.COLUMNWIDTH); 
1640 NEXT COL 
1650 IF HARDCOPY THEN LPRINT " " ELSE PRINT 
1660 NEXT ROW 
1670 RETURN 
1730 7 

1740 7 

1750 •••••• ** ••••••••••• * •• 
1760 7 * END-OF-PROGRAM • 
1770 7 * CLEANUP * 
1780 * ••• **.*.* •••••••••••• 
1790 
1800 CLOSE 1 
1810 RETURN 
1940 7 

1950 7 

1960 7 * ••• *.* •••••••• ******* 
1970 • ERROR IN FILE * 
1980 7 .***********.****.**** 
1990 7 

2000 PRINT 
2010 BEEP: PRINT "ERROR IN FILE . . • " 
2020 PRINT TAB(5); "TYPE ="; TYPE 
2030 PRINT TAB(5); "NUMBER ="; NUMBER 
2040 PRINT TAB(5); "STRING = "; STRNG$ 
2050 FILEBAD = TRUE 
2060 RETURN 
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CREATING A DIF FILE OUTSIDE OF 
THE VISITREND/PLOT PROGRAM 
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The following program prompts for VisiCalc worksheet entries (by 
row-column coordinate), then writes the entries on a disk in a DIF file. 
Either a string or number (integer or real) can be entered. To enter a 
label that starts with a number, type a quotation mark (") as the first 
character of the label. To end a row, type ESC then press RETURN; to 
end the worksheet, type ESC then press RETURN. 

The program assumes the coordinate of the lower-right corner of the 
worksheet is the row-column coordinate of the location immediately to 
the left of the coordinate where ESC-ESC is typed, so the last row should 
be at least as wide as all preceding rows. The worksheet is saved by rows: 

60 ' ********************** 
70 ' * INITIALIZATION * 
80 ' ********************** 
90 ' 
100 ESC$ = CHR$(27) 
110 LASTINROW$ = ESC$ 
120 LASTONSHEETS = ESCS + ESCS 
130 QUOTES = CHRS(34) 
140 NUL$ = QUOTE$ + QUOTE$ 
150 CLSCREEN$ = CHR$(12) 
160 ROW = 1 
170 COL = 1 
180 FALSE = 0 
190 TRUE = -1 
200 DIM WORKSHEETS(50,50) 
440 ' 
450 

460 ' ********************** 
470 * MAIN ROUTINE * 
480 ' ********************** 
490 ' 
500 GOSUB 1000' 
510 GOSUB 1200' 
520 GOSUB 1400' 
530 GOSUB 2000' 
540 END 
940 ' 
950 ' 
960 ' ********************** 
970 ' * PROMPT FOR ORDERS * 
980 ' ********************** 
990 ' 
1000 PRINT CLSCREENS 

* PROMPT FOR ORDERS * PROMPT FOR ENTRIES . * WRITE FILE * END-OF-PROGRAM CLEANUP 

1010 INPUT "Write the file (Yor N): ",REPLYS 
1020 IF REPLY$ = "Y" OR REPLYS = "y" THEN DISKCOPY = TRUE 
1030 IF DISKCOPY 

THEN INPUT "File name: ",FILENAMES: 
IF RIGHTS (FILENAMES, 4) < > ". DIF" THEN FILENAMES = FILENAI'IES + ". DIF 

1040 RETURN 
1140 ' 
1150 ' 
1160 ' ********************** 
1170 ' * PROMPT FOR ENTRIES * 
1180 ' ********************** 
1190 ' 
1200 PRINT CLSCREENS 
1210 WORKSHEETS (ROW, COL) = .... 
1220 PRINT "Row"; ROW; .. , Column ";CHRS(64+COL); ". "; 
1230 REPLYS = INPUTS(1) 
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1232 IF REPLY$ = CHR$(8) THEN IF LEN(WORKSHEET$(ROW,COL» > 0 THEN PRINT CHR$(29 
) ;" .. ; CHR$ (29) ; : WORKSHEET$ (ROW, COL> = LEFT$ (WORKSHEET$ (ROW, COL> , LEN (WORKSHEET$ (R 
OW,COL»-l):GOTO 1230:ELSE GOTO 1230 
1240 IF REPLY$ <> CHR$(13) 

THEN PRINT REPLY$;: WORKSHEET$(ROW,COL) = WORKSHEET$(ROW,COL) + REPLY$: 
GOTO 1230 
1250 PRINT 
1260 IF WORKSHEET$(ROW,COL) = LASTONSHEET$ 

THEN WDTH = COL - 1: DEPTH = ROW: RETURN 
1270 IF WORKSHEET$(ROW,COL) = LASTINROW$ 

THEN ROW ROW + 1: COL = 1: PRINT:GOTO 1210 
1280 COL = COL + 1 
1290 GOTO 1210 
1310 ' 
1320 ' 
1330 ' ********************** 
1340 ' * WRITE FILE * 
1350 ' ********************** 
1360 ' 
1370 ' ----------------------
1380 HEADER 
1390 ' ----------------------
1400 IF NOT OISKCOPY THEN RETURN 
1404 OPEN "0", 1, FILENAME$ 
1410 PRINT #1, "TABLE" 
1420 PRINT #1, 0; ","; 1 
1430 PRINT #1, NUL$ 
1440 PRINT #1, "VECTORS" 
1450 PRINT #1, 0; ","; DEPTH 
1460 PRINT #1, NUL$ 
1470 PRINT #1, "TUPLES" 
1480 PRINT #1, 0; ","; WDTH 
1490 PRINT #1, NUL$ 
1500 PRINT #1, "DATA" 
1510 PRINT #1, NOU;L$"'''; 0 
1520 PRINT #1, 
1540 ' 
1550 ' ----------------------
1560 ' DATA RECORDS 
1570 ' ----------------------
1580 FOR COL = 1 TO WOTH 
1590 PRINT #1, -1; ..... ; 0 
1600 PRINT #1, "BOT" 
1610 FOR ROW = 1 TO DEPTH 
1620 IF VAL(WORKSHEET$(ROW,COL» > 0 THEN 

PRINT #1, 0; ","; VAL(WORKSHEET$(ROW,COL»: PRINT #1, "V":GOTO 1 
660 
1630 IF LEFT$ (WORKSHEET$ (ROW, COL) ,1) = QUOTE$ THEN 

WORKSHEET$(ROW,COL) = MID$(WORKSHEET$(ROW,COL),2) 
1640 PRINT #1, 1; .. , .. ; 0 
1650 PRINT #1, QUOTE$; WORKSHEET$(ROW.COL); QUOTE$ 
1660 NEXT ROW 
1670 NEXT COL 
1680 ' 
1690 ----------------------
1700 ' END-OF-DATA 
1710 ----------------------
1 720 PR I N r # 1, -1; ..... ; 0 
1730 PRINT #1, "EOD" 
1740 RETURN 
1930 
1940 ' 
1950 ********************** 
1960 * END-OF-PROGRAM * 
1970 * CLEANUP * 
1980 ' ********************** 
1990 ' 
2000 CLOSE 1 
2010 RETURN 
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CONSIDERATIONS WHEN TRANSFERRING 
TO THE VISICALC PROGRAM 

When transferring VisiTrend/Plot program data to the VisiCalc pro­
gram, there are certain considerations you should observe in your 
VisiTrend/Plot data series. 

• The VisiCalc program uses a matrix of 63 rows by 252 columns. 

• A data series DIF file that exceeds 63 time units must be read into the 
VisiCalc program by columns. 

• A file that contains more than 252 time units exceeds the VisiCalc 
capability. 
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GLOSSARY 

This manual uses some terms that might be new to you or that you cur­
rently use in a different way. This glossary will help you to get acquainted 
with the precise meaning of these important terms. 

Argument: The value(s) that a function needs to calculate its own value. In 
the VisiTrend/Plot program you can use series as arguments to functions. 

Boot: The process of loading and starting up a computer program. 

Chart: The output of the plotting program. The graphic representation of 
one or more data series. 

Command or Option: An order given to the computer program. In the 
VisiTrend/Plot program, commands or options are issued by selecting a 
menu item. 

Cursor: A white block on the screen used to point to items in menus and 
lists. The cursor is controlled with the two arrow keys and the space bar in 
menus and by just the two arrow keys in lists. When the cursor is pointing 
to an item, the item is displayed in dark letters against the white 
background. 

Data Point: A numeric value that is associated with a major start date 
(year) or reference point, and a minor start (period). In most charts, the 
value is plotted against the Y-axis and the time against the X-axis. Data 
points, along their associated date or reference point, make up a series. 

Date: A value indicating a year or point within a year. A date or reference 
point is associated with every data point. 

Default: Responses or values that are already stored in the program. If you 
do not enter different values or responses, the program uses the built-in 
defaults when you begin a new session. 

DIFTM: Acronym for d&ta interchange format, a data format that is readily 
transferable to other computers and different computer programs. The 
VisiTrend/Plot program uses DIF to exchange data with VisiCalc and other 
VisiSeries programs. 

DOS: Disk Operating System. DOS 3.3 is an Apple II operating system 
that uses the capabilities of the disk drives together with the storage media 
from which they read and to which they write. 
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Exponential Smoothing: A forecasting technique to show trends in a data 
series by generating a new series giving preference to the current data 
and forecast. 

File: A collection of data on a floppy diskette. A file can contain from 1 to 
16 series but not more than 645 data points. 

Function: The operation or processing the program does in response to a 
command or option. 

Grid: Horizontal and vertical lines on a chart used as an aid in deter­
mining the value of a point or bars. In the VisiTrend/Plot charts, grid lines 
are series of small dots, light against a dark background and dark against a 
light background. 

Intersection of the Range: The range of data points in two or more series 
that are common to all of the series. 

Inverse Video: The display of black letters on a white background. The 
normal format in a display is white letters on a black background. 

Least Squares: See Linear Multiple Regression. 

Linear Multiple Regression: A method of developing an equation that 
relates a dependent variable, such as a company's sales, to one or more 
independent variables, such as inventory, economic indexes, competi­
tion, etc. The result is a means of explaining the dependent variable. 
Linear multiple regression in the VisiTrend/Plot program uses the ordinary 
least squares method. The method produces an equation consisting of a 
constant and independent coefficients that reproduce historical data with 
the smallest error, where error is the sum of the squares of the residuals 
(SSR). 

List: A display that offers a collection of data items, one or more of which 
are selected with the cursor, the space bar, and the RETURN key. 

Memory: The temporary storage area within your computer. 

Menu: A display that offers two or more command choices or options. The 
items in a menu are selected with the cursor and the RETURN key. An item 
can also be selected by typing the first two letters of the item name. 

Menu Item: A command choice or option that is offered in a menu. A 
menu item is selected with the cursor and the RETURN key, or by typing 
the first two characters of the item name. 
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Moving Average: An average taken over a specified number of points in a 
series. A series made up of moving averages may illustrate trends that are 
obscured by erratic peaks or valleys in the data. 

Overlay: An option in the Plot subprogram that allows you to plot addi­
tional series on an existing chart. With overlays, you can mix chart types 
(except Pie and XY charts), plot multiple series on a single chart, and 
create comparison plots on a single chart. 

Period or Periodicity: The frequency at which data points occur within a 
year. A period of 1 means the data is shown on a yearly basis. A period of 
12 means the data is shown on a monthly basis. 

Point: See Data Point. 

Prompt: A message, in or just above the status area, that either describes 
your next action(s) in the program or explains the meaning of a com­
mand in a menu. 

Range: The period of time covered by a series or the scope of the series. 
The range is the beginning date (and period) to the ending date (and 
period). 

Reference Point: A value associated with a data point in a series. Either 
a reference point value or a date must be associated with every data 
point. 

Scale: The scope of values normally covered by the Y-axis of a chart. A 
scale usually, but not always, covers the highest and lowest values in a 
series. 

Series: A collection of data points in sequence, usually time. A series is 
the basic unit of data that the VisiTrend/Plot program uses in memory. A 
series has a name. Up to 16 series can be stored in a file on diskette. 
Memory can hold a maximum of 16 series or 645 data points. 

Slot: A long narrow rectangular socket with the printed circuit edge con­
nectors, intended to receive the plated "fingers" of a printed circuit 
board such as a printer or drive controller card. There are 8 slots in your 
Apple II computer, numbered from 0 to 7 on the right side. 

Smoothing: A trending enhancement that performs an exponential com­
putation on the source series. The smoothing computation is based on the 
most current data point and current forecast. 

Time Series: See Series. 
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Union of the Range: The range of data points in two or mores series that 
begins with the earliest data point in all series and ends with the latest 
data point in all series. 

X-Axis: The horizontal axis of a chart. VisiTrend/Plot plots the range of 
dates on the X-axis (except on XY charts). 

Y-Axis: The vertical axis of a chart. VisiTrend/Plot plots the data point 
values on the Y-axis. 
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# 2-3 
* 2-93, 3-2, 3-4, 3-43, 3-52 
+ 2-93, 3-52 
- 2-93, 3-52 
/ 2-93, 3-52 
< 2-93, 3-52 
+- 2-93, 3-52 

2-93, 3-52 
> 2-93, 3-52 
- 2-93, 3-52 
@ 2-12, 3-21, 3-44, 3-50 
\ 3-53 
] 1-10, 2-47, 3-4, 3-37 
1\ 2-93, 3-52 
[ALL], 2-42 
[KEEP ALL], 2 -45 
[KEEP NONE], 2-45 
[MORE], 2-30 
[NEW FILE], 2-29, 2-43, 2-129, 

3-43 
[NEW SERIES], 2-57 
[NONE], 2-30, 2-42 
[SAME], 2-105, 3-33 
[TREND], 2-84, 3-38 

A 
ABS, 2-94, 3-52 
Absolute value, 2-94, 3-52 
Adding 

detail to a chart, 2-8, 3-33 
values to a series, 2-59, 2-62, 

2-68, 3-24 
Address 

drive, 2-37, 3-5, 3-17 
slot, 2-37, 3-5, 3-17 

Agreement, Customer License, 
1-12 

Analysis display, regression, 
2-82 

ANALYZE, 2-75, 3-12 
Analyze menu, 2-75 

Index-l 

INDEX 

AND, 2-93, 3-52 
Annotations, creating on 

charts, 2-125, 3-49 
Apple II requirements, 1-7 
Apple Silentype, 2-28 
Applesoft BASIC, 1-7, 0-1 
Applesoft functions, 1-7, 2-94 
Applesoft ROM, 1-7 
AREA, 3-12 
Area charts, 1-4, 3-12 
Areas, status, 1-12, 3-4 
ARITH, 2-65, 3-12 
Arithmetic operators, 2-93, 

3-52 
Arrow keys, 2-126, 3-3, 3-49 
Asterisk (*), 2-93, 3-2, 3-4, 

3,.43, 3-52 
ATN, 2-94, 3-53 
Arctangent, 2-94, 3-53 
Average, aritmetic mean, 2-78 
Average, moving, 2-75, 2-86, 

2-91, 3-29 
Axes, 2-4 

removing labels on, 3-51 

B 
BACKGR, 3-12 
Background colors, 3-12 
BAR, 3-14 
Bar 

chart, 1-3, 2-6, 3-14 
format types, 2-24, 3-14 
menu, 2-6 
widths, 2-6, 3-26, 3-33, 3-42 

BOLD, 3-14 
Bold typeface, 2-10, 2-127, 

3-14 
Booting the program, 1-9, 3-37 
Borders, chart, 2-26 
BOTH, 3-14 
Bringing back the legend, 

2-12, 3-27 
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c 
Calculating the range 2-17 

2-82, 3-7 " 
Calculating the scale, 2-17, 3-8 
Calculating series statistics 

2-75, 2-78, 3-46 ' 
CANCEL, 2-16, 2-19, 2-31, 

2-112, 3-15 
Cancelling moving titles, 2-15, 

3-15, 3-29 
Care of diskettes, 1-8 
Change, percent of, 2-15, 

2-90, 3-35 
Changes, removing, 2-60, 

2-64, 3-51 
Changing 

data drive number, 3-17 
fixed titles, 2-12, 2-16 
moveable titles, 2-15 
printer driver, 2-29, 3-16, 

3-19, B-2 
range, 2-21, 3-8, 3-31, 3-44 
scale, 2-18, 3-8, 3-42 
series specifications, 2-62, 

3-33, 3-46 
slot number, 3-45 

Characters 
erasing during data entry, 

2-10, 2-57 
erasing in formulas, 2-95, 

3-53 
erasing in Text mode, 2-127 

3-49 ' 
superscript and subscript, 

2-128 
Chart Types 

AREA, 1-4, 3-12 
BAR, 3-14 

comparative, 2-107 
single, 1-3, 2-106 
stacked, 2-109, 3-14 

Combined, 1-6 
HI-LO-CL, 1-5, 3-23 
LINE, 1-3, 3-27 

single, 1-3, 2-101 
three-line, 2-103 
two-line, 2-102 
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PIE, 1-4, 2-123, 3-35 
XY, 1-5, 2-117, 3-54 

INDEX 

Charts 
adding detail to, 2-8, 3-34 
annotating, 2-125, 3-49 
borders on, 2-26 
displaying two, 2-118, 3-51 
drawing, 2-3, 2-100, 3-36 
formatting, 2-23, 3-14, 3-22, 

3-27, 3-36, 3-47 
overlaying, 2-108, 3-34 
plotting, 2-3, 2-100, 3-36 
printing, 2-28, 3-36 
ranges, 2-17, 3-6, 3-31, 3-44 
removing axis labels on, 3-51 
removing legends on, 3-21, 

3-50 
rescaling, 2-18, 2-104, 3-42 
restoring legends on, 2-12, 

3-27, 3-50 
retrieving screen images of, 

2-30, 2-126, 3-28 
saving on diskette, 2-29, 

2-129, 3-42 
selecting types of, 2-2, 3-44 
titling, 2-9, 3-50 
type code, 3-27 
well-scaled, 2-20 

CLEAR, 2-44, 2-74, 3-15 
Clearing series from memory, 

2-44, 2-74, 3-15 
Clearing the screen 

current chart and options, 
3-33 

in text mode, 2-129, 3-49 
Codes 

chart type, 3-27 
color, 2-4, 3-5, 3-15 
legend, 2-5, 3-27 
window, 2-120, 3-5, 3-51 

Coefficients of correlation 
2-15, 2-78 ' 

COLOR,3-15 
Color codes, 2-4, 3-5, 3-15 
Color menu, 3-16 
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Colors 
background, 3-12 
black-&-white 

representation, 3-5 
compatible, 3-16 
default, 3-16 
plotting, with BACKGR, 

3-13 
plotting, with COLOR, 3-15 

Column width, 2-63, 2-67, 3-21 
Commands affecting files and 

series, 2-46 
Commands, see Menu items 
Commands, edit, 2-57, 3-20 

DELETE, 2-62, 2-68, 3-17 
EDIT, 2-64, 2-74, 3-20 
EXIT, 2-60, 3-20 
FILL, 2-65, 3-20 
FORMAT, 2-63, 2-67, 3-21, 

3-22 
INSERT, 2-62, 2-68, 3-24 
JUMP, 2-61, 2-66, 3-24 
PRINT, 2-64, 3-36 
SPECS, 2-62, 3-46 
UNDO, 2-64, 3-51 

Comparative Bar chart, 2-107 
Comparative operators, 2-93, 

3-52 
Computed series 

creating, 2-75 
default name extensions, 

2-81, 2-86, 2-95, 3-6 
Computer requirements, 1-7 
Configuration, 1-7 
Constant, using in regression, 

2-80, 3-38 
CONTINUE, 3-16 
Controller card, disk, 1-7 
Conventions, naming, 2-81, 

2-86, 3-2, 3-6 
Converting an N + 1 moving 

average 
to a Centered moving 

average, 3-31 
to an N moving average, 

3-30 
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Copyright notice, 1-12 
Correlation coefficients, 2-75, 

2-78 
Correlation of series values, 

1-5, 2-117 
Corvus Hard Disk, 1-11 & 

shaded information 
COS, 2-94, 3-53 
Cosine, 2-94, 3-53 
Count of items in series 

calculations, 2-78 
Creating 

annotations and text pages, 
2-125, 3-49 

computed series, 2-75, 2-81, 
2-86, 2-95, 3-6 

data diskettes, 2-41, 3-22 
DIF files, 2-48, D-4 
series data, 2-57, 3-20 

CTRL key, 3-3 
CTRL-@, 2-129, 3-3, 3-49 
CTRL-A, 2-128, 3-3, 3-49 
CTRL-B, 2-127, 3-3, 3-49 
CTRL-C, 2-64, 3-3, 3-37 
CTRL-I, 2-130, 3-3, 3-49 
CTRL-L, 2-127, 3-3, 3-49 
CTRL-O, 2-127, 3-3, 3-49 
CTRL-R, 2-131, 3-3, 3-49 
CTRL-Z, 2-128, 3-3, 3-49 
Current series, 2-4 
Cursor, 1-12, 3-5 
Cursor movement, changing, 

2-128 
Cursor-moving keys, 3-3 

arrows, 1-12, 2-66, 2-126, 
3-3, 3-24 

CTRL-I, 2-130, 3-3, 3-49 
CTRL-L, 2-127, 3-3, 3-49 
CTRL-O, 2-127, 3-3, 3-49 
RETURN, 2-126, 3-2, 3-49 
space bar, 1-12, 2-127, 3-2, 

3-49 
Customer Licence Agreement, 

1-12 
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D 
Data 

deleting files, 2-46, 3-17 
disk drive identifier, 2-37, 

3-5, 3-17 
disk drive, changing, 3-17 
diskette, formatting a, 2-41, 

3-22 
diskettes, caring for, 1-8 
entry, 2-57 
formatting, 2-63, 2-67, 3-21 
interchange format 2-42 

2-48, 3-19, D-l' , 
internal formats, 3-33, C-l 
loading, 2-1, 2-100, 3-28 
off-scale during overlays, 

2-).12, 3-37 
points 

adding, 2-59, 3-12, 3-24 
deleting, 2-62, 2-68, 3-17 
inserting, 2-62, 3-12, 3-24 
maximum number of, 2-65, 

3-1 
replacing, 2-59, 3-24 

record, D-l 
saving, 2-29, 3-42 
series, 2-2, 2-57 
strings, D-l 
type, D-l 

Date 
series start, 2-3, 2-22, 3-46 
series end, 2-3, 2-22 

DEFAULT, 3-16 
DELETE, 2-62, 2-68, 3-17 
Deleting 

data points, 2-62, 2-68, 3-17 
editing changes, 2-64, 3-51 
files from diskette, 2-46, 3-17 
series from diskette 2-43 

3-43 " 
series from memory, 2-44, 

3-15, 3-51 
Detail, adding to a chart, 2-8, 

3-33 
Deviation, standard, 2-75, 2-78 
DEVICE, 3-17 
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DIF, 2-42, 2-48, 3-19, D-l 
DIF extension, 2-52, 3-43 
DIF, files 

creating, D-8 
dumping, D-4 
printing data files from, D-6 
working with, 2-48, D-4 

DIF format, 2-42, 3-19, D-l 
DIFF, 2-90, 3-19 
Difference, adjacent, 2-75, 

2-90, 3-19 
Disk 

controller card, 1-7, 3-17 
drive identifier, 2-37, 3-5, 

3-17 
drives, changing, 3-17 
drives, connecting, 1-7, 3-18 

Diskettes 
care of, 1-8 
data, 2-37 
DOS system master, 1-10 
formatting, 2-41, 3-22 
inserting and removing, 1-9 
loading chart images from, 

2-30, 2-126, 3-28 
loading data from, 2-1, 2-39, 

2-100, 3-28 
program, 1-7, 2-37 
removing all data from, 3-22 
saving charts on 2-29 

2-129, 3-43' , 
saving files on, 2-42, 2-129, 

3-42 
DISPLAY, 2-40, 2-74, 3-19 
Display, startup, 1-11 
Displaying 

Index-4 

chart images, 2-30, 2-126, 
3-28 

names of files on diskette 
2-39 ' 

series in memory, 2-40, 2-74, 
3-19 

series in table format 2-76 
3-48 " 

status area (menu), 1-13, 3-3 
two charts on one screen 

2-118, 3-51 ' 
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DOS 
after QUIT, 2-47, 3-37 
rebooting from, 3-37 
system master diskette, 1-10 

Drawing 
charts, 2-3, 2-100, 3-36 
grid lines, 2-26, 3-23 

DRIVER, 3-19 
Drive 

address, 2-37, 3-17 
and slot address, 2-37, 3-17 
changing, 3-17 
identifier, 2-37, 3-5, 3-17 
connecting, 1-7, 3-18 

Drivers for 

E 

text-only interfaces, B-3 
supported graphics printers, 

B-1 

e to the power of, 2-94, 3-52 
EDIT, 2-57, 2-64, 2-74, 3-20 
Edit menu, 2-60, 3-20 
Edit operation, using, 2-57 
Edit entry level, 2-64 
Edit commands, 2-60, 3-20 

DELETE, 2-62, 2-68, 3-17 
EDIT, 2-64, 2-74, 3-20 
EXIT, 2-60, 3-20 
FILL, 2-65,· 3-20 
FORMAT, 2-63, 2-67, 3-21, 

3-22 
INSERT, 2-62, 2-68, 3-24 
JUMP, 2-61, 2-66, 3-24 
PRINT, 2-64, 3-36 
SPECS, 2-62, 3-46 
UNDO, 2-64, 3-51 

Effects of commands on files 
and series, 2-46 

End date, 2-3, 2-22 
End-of-data records, D-l, D-4 
En try, series 

adding, 2-59, 2-62, 2-68, 
3-24 
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changing, 2-59 
removing, 2-62, 2-68, 3-17 

Erasing 
characters during data 

entry, 2-10, 2-57, 3-3 
characters in Text mode, 

2-127, 3-49 
data points, 2-62, 2-68, 3-17 
entries in formulas, 2-95, 

3-53 
entries in series, 2-62, 2-68, 

3-17 
grid lines, 2-27, 3-23 
legends, 3-27, 3-50 
moveable titles, 2-15, 3-15, 

3-28 
series 

in memory, 2-44, 3-15, 
3-51 

on diskette, 2-43, 3-42 
Error messages, A-I 
ESC key, 1-13, 3-3, 3-49 
Examples, plotting, 2-100 
Exchanging files, D-l 
Execution order of formulas, 

2-94, 3-53 
EXIT, 3-20 
Exit menu, 2-31 
Exiting 

the edit operation, 2-60 
the program, 2-47, 3-37 

EXP, 2-94, 3-52 
Exponential notation, 2-64, 3-9, 

3-21 
Exponential smoothing, 2-75, 

2-88, 3-45 
Exponential values, 

converting, 2-93, 3-9, 3-52 
Extensions, computed series 

name, 2-81, 2-86, 2-95, 3-6 
Extensions, default file name 

chart image files, 2-30, 2-129 
DIF -formatted files, 2-52 

Extensions, default series 
name, 2-48, 2-63, 3-6 
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F 
Factor 

in progressions, 2-65, 3-12 
smoothing, 2 -89, 3-45 

Facts about program 
operations, 3-1 

File name extensions 2-30 
2-52, 2-129 ' , 

File naming conventions, 3-2 
FILES, 3-20 
Files 

and series, 2-38 
deleting from data diskette, 

2-46, 3-17 
effects of commands on, 2-46 
exchanging, D-1 
loading, 2-1, 2-39, 2-100, 

3-28 
managing, 3-20 
menu, 2-41, 2-46, 3-20 
saving on diskette, 2-42, 

2-129, 3-42 
text, D-1 

FILL, 2-65, 3-20 
Fill menu, 2-65 
FIRST, 3-21 
Fitted data series, 2-81, 3-38 
FIX, 3-21 
Fixed-decimal format 2-63 

3-21 " 
Fixed titles 

adding, 2-9, 3-50 
changing, 2-12, 2-16 
entering, 2-9 
erasing, 2-11, 2-16 
left-justifying, 2-12, 3-21, 

3-44, 3-50 
Floating-decimal format, 2-63, 

3-21 
Forecasting with REGRESS 

2-84, 3-38 ' 
FORMAT, 2-63, 2-67, 3-21, 

3-22 
Format 

column width, 2-63, 3-21 
exponential, 2-64, 3-21 

APPLE II 
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fixed-decimal, 2-63, 3-21 
floating-decimal, 2-63, 3-21 

Formatting 
charts, 2-23, 3-22 
data diskettes, 2-41, 3-22 
data displays, 2-63, 2-67, 

3-21 
Format, internal data, 3-33 

C-1 ' 
Format menu, 2-23 
Formulas 

erasing characters in, 2-95 
3-53 ' 

execution order of, 2-94, 
3-53 

exponential smoothing, 2-89 
3-45 ' 

regression, 2-80, 3-39 
statistical analyses, 3-46 
transformation, 2-93, 3-52 

FUNCTION, 2-75, 3-22 
Function menu, 2-85, 3-22 

DIFF, 2-90, 3-19 
LAG, 2-90, 3-25 
LEAD, 2-91, 3-26 
MOVE AVG, 2-86, 3-29 
PERCENT, 2-90, 3-35 
SMOOTH, 2-88,3-45 
TOTAL, 2-91, 3-50 

Functions 
trigonometric, 2-94, 3-53 
variables in, 2-94, 3-53 

G 
GEOMET, 2-65, 3-22 
Getting started, 1-8 
Graphics printers, supported, 

B-1 
GRID, 3-23 
Grid lines 

drawing, 2-26, 3-23 
erasing, 2-27, 3-23 

Grid menu, 2-26 
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H 
Hardcopy output, 2-78, 3-36 
Header records, D-3 
HI-LO-CL, 3-23 
High-Low-Close chart, 1-5 

3-23 ' 
HORIZ, 2-118, 3-23 
horizontal 

axis, 3-23 
grid lines, 2-26, 3-23 
windows, 2-118, 3-23, 3-51 

How the range is determined 
2-17, 3-7 ' 

How the scale is determined, 
2-17, 3-8 

How to 

I 

change the range, 2-21, 3-8 
change the scale, 2-18, 3-8 
convert an N + 1 moving 

average, 3-29 
use data with other 

programs, 2-51, D-l 

I key, 2-13, 3-3 
Identifiers, computed series 

name, 2-81, 2-86, 2-95, 3-6 
Identifiers, default file name 

chart image files, 2-30, 2-129 
DIF -formatted files, 2-52 

Initializing diskettes, 2-41, 3-22 
INSERT, 2-62, 2-68, 3-24 
Inserting 

and removing diskettes, 1-9 
data points, 2-62, 2-68, 3-20 

3-24 ' 
entire series, 2-65, 3-44 

INT, 2-94, 3-52 
Integer part of, 2-94, 3-52 
Internal data format, 3-33, C-l 
INTERP, 2-65, 3-24 
Interplay between scale and 

range, 3-9 
Intersection of ranges, 2-81, 

3-7 
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Intervals, selecting axis, 2-21, 
3-8, 3-42 

Introduction, 1-1 
IN USE light, 1-9 
INVERSE, 3-24 
Invoking the editor, 2-57 
Item selection, 1-13 
Items, see Menu items 

J 
JUMP, 2-61, 2-66, 3-24 

K 
Keyboard, 1-8, 3-2 
Keys, special use 

@, 2-12, 3-3 

L 

arrows, 1-12, 2-126 3-3 
3-49 " 

CTRL-@, 2-129, 3-3, 3-49 
CTRL-A, 2-128, 3-3, 3-49 
CTRL-B, 2-127, 3-3, 3-49 
CTRL-C, 2-64, 3-3, 3-37 
CTRL-I, 2-130, 3-3, 3-49 
CTRL-L, 2-127, 3-3, 3-49 
CTRL-O, 2-127, 3-3, 3-49 
CTRL-H, 2-131, 3-3, 3-49 
CTRL-Z, 2-128, 3-3, 3-49 
ESC, 1-13, 3-3, 3-49 
I, 2-13, 3-3 
M, 2-13, 3-3 
RESET, 1-8, 3-4 
RETURN, 2-126, 3-2, 3-49 
space bar, 2-127, 3-2, 3-49 
Y,3-3 
1-9 (numbers), 2-13, 3-29 

Labels, 3-35, 3-51 
LAG, 2-90, 3-25 
Language System, 1-7 
LEAD, 2-91, 3-26 
Least squares, 2-80 
Leaving the edit operation, 

2-60, 3-20 
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Leaving the program, 2-47, 
3-37 

LEFT, 3-26 
Left-justifying fixed titles, 2-12, 

3-21, 3-44, 3-50 
LEGEND, 3-27 
Legend 

and titles in overlays, 2-110 
codes, 2-5, 3-27 
display, 2-105 
line, 2-5, 3-27 
restoring the, 2-12, 3-27 

License agreement, 1-12 
Limitations, program, 2-40, 

2-62, 3-1 
LINE, 3-27 
Line s::harts, 1-3, 3-27 
Line, title-entry, 2-10 
Linear multiple regression, 

2-75, 2-80, 3-38 
Linefeeds, automatic, 3-17, 

3-19 
LINES, 3-27 
Lines, grid, 2-26, 3-23 
Listing 

names of files on diskette, 
2-39 

names of series in memory, 
2-40, 2-74, 3-19 

series data, 2-40, 2-64 
series in table format, 2-76, 

3-48 . 
LOAD, 2-1, 2-126, 3-28 
Loading 

chart image files, 2-30, 
2-126, 3-28 

files containing series, 2-1, 
2-39, 2-100, 3-28 

the Main subprogram, 2-1, 
2-36, 3-28 

the Plot subprogram, 2-1, 
2-100, 3-36 

the Trend subprogram, 2-73, 
3-50 

the VisiTrend/Plot program, 
1-9, 3-37 

VisiCalc data, 2-48 
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LOG, 2-94, 3-52 
Logarithm, natural, 2-94, 3-52 
Logical operators, 2-93, 3-52 
Long prompt, 1-12, 3-5 

M 
M key, 2-13, 3-3 
MAINi 2-74, 3-28 
Main menu, 2-36 
Main subprogram, 1-2, 2-36, 

3-28 
Masking, 2-16, 3-29 
Maxima, program, 2-62, 3-1 
Maximum value in series, 2-78 
Mean, 2-78 
Memory 

clearing series from, 2-44, 
3-15 

listing series in, 2-40, 3-19 
requirements, 1-7 

Menu, 1-12, 3-5 
Menus 

Analyze, 2-75 
Backgr, 3-12 
Bar, 2-6 
Color, 3-16 
Edit, 2-60, 3-20 
Exit, 2-31 
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Files, 2-41, 2-46 
Fill, 2-65 
Format, 2-23 
Function, 2-85, 3-22 
Grid, 2-26 
Main, 2-36 
Options, 2-8 
Plqt, 2-3 
Print, 2-28 
Range, 2-22 
Rescale, 2-19, 2-104 
Save, 2-42 
Screen, 2-29, 3-43 
Select, 2-2 
Specs, 2-62 
Table, 2-76 
Title, 2-9 
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Trend, 2-73 
Typeface, 2-10 
Unlabel, 3-51 
Window, 2-118 

Menu items, 3-9 
ANALYZE, 2-75, 3-12 
AREA,3-12 
ARITH, 2-65, 3-12 
BACKGR, 2-28, 3-12 
BAR, 2-6, 3-14 
BOLD, 2-10, 3-14 
BOTH, 2-7, 2-23, 2-28, 3-14 
CANCEL, 2-16, 2-19, 2-31, 

2-112, 3-15 
CLEAR, 2-44, 2-74, 3-15 
COLOR, 2-28, 3-15 
CONTINUE, 3-16 
DEFAULT, 2-29, 3-16 
DELETE, 2-46, 2-62, 2-68, 

3-17 
DEVICE, 3-17 
DIF, 2-42, 3-19 
DIFF, 2-90, 3-19 
DISPLAY, 2-40, 2-74, 3-19 
DRIVER, 2-29, 3-19 
EDIT, 2-57, 2-64, 2-74, 3-20 
EXIT, 3-20 
FILES, 2-41, 3-20 
FILL, 2-65, 3-20 
FIRST, 2-12, 3-21 
FIX, 2-14, 3-21 
FORMAT, 2-23, 2-41, 2-63, 

2-67, 2-76, 3-21 
chart, 2-23, 3-22 
data diskette, 2-41, 3-22 
series data, 2-63, 2-67, 
2-76, 3-21 

FUNCTION, 2-75, 3-22 
GEOMET, 2-65, 3-22 
GRID, 3-23 
HI-LO-CL, 3-23 
HORIZ, 2-27, 2-118, 3-23 
INSERT, 2-62, 2-68, 3-24 
INTERP, 2-65, 3-24 
INVERSE, 3-24 
JUMP, 2-61, 2-66, 3-24 
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LAG, 2-90, 3-25 
LEAD, 2-91, 3-26 
LEFT, 2-7, 3-26 
LEGEND, 2-12, 3-27 
LINE, 2-2, 3-27 
LINES, 2-23, 3-27 
LOAD, 2-1, 2-126, 3-28 

data from diskette, 2-1, 
3-28 

chart screen image, 2-30, 
2-126, 3-28 

MAIN, 2-31, 2-74, 3-28 
MOVEABLE, 2-13, 3-28 
MOVE AVG, 2-86,3-29 
NAME, 2-2, 2-62, 3-33 
NEW, 2-23, 3-33 
NONE, 2-2, 2-118, 3-33 
NORMAL, 2-6, 2-42, 3-33 
OPTIONS, 2-8, 3-33 
OUTLINE, 2-24, 3:-14 
OVERLAY, 2-30, 2-108, 3-34 
PER, 2-3, 2-62, 3-34 
PERCENT, 2-90, 3-35 
PIE, 2-123, 3-35 
PLOT, 2-4, 2-74, 3-36 
POINTS, 2-23, 3-36 
PRINT, 3-36 
PROCEED, 2-19, 2-112, 3-37 
QUIT, 2-47, 3-37 
RANGE, 2-21, 3-37 
PROCEED, 2-19, 2-112, 3-37 
QUIT, 2-47, 3-37 
RANGE, 2-21, 3-37 
REDRAW, 2-112, 3-37 
REGRESS, 2-80, 3-38 
RESCALE, 2-19, 3-42 
RETURN,3-42 
RIGHT, 2-7, 3-42 
SAVE, 2-29, 3-42 

chart screen image, 2-29, 
2-129, 3-43 

series in files, 2-42, 3-42 
SCREEN, 2-29, 2-126, 3-43 
SECOND, 2-12, 3-44 
SELECT, 2-6, 3-44 
SERIES, 2-65, 3-44 
SET, 2-22, 3-44 



VISITREN DIPLOT™ ~tT~~S 

SHADED, 2-25, 3-14 
SIDE, 3-45 
SLOT, 2-29, 3-45 
SMOOTH, 2-88, 3-45 
SOLID, 2-24, 3-14 
SPECS, 2-62, 3-46 
START, 2-3, 2-62, 3-46 
STATS, 3-46 
SWITCH, 2-118, 3-47 
SYMBOLS, 2-23, 3-47 
TABLE, 2-76, 3-48 
TEXT, 2-30, 3-49 
THIRD, 2-12, 3-50 
TITLE, 2-9, 3-50 
TOP, 2-10, 3-50 
TOTAL, 2-91, 3-50 
TREND, 2-31, 2-73, 3-50 
UNDO, 2-64, 3-51 
UNLABEL, 2-28, 3-51 
VERT, 2-28, 2-118, 3-51 
WINDOW, 2-30, 2-118, 3-51 
XFORM, 2-75, 2-93, 3-52 
XY, 2-117, 3-54 

Messages, error, A-I 
Micros9ft RAM card, 1-10 
Minimum value in series, 2-78 
Modifying data series, 2-57 
Monitor, 1-7 
MOVEABLE, 3-28 
moveable title distance, 2-13, 

3-29 
moveable titles 

creating, 2-13, 3-28 
erasing, 2-15, 3-15, 3-29 
masking, 2-16, 3-29 
movement of, 2-13, 3-29 

MOVE AVG, 2-86, 2-91, 3-29 
Moving average, 2-75, 2-91, 

3-29 
converting, 3-29 
description, 2-86, 3-29 

Moving 
a title, 2-13, 3-28 
between subprograms, 2-45, 

3-20 
from point to point in series, 

2-61, 3-24 
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Multiple regression 

N 

linear, 2-75, 2-80, 3-38 
exponential, 2-80, 2-93 
using a constant in, 2-80, 

3-38 

NAME, 2-2, 2-62, 3-33 
Naming conventions 

computed series, 2-81, 2-86, 
3-6 

file, 3-2 
series, 3-2, 3-6 

Natural logarithm, 2-94, 3-52 
NEW, 2-23, 3-33 
NONE, 2-2, 2-118, 3-33 
Non-graphics printers, using, 

2-28 
NORMAL, 3-33 

storage format, 2-42, 3-33 
typeface, 2-10, 3-33 

NOT, 2-93, 3-52 
Numbers 

o 

for changing title movement, 
2-13, 3-29 

for column width display, 
2-63, 2-67, 3-21 

for fixed format display, 
2-63, 3-21 

Off-scale data during overlays, 
2-112, 3-37 

Operators 
arithmetic, 2-93, 3-52 
comparative, 2-93, 3-52 
logical, 2-93, 3-52 

OPTIONS, 3-33 
Options menu, 2-8, 3-33 
Options menu, Pie chart, 

2-125, 3-35 
Options, see Menu items 
OR, 2-93, 3-52 
Order of execution,. formulas, 

2-94, 3-53 
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OUTLINE, 2-24, 3-14 
OVERLAY, 2-108, 3-34 
Overlays 

p 

legends and titles with, 
2-110, 3-34 

maximum number per chart, 
2-110, 3-34 

off-scale data with, 2-112, 
3-37 

Parentheses, 2-94, 3-53 
PER, 2-3, 2-62, 3-34 
PERCENT, 2-90, 3-35 
Percent-of-change, 2-75, 2-90, 

3-35 
Performing a linear multiple 

regression, 2-80, 3-38 
Period, 2-3, 2-62, 3-34 
Periodicity, 2-3, 2-62, 3-34 
PIE, 2-123, 3-35 
Pie chart, 1-4, 2-121, 3-35 

compatible colors, 3-36 
data, 2-121, 3-35 
legends, 2-124, 3-27, 3-35 
segment labels, 2-123, 3-35 
titling and shading, 2-124, 

3-35 
PIX extension, 2-30, 3-43 
PLOT, 2-4, 2-74, 3-36 
Plot menu, 2-3 
Plot subprogram, 1-2, 2-1, 

2-100, 3-36 
Plotting 

a chart, 2-3, 2-100, 3-36 
colors with BACKGR, 3-13 
colors with COLOR, 3-16 
examples, 2-100 
symbols, 3-48 
the maximum of 16 charts, 

3-34, 3-36 
Point, data; see Data point 
POINTS, 3-36 
Pound sign, 2-3 
Power switch, 3-37 
Precision, 2-63, 3-21 
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Preparing a data diskette, 2-41, 
3-22 

PRINT, 3-36 
Print menu, 2-28 
Printer support, B-1 
Printers 

Apple Silentype, 2-28, B-1, 
B-5 

changing drivers for, 3-16, 
3-19, B-3 

Centronics, B-1, B-5 
Epson, B-1, B-6 
IDS Paper Tiger/Prism, B-1, 

B-7 
interface cards and drivers, 

B-2 
NEC Spinwriter, B-1, B-I0 
non-graphics, using, 2-28, 

B-3 
Qume Sprint, B-1, B-14 
setup and switch setting, B-5 
supported, B-1 
Trendcom, B-1, B-15 

Printing 
charts, 2-28, 3-36 
data from a DIF -formatted 

file, 0-6 
displayed lists, 2-41, 3-36 
series data, 2-64, 3-36 

PROCEED, 2-19, 2-112, 3-37 
Program 

diskette, 1-7, 2-37 
exiting the, 2-47, 3-37 
limitations, 2-40, 2-62, 3-1 
loading the, 1-9, 2-36 
maxima, 2-40, 2-62, 3-1 
operation facts, 3-1 

Progressions 
ARITH, 2-65, 3-12 
factor in, 2-65, 3-12 
GEOMET, 2-65, 3-22 

Prompt, long, 1-12, 3-5 

Q 
QUIT, 2-47, 3-37 
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R 
RAM memory, 1-7 
Random number, 2-94, 3-52 
RANGE, 3-37 
Range 

and scale, interplay, 3-9 
calculating the, 2-17, 2-82 

3-7 ' 
changing the, 2-21, 3-8, 

3-37, 3-44 
for deletions, 2-62, 3-17 
intersection of, 2-81, 3-7 
linear multiple regression 

2-82 ' 
major, 3-6 
menu, 2-22, 3-37 
minor, 3-6 
union of, 2-76, 3-7 

Record data, D-l 
Record, end-of-p,ata, D-4 
Recovering the legend, 2-12, 

3-27, 3-50 
Recovery from a Monitor 

transfer, 3-37 
REDRAW, 2-112, 3-37 
Reference, 3-1 
REGRESS, 2-80, 3-38 
Regression 

analysis display, 2-82 
computed series names 

2-81, 3-6, 3-38 ' 
constant in, 2-80, 3-38 
exponential, 2-80, 2-93 
formulas, 2-80, 3-39 
linear multiple, 2-80, 3-38 
statistics, 3-38 
trend forecasting, 2-84, 3-38 
variables, 2-80 

Removing 
and inserting diskettes, 1-9 
all data from a diskette, 3-22 
chart labels, 3-51 
data points, 2-62, 2-68, 3-17 
editing changes, 2-60, 2-64 

3-51 ' 
files from diskette, 2-46, 3-17 

APPLE II 
INDEX 

grid lines, 2-27, 3-23 
series from diskette, 2-43 

3-43 ' 
series from memory, 2-44, 

3-15, 3-51 
Replacing values in a series 

2-59 ' 
Requirements, computer, 1-7 
RESCALE, 2-19, 3-42 
RESET key, 1-8, 3-4 
Residual data series, 2-81, 3-38 
Retrieving a chart image file, 

2-30, 2-126, 3-28 
RETURN, 3-42 
Returning 

to a previous menu, 3-33 
to the edit commands, 2-61 
to the VisiTrend/Plot 

program, 3-37 
RIGHT, 3-42 
RND, 2-94, 3-52 

s 
SAVE, 3-42 
Saving 

a chart image, 2-29, 2-129, 
3-43 

series data in memory, 2-61 
series data on diskette, 2-42 

3-42 ' 
Scale 

and range interplay, 3-9 
assumptions, 2-21, 3-42 
calculating the, 2-17, 3-8 
changing the, 2-18, 3-8, 3-42 
factor, 2-17, 3-8 
intervals, 2-19, 3-8 

SCREEN, 2-126, 3-43 
Screen image retrieval, 2-30, 

2-126, 3-28 
Screen menu, 2-126, 3-43 
Scrolling the screen, 2-66 
SECOND, 3-44 
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SELECT, 3-44 
Select menu, 2-2 
Selecting 

axis intervals, 2-21, 3-8 
chart types, 2-2, 3-5, 3-44 
menu items, 1-13 

SERIES, 2-65, 3-44 
Series 

adding values, 3-24 
by interpolation, 2-65, 

3-20, 3-24 
of another series, 2-65, 

3-20, 3-44 
to the end of, 2-59 
in arithmetic progression, 

2-65, 3-12, 3-20 
in geometric progression, 

2-65, 3-20, 3-22 
and files, 2-38 
clearing from memory, 2-44, 

3-15, 3-51 
computed, 2-75, 2-81, 2-86, 

2-95, 3-6 
computing adjacent 

differences, 2-75, 2-90, 
3-19 

computing moving average, 
2-75, 2-86, 2-91,' 3-29 

computing percent-of­
change, 2-75, 2-90 

computing statistic~, 2-75, 
2-78, 3-46 

correlation of values in, 1-5, 
2-117 

current, 2-4 
data, 2-57, 3-20 
deleting values from, 2-62, 

2-68, 3-17 
displaying, in memory, 2-40, 

2-74, 3-19 
effects of commands on, 2-46 
end date, 2-3, 2-22 
formatting, 2-63, 2-67, 3-21 
inserting values into, 2-62, 

2-68, 3-20, 3-24 
lagging, 2-75, 2-90, 3-25 
leading, 2-75, 2-91, 3-26 

VISITREN DIPLOT™ ~~T~~s 

listing in table format, 2-76, 
3-48 

moving within, 2-66, 3-24 
name extensions, default, 

2-48, 2-63, 2-81, 2-86, 
2-95, 3-6 

naming conventions, 3-2, 3-6 
printing, 2-64, 3-36 
saving in a file, 3-42 
shifting to the future, 2-90, 

3-25 
shifting to the past, 2-91, 

3-26 
smoothing, 2-75, 2-88, 3-45 
specifications, changing, 

2-62, 3-33, 3-46 
start date, 2-3, 2-22, 2-58, 

3-46 
statistics, calculating, 2-75, 

2-78, 3-46 
totalling, 2-75, 3-50 
transformations, writing, 

2-75, 2-93, 3-52 
SET, 3-44 
Setting up 

the computer, 1-7 
the printer, B-5 

SGN, 2-94, 3-52 
SHADED, 2-25, 3-14 
Shading and titling a Pie chart, 

2-124, 3-35 
SIDE, 2-12, 3-45 
Sign, 2-94, 3-52 
SIN, 2-94, 3-53 
Sine, 2-94, 3-53 
SLOT, 3-45 
Slot 

address, 3-45 
and drive address, 3-5 

SMOOTH, 2-88, 3-45 
Smoothing, exponential, 2-75, 

2-88, 3-45 
SOLID, 2-24, 3-14 
Space bar, 2-127, 3-2, 3-49 
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Specifications 
changing, 2-62, 3-33, 3-34, 

3-46 
menu, 2-62 

SPECS, 2-62, 3-46 
SQR, 2-94, 3-52 
Square root, 2-94, 3-52 
Standard deviation, 2-75, 2-78 
START, 2-3, 2-62, 3-46 
Start date, 2-3, 2-22, 3-46 
Startup display, 1-11 
Statistics, calculating, 2-75, 

2-78, 3-46 
Statistics, regression, 3-38 
STATS, 3-46 
Status areas, 1-12, 3-4 
String, data, D-l 
Subprograms 

Main, 1-2, 2,,36, 3-28 
moving between, 2-45 
Plot, 1-2, 2-1, 2-100, 3-36 
Trend, 1-2, 2-73, 3-50 

Superscript and subscript 
characters, 2-128 

Supported Graphics Printers, 
B-1 

SWITCH, 2-118, 3-47 
Switch, power, 3-37 
SYMBOLS, 3-47 
Symbols, plotting, 2-5, 3-48 

T 
Tab, write-protect, 2-41, 3-17 
TABLE, 3-48 
Table format listing, 2-76, 3-48 
Tabs, using, 2-130 
Taking care of diskettes, 1-8 
TAN, 2-94, 3-53 
Tangent, 2-94, 3-53 
TEXT, 3-49 
Text 

chart annotations, 2-125, 
3-49 

creating pages, 2-126, 3-49 
file, D-l 

THIRD, 3-50 

APPLE II 

TITLE, 3-50 
Title-entry line, 2-10 
Titles 

INDEX 

and legends in overlays, 
2-110 

bottom, 2-12, 3-21, 3-44, 
3-50 

changing, 2-12, 2-15 
erasing, 2-15, 3-15, 3-51 
left-justifying, 2-12, 3-21, 

3-44, 3-50 
lengths of, 2-11, 3-2 
masking, 2-16, 3-29 
menu, 2-9 
moveable, 2-13, 3-21, 3-28 
side, 2-12, 3-45 
top, 2-10, 3-50 

Titling 
a chart, 2-9, 3-50 
and shading Pie charts, 

2-124, 3-35 
TOP, 3-50 
TOTAL, 2-91, 3-50 
Totalling a series, 2-75, 3-50 
Transformations of series, 

writing, 2-93, 3-52 
TREND, 2-31, 2-73, 3-50 
Trend subprogram, 1-2, 2-73, 

3-50 
Trend forecasting, 2-84, 3-38 
Trigonometric functions, 2-94, 

3-53 
TV set, 1-7 
Type, data, D-l 
Typeface menu, 2-10 

u 
UNDO, 2-64, 3-51 
Union of ranges, 2-76, 3-7 
UNLABEL, 3-51 
Unlabel menu, 3-51 
Usage, keyboard, 1-8, 3-2 
Useful facts about program 

operations, 3-1 
User support plan, 1-12 
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Using 

v 

the Analyze operation, 2-75 
the Edit operation, 2-57, 3-20 
the Function operation, 2-85 
VisiCalc data in the 

VisiTrend/Plot program, 
2-48 

VisiTrend/Plot data in the 
VisiCalc program, 2-51 

windows to display two 
charts, 2-118, 3-51 

Value(s), series 
adding, 2-59, 2-62, 2-68, 

3-24 
deleting, 2-62, 2-68, 3-17 
formatting, 2-63, 2-67, 3-21 
inserting, 2-62, 2-68, 3-20, 

3-24 
replacing, 2-59 

Variables 
function, 2-94, 3-53 
regression, 2-80 

Variance, 2-75, 2-78 
Version number, 1-12 
VERT, 2-28, 2-118, 3-51 
Vertical 

axis, 3-51 
grid lines, 2-26, 3-51 
windows, 2-118, 3-51 

Video 
inverse, 1-12, 2-131, 3-24 
monitor, 1-7 

VisiCalc 
data, using, 2-48, D-l 
DIF, file 2-48, D-1 
worksheet, 2-48 

VISITRENDIPLOT™ ~~f~~s 

VisiTrend/Plot internal data 
format, 3-33, C-1 

w 
Well-scaled charts, 2-20 
WINDOW, 2-30, 2-118, 3-51 
Window 

cancelling, 2-118, 3-33 
charts, annotating, 2-120 
codes, 2-120, 3-5, 3-51 
horizontal, 2-118, 3-23, 3-51 
menu, 2-118 
switching a, 2-118, 3-47 
vertical, 2-118, 3-51 

Working with DIF files, 2-48, 
D-4 

Worksheet, VisiCalc, 2-48 
Wraparound, cursor, 1-12, 2-3, 

3-3 
Write-protect tab, 2-41, 3-17 
Writing a series 

transformation, 2-75, 2-93, 
3-52 

x 
X-axis, 2-4 
XFORM, 2-75, 2-93, 3-52 
XY, 2-117, 3-54 
XY charts, 1-5,2-117, 3-54 

y 

Y-axis, 2-4 
Y key, 3-3 
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Please tell us how you rate this manual in the following areas: 
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2. Clarity of information. 0 D 0 0 D 
3. Organization of manual. 0 D 0 0 D 
4. Appearance of manual. D D 0 0 D 
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0 D 0 0 D illustrations. 
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9. Degree to which this manual meets 
D D D 0 D your expectations and needs. 

10. Appropriateness of the manual level 
D D 0 D D to a person of your experience. 

II. Overall manual. D D 0 0 D 
2 years 2-5 Over 

How much computer experience or less years 5 years 

do you have? D 0 0 

Please specify, by page, any errors you found in this manual. 

We would appreciate hearing any other comments and suggestions you have about this 
manual. 

Name 

Company 

Street 

City _____________ State ________ Zip ____ _ 



BUSINESS REPLY MAIL 
FIRST CLASS PERMIT NO. 7066 SAN JOSE, CA 95134 

POSTAGE WILL BE PAID FOR BY ADDRESSEE 

VISICORP 
2895 Zanker Road 
San Jose, CA 95134 

IIIIII No Postage 
Necessary 
If Mailed 
in the 
United States 




	0001
	0002
	001
	002
	003
	004
	005
	006
	007
	008
	009
	010
	011
	012
	013
	014
	015
	016
	1-01
	1-02
	1-03
	1-04
	1-05
	1-06
	1-07
	1-08
	1-09
	1-10
	1-11
	1-12
	1-13
	2-001
	2-002
	2-003
	2-004
	2-005
	2-006
	2-007
	2-008
	2-009
	2-010
	2-011
	2-012
	2-013
	2-014
	2-015
	2-016
	2-017
	2-018
	2-019
	2-020
	2-021
	2-022
	2-023
	2-024
	2-025
	2-026
	2-027
	2-028
	2-029
	2-030
	2-031
	2-032
	2-033
	2-034
	2-035
	2-036
	2-037
	2-038
	2-039
	2-040
	2-041
	2-042
	2-043
	2-044
	2-045
	2-046
	2-047
	2-048
	2-049
	2-050
	2-051
	2-052
	2-053
	2-054
	2-055
	2-056
	2-057
	2-058
	2-059
	2-060
	2-061
	2-062
	2-063
	2-064
	2-065
	2-066
	2-067
	2-068
	2-069
	2-070
	2-071
	2-072
	2-073
	2-074
	2-075
	2-076
	2-077
	2-078
	2-079
	2-080
	2-081
	2-082
	2-083
	2-084
	2-085
	2-086
	2-087
	2-088
	2-089
	2-090
	2-091
	2-092
	2-093
	2-094
	2-095
	2-096
	2-097
	2-098
	2-099
	2-100
	2-101
	2-102
	2-103
	2-104
	2-105
	2-106
	2-107
	2-108
	2-109
	2-110
	2-111
	2-112
	2-113
	2-114
	2-115
	2-116
	2-117
	2-118
	2-119
	2-120
	2-121
	2-122
	2-123
	2-124
	2-125
	2-126
	2-127
	2-128
	2-129
	2-130
	2-131
	2-132
	2-133
	2-134
	3-01
	3-02
	3-03
	3-04
	3-05
	3-06
	3-07
	3-08
	3-09
	3-10
	3-11
	3-12
	3-13
	3-14
	3-15
	3-16
	3-17
	3-18
	3-19
	3-20
	3-21
	3-22
	3-23
	3-24
	3-25
	3-26
	3-27
	3-28
	3-29
	3-30
	3-31
	3-32
	3-33
	3-34
	3-35
	3-36
	3-37
	3-38
	3-39
	3-40
	3-41
	3-42
	3-43
	3-44
	3-45
	3-46
	3-47
	3-48
	3-49
	3-50
	3-51
	3-52
	3-53
	3-54
	A-01
	A-02
	A-03
	A-04
	A-05
	B-01
	B-02
	B-03
	B-04
	B-05
	B-06
	B-07
	B-08
	B-09
	B-10
	B-11
	B-12
	B-13
	B-14
	B-15
	C-01
	C-02
	D-01
	D-02
	D-03
	D-04
	D-05
	D-06
	D-07
	D-08
	D-09
	D-10
	Glossary-01
	Glossary-02
	Glossary-03
	Glossary-04
	Index-01
	Index-02
	Index-03
	Index-04
	Index-05
	Index-06
	Index-07
	Index-08
	Index-09
	Index-10
	Index-11
	Index-12
	Index-13
	Index-14
	Index-15
	replyA
	replyB
	xBack

